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Preface 
MAGIX Music Maker Premium Steam Edition offers an easy start and the option to 
dive deeper into the world of music production. A giant, high-quality sound archive, 
an especially intuitive approach to creating original music, plus many useful functions 
result in an unbeatable complete package for making your own songs. 

The handling is especially easy and consistent. The included sound files can be 
combined with the software synthesizers easily. MP3 songs can be used with audio 
CD tracks, your own music recordings and even videos, photos or graphics. Even VST 
and DirectX plug-ins or MIDI files can be added easily. 

This turns your computer into a universal production studio for music and all other 
kinds of multimedia files. The included CD-quality musical building blocks can all be 
easily combined since they are all categorized according to tempo and harmony. And 
for those of you who want to start making songs effortlessly and straight away, the 
integrated "Song Maker" will take care of almost everything for you. 

The tutorial (view page 22) starts off by explaining all of the basic features in the 
program and then goes on to provide complete, detailed descriptions of each of the 
functions. If you prefer to discover the many possibilities of the program by yourself, 
you can also use the PDF manual and the Help feature as references. An alphabetical 
index is included at the very end. 

Have fun with MAGIX Music Maker Premium Steam Edition. 

The MAGIX Team 
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Support 
Dear MAGIX customer, 

Our aim is to provide fast, convenient, solution-focused support at all times. To this 
end, we offer a wide range of services: 

• Unlimited web support: 
As a registered MAGIX customer, you have unlimited access to web support 
offered via the convenient MAGIX service portal on http://support.magix.net, 
including an intelligent help assistant, high-quality FAQs, patches and user 
reports that are constantly updated. 
The only requirement for use is product registration at www.magix.com 

• The online community, on-the-spot support and a platform for exchange: 
MAGIX customers have free and unlimited access to the online community at 
www.magix.info, which includes approx. 150,000 members and offers the 
opportunity to ask members questions concerning MAGIX products as well as 
use the search function to search for specific topics or answers. In addition to 
questions & answers, the knowledge pool includes a glossary, video tutorials and 
a discussion forum. The multiple experts, found round-the-clock at 
www.magix.info guarantee quick answers, which sometimes come within 
minutes of a question being posted.  

• Email support for MAGIX products: 
For each new MAGIX product you will automatically receive 12 months free 
customer support by email. 

• Premium Email Support: 
For priority support, or if you want the support team to help with non-MAGIX 
related hardware problems you can purchase a premium email support ticket. 
Proceed as follows: 
1. Go to the MAGIX customer support page at http://support.magix.net. 
2. Sign in using your login details. 
3. Click on "Purchase access code" in the navigation bar. 

Each ticket corresponds to a specific problem, it will remain valid until the 
problem has been solved. A ticket is not limited to a single email. 

Please note: To be able to use the Premium email support and free product email 
support via the Internet, you have to register your MAGIX product using the serial 
number provided. The serial number can be found on the sleeve of the installation 
disc or on an insert card included in the package. 

• Additional telephone service: 
Besides the large number of free customer service offers, we also offer a fee-
based telephone customer service. 

Here you can find a summary of our technical support telephone numbers: 

http://support.magix.net/ 
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Mail (Europe): MAGIX Development Support, P.O. Box 20 09 14, 01194 Dresden, 
Germany 

Mail (North America): MAGIX Customer Service, 1105 Terminal Way #302, Reno, 
NV 89502, USA 

Please make sure you have the following information at hand: 
• Program version 
• Configuration details (operating system, processor, memory, hard drive, etc.), 

sound card configuration (type, driver) 
• Information regarding other audio software installed 

MAGIX Sales Department 

You can reach the MAGIX Sales Department workdays for help with the following 
questions and problems: 

• Orders 
• Product consulting (pre-purchase) 
• Upgrade requests 
• Returns 

Europe 
Monday - Friday, 09:00-16:00 GMT 

U.K.: 0203 3189218  

Denmark: 45 699 18763 

Sweden: 46 852 500713  

Finland: 35 89 42419023 

Norway: 47 210 35843 

North America 
9 am to 4 pm EST Mon-Fri 

Phone: 1-305-722-5810  
 

Particularities for purchases made through 
Steam™ 
Different conditions apply if you have purchased the program through Steam™. You 
can find more information at https://support.steampowered.com 
https://support.steampowered.com. 

 

https://support.steampowered.com/
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Introduction 

What is MAGIX Music Maker Premium Steam 
Edition? 
MAGIX Music Maker Premium Steam Edition is the ideal program for creating 
professional sounding recordings without having to learn any complicated musical 
theory. You can simply combine the professionally produced loops in the intuitive 
arranger and mix them to create your own personal sound. 

Are you aiming for a unique sound that will set you apart from the crowd? Then try 
creating your own special sounds with the included software synthesizers or load 
your own plug-in synthesizers. High-quality effects help to give your tracks the final 
polish or you can take things in the other direction and distort them until they are 
almost unrecognizable. Express your own creativity by recording your vocals or 
instruments and adding them to the project. 

Whether rock, techno or film music, you can produce all kinds of tracks using the 
wide range of styles available in the program. When you combine elements from 
different style libraries the tempo is adjusted automatically to make sure your 
arrangement fits together perfectly. Who knows? Maybe flamenco rock or country 
techno is the next big thing. 

If you need even more sounds and samples, Catooh offers a rich selection of audio, 
video, images and professionally created sound effects, which can add even more 
variety to your project. 

Or how about a remix? Load up your favorite hits from the past and add some fat 
bass or a totally modern beat! When you load audio CD tracks and MP3s into Music 
Maker the tempo of the song is recognized and adjusted to fit the project. The track 
can also automatically be cut into loops. 

But music alone isn't everything! You can import images and video files to your 
project, include text and add video effects and cool visuals. The finished video can be 
directly exported from Music Maker and posted on MAGIX Online Album, Youtube 
or Facebook 
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The Features 
Multimedia Library  - Soundpool 
The included multimedia library provides audio and video building blocks ("samples") 
that can be combined in the arranger. The samples are categorized according to 
styles, instrument category, and pitch. In short: just about anything can be combined 
with anything else. The pitches match one another and the various styles of samples 
are adapted to the tempo. The sky's the limit to your creativity. Music Maker also 
comes with a range of audio and video effect templates, titles, and graphic animations 
for video clips.  
 

Audio effects 
MAGIX Music Maker Premium Steam Edition provides lots of different audio effects. 
A short overview: 

• The Audio Effect Rack supplies Reverb, Echo, Equalizer, Compressor, Time 
Processor, Distortion and Filter – classic effects which can be used to produce 
almost any sound. The reverb effect, for example, provides professional and 
realistic reverb algorithms to add depth and spaciousness to your material. You 
can correct tempo and pitch in real time using Resampling, Timestretching or 
Pitchshifting. 

• You can also individually apply all of the effects of the Audio FX rack. 
Additionally, you can find a parametric equalizer, bit machine, gater, etc. in the 
effects menu. 

• Vandal SE is a guitar amplifier from MAGIX. You can adjust all the typical 
settings on its realistic user interface.  

• essentialFX: important bread-and-butter effects that are embedded like VST 
plug-ins.  

• The Vintage Effects Suite covers "good old" guitar effects that were activated 
using a foot pedal in Jimi Hendrix's era: more warmth and fullness with Chorus, 
jet-like special effects with the Flanger or ping-pong effects with Delay. The 
Filter enables tempo-synchronous frequency filtering. 

There are three ways of implementing filters:  

• Object effects: Effects for selected objects These effects can be found in "Effects 
> Audio > Audio Effects" or in the context menu (right mouse click).  

• Track effects: Effects for complete tracks These effects can be found in the track 
box or in the mixer channels.  

• Master effects: Effects for the overall sound These effects can be found in the 
mastering area of the mixer ( or in the "Effects" menu). 
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Import 
You have the following options for using your own material: 

• Audio files in a wide range of formats. You can also use MIDI, video and 
bitmaps.  The files can be dragged to a track from the Media Pool with a held-
down mouse key (drag & drop). You can find a list of supported formats below 
(view page 16). 

• Audio CDs can be imported directly in the program. Simply place the CD into 
the drive and press "CD/DVD" and all the tracks are ready to be dragged & 
dropped into the Arranger. Whether for remixes or as sound material for your 
own compositions - your personal CD collection has a whole new meaning. 

• Use the recording function to record vocals, noises, or instruments and integrate 
them into the project. 

 

Song Maker 
The Song Maker lets you create new projects quickly and easily and complement 
existing projects by automating the complicated steps such as sample selection and 
combination. The Song Maker takes over arranging whole sections such as intro and 
refrain. Therefore, you do not have to do everything yourself – you can omit the 
arranging and process your selection from the suggestions. 
 

Own recordings 
Use this recording function from MAGIX Music Maker Premium Steam Edition to 
record vocals, noises, or instruments and integrate them into the project. 
 

Audio & MIDI 
The MIDI format is extremely important in modern music production. You can use 
MIDI files to control external devices such as synthesizers and samplers and internal 
software audio generators such as VST plug-ins from your computer. 

With MAGIX Music Maker Premium Steam Edition you can arrange, load, record, 
edit, and play MIDI files just as easily as audio files. For MIDI editing, you can use the 
specialized MIDI Editor with Piano Roll, Drum Editor, Velocity/Controller Editor and 
Event List. 
 

VST Support 
Now it is possible to use external VST instruments and effects in all MAGIX Music 
Maker Premium Steam Edition versions. A wide range of DirectX and VST plug-ins 
are offered in retail stores or directly on the Internet, greatly expanding the 
possibilities of MAGIX Music Maker Premium Steam Edition. 

VST instruments and effects are external programs, which must first be installed 
before being used in MAGIX Music Maker Premium Steam Edition. You can then find 
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them in the mixer plug-in slots and in the track boxes at the start of every track. VST 
effects are applied to an entire track. VST instruments are controlled by MIDI objects. 
 

Mixer 
MAGIX Music Maker Premium Steam Edition contains a professional real-time mixer 
with an Effect Rack and two Insert Effects per channel and for the Master, as well as 
additional Mastering Effects. You can group a number of faders of a specific type (for 
example, volume or panorama) and use them all together by holding down the Ctrl 
key. The quickest way to open and close the mixer is by using the M key. 
 

Harmony Agent 
The Harmony Agent provides harmony recognition automatically and determines the 
key and chord of any music title. See the guitar tablature of your favorite song in real 
time for the project! 
 

Formats and interfaces 
Import: WAV, MP3, OGG Vorbis, WMA, QuickTimeTM, MIDI, CD-A (without copy 
protection), BMP, JPG, AVI, MXV, WMV 

Export: WAV, MP3, OGG Vorbis, WMA, QuickTime, MIDI, BMP, JPG, AVI, MXV, 
WMV, CD-A (Live & Premium version) 
 

InfoBox 
Thanks to the new InfoBox, all important functions can be easily understood as they 
are applied. Just hold the mouse over a button that you would like to learn about and 
read the infotext in the video monitor. 

Note: The video monitor is preset as hidden and can be made visible with the key F3. 
 

Internet upload to many platforms 
When the song is finished, it should be heard not just by your friends, but preferably 
the whole world. This is achieved, naturally, with the help of the web. Under "File > 
Export > Community upload" you will find the most impotant communities, where 
you can upload your songs. 
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Additional features in the Live & Premium 
versions 
Music Maker comes in three versions: Music Maker, Music Maker Live and Music 
Maker Premium. The Premium version differs from the Live version only in that it 
contains more loops, instruments and live sets. The following list outlines the 
difference between the standard version of Music Maker and the Live & Premium 
versions. 
 

Additional styles & samples 
The standard version of MAGIX Music Maker contains 6 styles (> 5000 samples), 
the Live version 8 styles (> 6,000 samples) and the Premium version 10 styles (> 
7,000 samples). 
 

Additional instruments 
• Revolta 2: A powerful, varied, 12-tone analog synthesizer. Comes with a sound 

matrix, noise generator and nine effect types. 
• Additional soundbanks in the Vita sample synthesizer 
• Additional Vita Solo instruments: Music Maker contains 3 Vita Instruments, 

Music Maker Live 5 and Music Maker Premium 8 Vita Solo Instruments 
 

Additional audio effects 
• Essential FX Vocal Strip: This combination of effects is specifically designed for 

editing speech and vocal recordings. 
• Vocoder: produces distorted vocals from synthesized sounds. 
• Mastering Suite: a special effect rack for "Mastering". In this process, the mixed-

down music track is "polished" using parametric equalizer, multimax, limiter and 
stereo enhancers.  You can transfer the sound and dynamic quality of a 
completed piece of music to your project using the auto mastering in the 
mastering suite. 

• Am-Track SE: This analog vintage compressor produces an especially warm, 
pumping sound. Launch it via the effects menu for selected audio objects or via 
the plug-in slot in the mixer. 

 

Object and track curve automation 
Effect and volume progressions can be controlled using freely drawable curves – for 
individual objects as well as for complete tracks. In addition, you can fade an echo in 
or out at a specific position in the song by drawing in a curve peak at the 
corresponding position. 
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Video recording 
In addition to audio recording, MAGIX Music Maker Premium Steam Edition provides 
a recording function for video from analog video sources for your own video clips. 
 

MAGIX Mastering Suite 2.0 
Impressive studio sound just like you hear on store-bought CDs! MAGIX Mastering 
Suite is a special effects rack for use with the mixer master channel. The included 
effects help you with so-called "mastering"; put the final touch on your completed and 
mixed music piece using parametric equalizers, MultiMax, limiter, and stereo 
enhancers. 
 

Real 5.1 Surround Sound 
MAGIX Music Maker Premium Steam Edition deluxe provides real 5.1 Surround 
Sound. 5.1 Surround is the preferred home cinema sound format, which is also 
supported in the Live & Premium version when importing, editing, and exporting. 
With the 5.1 Surround Editor you can move your sound around the room. 
 

Revolta 2 
Revolta 2 is a powerful-sounding, varied 12-voice analog synthesizer with highly 
advanced functions, sound matrix, noise generator, and a complete effects section 
featuring nine effect types. 

This synthesizer can create any electronic music you can imagine. The sound presets 
were created by sound designers for Access Virus and Rob Papens Albino, which 
makes Revolta 2 the number 1 choice for beginners and professionals alike. 
 

Live Pads 
Perform music live and produce new songs on the fly. The Live Pads are ideal for quick 
music productions in realtime, live performances and sketching out new songs. The 
mobile concept behind Music Maker Jam http://www.magix.com/de/apps/music-
maker-jam/ has been introduced to Music Maker. You can control 16 matching loops, 
global pitches and effects via mouse, keyboard, MIDI keyboard or smartphone app. 
 

MAGIX Audio Remote - remote control via smartphone 
app 
With this iOS and Android app, you can operate Music Maker using your 
smartphone. If your computer and phone are on the same Wi-Fi network, the app and 
the program will connect to each other automatically. Right now, the app features 
transport controls, remote control of filters and reverb on Vita Solo Instruments, as 
well as a complete Live Pad interface (in  only). 
 

http://www.magix.com/de/apps/music-maker-jam/
http://www.magix.com/de/apps/music-maker-jam/
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Also in the Live & Premium version 
• Additional tracks: The Live & Premium version offers unlimited tracks (instead 

of 96 - more space for even more complex projects. 
• Timecode sync: For creating songs in teams on multiple PCs. Simply connect 

two notebooks to each other via MIDI and jam together. 
• MIDI step recording: Provided for composers unsure of their keyboard playing 

skills who want to play perfect melodies. The MIDI editor can be opened by 
double-clicking on a MIDI object. 

• ReWire: For embedding of other music programs. Programs such as 
Propellerhead Reason or Ableton Live can be controlled in MAGIX Music Maker 
Premium Steam Edition like a software synthesizer using MIDI objects. 

• Video recoding: In addition to audio recording,  provides a recording function for 
video from analog video sources – for your own video clips. It can be found in 
the "File" menu under "Import > Video recording". 

• Curve automation: Effect and volume progressions can be controlled using freely 
drawable curves – for individual objects as well as for complete tracks. In 
addition, you can fade in or out an echo at a specific position in the song by 
drawing in a curve peak at the corresponding position. 

• MAGIX Music Editor: Detailed audio editing in real time and specialist for CD 
burning, sound restoration, sampling and audio editing. 

• MAGIX Print Studio for quickly creating CD covers, inlays and labels. 
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Overview of the program interface 

 

 Menu bar This bar provides the most important editing 
commands. 

 Toolbar This contains the buttons for quick editing and the 
different mouse modes. 

 Track headers Complete tracks can be turned on or off (muted) 
or played separately (solo). Use the FX buttons to 
apply track effects. Load software instruments with 
the button in the front. 

 Arranger You can freely position any multimedia material on 
all of the arranger's tracks. 

 Transport control In the middle you'll find the volume control, the 
transport console for the playback functions and 
the tempo display. 

 Zoom functions Here you can enlarge or reduce the view. The 
horizontal scrollbar can be stretched and 
compressed for zooming. 

 Control tab In this area, you can display the following tools for 
creating and editing objects: the keyboard, object 
inspector and templates folder.  

 Media Pool All loops, synthesizers and files listed here can be 
added to the arranger using drag & drop. 

 Show/Hide Media 
Pool/Control tab 

The Media Pool or Control tab can be hidden or 
displayed using these buttons to create more 
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space for the arranger. 

 Arranger buttons Buttons for displaying the mixer, Live Pads (Live & 
Premium version only) and video monitor with 
peak meter. 

The arranger, video monitor, Control tab and Media Pool can be positioned anywhere 
on the screen or completely hidden. In the "View" menu (F4 key) you can reset the 
standard layout for Music Maker. 

 The maximize buttons on the arranger, Control tab and Media Pool let you display 
them on the full screen, e.g. to make positioning and editing objects in the 
arranger easier. 

For very large projects, the video monitor can be used as an overview display (Menu -
> Video monitor -> Project overview). 
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Quick start 
This chapter explains the basic functions of MAGIX Music Maker Premium Steam 
Edition with a step-by-step introduction. A systematic description of all program 
functions can be in the manual. 

Tip: Watch the introductory videos and learn some tips and tricks from other users 
at magix.info http://www.magix.info/us/search/music+maker/. 

 

Play demo project 
When MAGIX Music Maker Premium Steam Edition is started for the first time it will 
display a welcome screen. 

 

To get an idea of what Music Maker can do, click on "Load demo song" and select a 
demo song from the menu. Once it is loaded, the Music Maker interface will be 
displayed. 

http://www.magix.info/us/search/music+maker/


 

 

Quick start 23 

    
 

 

The large area with the horizontal tracks is the arranger. The colored rectangles are 
objects. They represent various samples, synthesizers and other sounds. There are 
also objects for titles, images and video files. 

Look at the individual tracks of the song in the arranger: In MAGIX Music Maker 
Premium Steam Edition you can create a complete song by compiling objects. Click 
on the vertical scroll bar on the right-hand side of the screen and drag them down 
(hold down the left mouse button) in order to be able to see each track. 

Underneath the arranger you'll find the transport console (view page 39) and some 
buttons for opening important windows and a large volume control. 

On the right-hand side you'll find the Media Pool. In Loops you will find loops that you 
can add to the project using drag & drop while holding the mouse key, or by double-
clicking. In Instruments you'll find software synthesizers, while via the File manager 
lets you access your computer's file system. 

Below in the program window is the Control tab with the keyboard for playing the 
synthesizers, the object inspector and the templates folder. 

To play the demo, click on the Play button with the mouse or press the spacebar on 
your keyboard. A vertical red line (the playback marker) runs across the screen and 
music will play from the speakers. 

Note: If you do not hear anything, check if the correct sound card is active for 
playback in the Setup window (P key). Also make sure that the output of the sound 
card is connected to the speakers. 
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Previewing and loading sounds 
Now you can load your first sound into the arranger. 

 
Create a new, empty project. Simply click on this button. 

 

• Click on Loops(1) in the Media Pool.  
• Various Soundpools (2) are displayed above 

right in the Media Pool. Soundpools 
represent particular musical genres. Click on 
one of the Soundpools to display the loops 
that match this genre. 

• Now, select which instrument you would 
like to use under instruments (3). All of the 
loops (5) will be listed below and you can 
select the sound you want. The selected 
sound will play back automatically.  

• Most instruments are categorized according 
to pitch. Click on the pitch (4) to listen to 
the sound in the corresponding pitch. Other 
instruments, like drums, are not categorized 
according to pitch. 

• To load a file into the arranger, simply press the Enter key. You can also drag the 
file from a table onto a track in the arranger. Once you let go of the mouse 
button, the file will appear as an audio object (or MIDI object) at that position. 
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Create a Project 
Start playback now. 

To load new samples into the arranger, you do not need to interrupt playback. MAGIX 
Music Maker Premium Steam Edition has a "Smart Preview" function: You can 
simultaneously preview new samples in the Media Pool – they always run in sync with 
the song in the arranger. This function considerably simplifies the search for suitable 
samples for a song you wish to create. 

 

This way, any number of loops from any style can be dragged from any folder into the 
arranger and placed on top of one another, on multiple tracks, or behind one another. 

The pitch of the first loop is displayed in the pitch bar. When additional loops are are 
added underneath at the same time position, they are automatically adjusted to the 
same pitch. 

 

Take note of the two markers at the top of the bar ruler – they represent the start and 
end points of the range to be played (playback range). Playback is "looped" in this 
range which means that it repeats continuously. New loops can be added when 
possible.  

If you want to create a new part for the song you can reposition the start marker by 
left-clicking on the bar ruler and the end marker by right-clicking on the bar ruler. Or 
you can use the right arrow key (view page 36) to move the playback area its entire 
length to the right. 

Each object can be moved in any way in the arranger with the mouse; horizontally on 
a track as well as vertically between tracks. 

Note: There is one important limitation to the movement of objects on tracks. The 
Soundpools contain two different kinds of loops: audio & MIDI. You can recognize 
MIDI loops by their icon in the list. You can recognize MIDI loops by their 
corresponding icon in the list . These loops only produce a sound when 
combined with a software synthesizer (view page 119). This synthesizer is 
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automatically loaded to the track where the MIDI object is placed. These objects 
should not be moved to other tracks once the synthesizer is loaded to a particular 
track. 

 

Edit objects 
Even though it's possible to make great projects with the audio building blocks 
provided, you will probably get to a point where you want to add your own personal 
touch by shortening or removing objects or adjusting the loops in specific areas. 

All objects can be shortened or looped by moving the mouse to one of the lower 
corners of the object until it turns into a stretch symbol. You can now stretch or 
compress the object length as much as you like. If you make the object longer than it 
originally was, it will be played back as a loop. This way you can create rhythm tracks 
from short drum samples simply by stretching them. 

If an object is selected, additional "handles" will appear on it. 

 

Two fade handles are found on both top corners, which can be dragged inwards in 
order to fade the object in and out. The handle at the top center can be used to adjust 
the volume of audio objects and the transparency of video objects.  

All objects can be split into multiple objects. To do so, open the "Edit" menu, click on 
"Object", and select the "Split objects" option. The selected object will be split at the 
position of the playback marker.  

 
This can be done even faster using the special splitting mouse mode, found in 
the mouse mode button in the tool bar, or by pressing "Ctrl + 6". 

Right-clicking on an object opens the context menu with the options available for that 
specific object in the Timeline mode. 

Tip: You'll really notice the advantages of object-based editing when you start to use 
Object Effects! You can apply audio effects to each individual audio object. For 
example, you can cut a sample to create an object for the last beat before a pause in 
the project and add an echo effect. Or create some crazy drums by applying various 
filter effects to each beat in the loop. There's no limit to the creative possibilities!  
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Adding software instruments 
The included audio loops in the Soundpool are of the highest quality and melodically 
synchronized. But sometimes it's good to have a bigger selection of beats and 
melodies or a way to create your own ideas. In this case you need software 
instruments.  

While audio objects consist of pre-made recordings, the sound from software 
instruments (synthesizers) is created during playback on the computer. The resulting 
sounds are not as refined but allow for total control of every musical detail.  

A selection of the loops included in Music Maker are intended as control files for 
software synthesizers (MIDI loops). The sound progressions of these loops can be 
edited in the MIDI Editor (view page 89). You can also record your own melodies by 
connecting a MIDI keyboard. 

In MAGIX Music Maker Premium Steam Edition a distinction is made between VST 
instruments and object synthesizers. 

Object synthesizers are standalone objects in the track and can be moved, cut and 
arranged just like any other objects. Various object synthesizers can also be put 
together on one track. The control of the sound creation takes place within the object 
synthesizer. 

VST Instruments are always loaded to one track and controlled by MIDI objects in the 
track. MIDI objects only contain control information (notes) that is used to create 
sounds in VST instruments. Various MIDI objects arranged on one track control the 
same synthesizer and that means a maximum of one instrument per track. 
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To open the folder with the software instruments in MAGIX Music Maker Premium 
Steam Edition switch to the Instruments folder in the Media Pool. 

 
• When the mouse is moved over a synthesizer, a play button appears that allows 

you to play a sample of the instrument. 
• Drag the desired synthesizer into an arrangement track by holding down the 

mouse button.  
• For object synthesizers a synth object will be created and a settings dialog for 

the synthesizer will open. You can "program" the synth here. The resulting synth 
object can be moved, cut, stretched or adjusted with effects just like an audio 
object. 

• VST instruments are loaded to a track and a preset MIDI object is added to the 
track. Double-clicking on it opens the MIDI Editor where you can make 
adjustments to the melody.  

• Or you can switch to Keyboard view in the Control tab. Here you can play the 
synthesizer using your computer keyboard. You can also record your playing by 
clicking on the large red record button. 

Tip: You can access the sound programs of the included VST instruments with the 
button on the far left of the track. 

Experiment with the various synthesizers in MAGIX Music Maker Premium Steam 
Edition and take advantage of each of their individual strengths. 
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Add videos or images 
Perhaps you would like to make a video clip? To do so, open a folder with video or 
photo files in the Media Pool under Data Manager and select the ones you want to 
use in your project. 

You can activate a video monitor using the middle button on the right below the 
arranger. 

 

A preview of the selected video file is shown on the video monitor. 

 

Once you have found a matching video, use 
the mouse button to drag it onto any track 
(like previously with the audio files). You can 
place as many video and photo files as you like 
under your music.  

You can adjust the length of the individual 
image objects with the help of object handles 
(view page 26). 

In the Media Pool templates you will also find animated text templates (view page 
197) (Titles), video effects (Video FX) and visualizations that you can use to spice up 
your videos. 
 

Effects 
You should take time to experiment with the effects. You can select a number of 
effects from the context menu for an object. Effect modules can be opened and 
adjusted to get the exact sound you want. 

Effects can be dragged as finished effect templates onto objects. Simply open the 
Templates folder in the Control tab and test out the effects listed in Audio FX by 
clicking on them. You'll hear a short preview of the effects. If you like an effect, simply 
drag it onto the object in the arranger. 

Tip: Use the object inspector in the Control tab to display all the important effects 
for an object. 
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Another option for using effects is to apply Track Effects. These effects influence the 
signals of an entire track, making it a quick way to apply the same effect to several 
objects or add the audio output from synthesizers. There are no audio effects 
available for MIDI objects so object effects can't be used on them. 

 You can also select from a variety of useful track effect presets by clicking on 
the button on the corresponding track. These are organized according to the 
instruments and applications. 

 

Export Project 
When your project is ready, you would normally want to do something with it "out in 
the real world". For example, show it to friends. To do so, you must first export your 
work from MAGIX Music Maker Premium Steam Edition.  

You can find the most important functions in "File > Export > Common export 
functions". 

 

• Export as MP3: You can transfer 
your project in MP3 format to a 
portable player. 

• Burn onto CD or DVD: The classic 
way to present music. You can burn 
single songs or complete albums 
directly to CDs.  

Tip: In the Live & Premium version, you 
can use the integrated CD mastering 
and burn program to do this. Click on 
"File" and select the "Export project -> 
Burn audio CD-R(W)" option to export 
your project. The project will be loaded 
into the CD mastering program MAGIX 
Music Editor and can be burned 
straight to disc from there. 

• Upload to the MAGIX Online Album: When the song is finished, it should be 
heard not just by your friends, but preferably the whole world. The easiest way 
to do this is with a MAGIX Online Album of your own.  

• Publish on Facebook (YouTube/SoundCloud): With these options you can 
publish directly on the popular online platforms. 
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• Export in various formats: In the "File > Export" menu you will also find all 
supported export formats for creating an audio or video file (for music videos) 
from your project. 

Note: The export calculations don't affect playback performance. Even if playback on 
your computer begins to stutter because too much RAM is being used for videos 
and effects, the export file will still be calculated correctly. We recommend placing 
already finished passages of complex projects via the export or mixdown function 
into a single file to free up some processing power (and tracks). This kind of file can 
be reloaded into the project and edited further with the other parts. 

 

Burn audio CD 
To burn an audio CD, first export your project as a WAV file: 

• Click "File" and select the "Export project -> Audio as wave..." option.  

The WAV file created can be burned as an audio CD with the included burn program 
MAGIX Speed burnR. 

Tip: You can use an integrated CD mastering tool in the Live & Premium version and 
a burn program to do this. Click on "File" and select the option "Export project -> 
Burn audio CD-R(W)" to export your project. The project will be loaded into the CD 
mastering program MAGIX Music Editor and can be burned straight to disc from 
there. 
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Arranger 

Tracks 
The arranger is organized into tracks. Each track corresponds to a channel on the 
mixer (view page 204). You can use this channel to control volume, apply effects, 
mute or solo all of the objects in the track. The loops of the same instrument are 
typically grouped together on one track (bass track, vocal track, etc.) which makes it 
easier to edit them.  

 

  
Additional tracks can be added with the button at the bottom of the arranger 
or by selecting the "Add track" option in "Edit" menu (Ctrl + I) 

To move a track you can open the Effects menu (view page 33) of the track and select 
"Move Track Up" or "Move Track Down". Tracks cannot be deleted, but those that 
don't have any audio objects are automatically deactivated and that means they don't 
use any computing power! 

If the tracks in the arranger are not long enough, you can increase their length by 
pressing the minus button (-) to the right. The size of the project adapts itself 
automatically when objects exceed the space for them on the right-hand side or when 
new objects are loaded. 
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Track headers and Instrument icons 
At the beginning of each track there is a track header with controls and displays. 

 

 Instrument icon: When you drag & drop a MAGIX Soundpool sample onto an 
empty track an icon will appear in the track header. You can replace this icon by 
right-clicking on it and selecting a different one. A left-click on the icon opens 
the menu for the track synthesizer (see below). 

 The Peak Meter can be found beside the icons. Here, you can control the volume 
of the track and see if the track produces any audio at all. 

 The track name is located to the left of the track number. You can rename the 
track by double-clicking on the field. 

 You can use the Mute button to shut off the sound of a track or the Solo button 
to play only the sound from one particular track. The Solo function is not 
exclusive which means you can use it to play back the sound from several tracks. 
On the lower border of the arranger, underneath the track headers you will find 
the buttons Reset Solo / Mute which you can use to restore the previous solo 
and mute settings of all tracks with one click. 

 

 
 

Left-clicking on the field with the instrument icon opens a menu with the 
sounds from the included software synthesizer which can be loaded to 
the track. This software instrument will then be used by all MIDI objects 
in the track. You can find out more about this in the chapters Software 
Synthesizers (view page 119) and MIDI objects (view page 89). 

 

 The track header of a track with a loaded synthesizer has a 
few additional controls. With the arrows (2, 4) you can 
switch back and forth from the previous to the next sound 
in the software instrument and the gear icon (3) opens the 
instrument editor. 
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  Here you can open the Track Effects menu. In it you will find presets for 
track effects sorted according to the instrument type. 

With the "Move track up/down" commands you can sort your tracks. A lit FX 
button indicates that the track effects are active. 

 

  With REC you can activate the track for an Audio or MIDI recording. 
 

 
A simple click puts the track into Audio Recording mode. This also 
activates monitoring which means you can hear the input signal of 
your sound card during playback. (Find out more in the section 
Listening to the input signal - monitoring (view page 70) ). If you 
start recording now (R key), the audio recording (view page 67) will 
start.  The recorded audio material is added to this track in the 
playback range (view page 36). 

 
Clicking this button again puts the track into MIDI Recording mode. If 
a software instrument is loaded, you can play it with a hooked-up 
MIDI keyboard (Monitoring). If you start recording now, a new MIDI 
object will be created in the track, the MIDI Editor will open and the 
MIDI recording  (view page 97) will begin. 

 
 
 

Zoom 

 

The vertical zoom function sets the 
number of visible tracks. On many tracks 
zooming is useful for selectively editing a 
track or an object in full view. 

Use the horizontal zoom functions to set up the visible section of the project on the 
timeline. 

Clicking and dragging on the bottom border of a track allows you to adjust the height 
of the display. 
 

Move/Zoom with the scroll bar 
The horizontal scroll bar can be dragged apart and pushed together at the edges in 
order to quickly zoom in and out of the timeline. Dragging the middle of the scroll bar 
moves the visible section. The vertical scroll bars correspondingly control the tracks 
shown. 

You can tell which part of the project is being displayed by the size and position of the 
scroll bar. If the entire project is displayed, then the scroll bar will fill out the progress 
bar. Complete view may be set by double clicking the scroll bar. 



 

 

Arranger 35 

A track may not be diminished without limit, and the number of maximum displayable 
tracks is also limited, meaning not all tracks may be able to be viewed at once. 
 

Zoom buttons 
 Zoom menu: Certain zoom levels may be selected by right clicking the 

horizontal scroll bar or by clicking the zoom menu. You can also jump to 
certain positions in the project here.  

 Enlarge objects: Vertical and horizontal zoom stages are enlarged so that 
all of the selected objects are displayed at maximum size. If the function is 
switched off, the regular zoom stage will be restored. 

 Optimize view (view page 266) 

 Zoom buttons: Buttons for zooming in and out 
 

Move/Zoom with the mouse wheel 
The visible section can be moved, reduced, and increased in size by using the mouse 
wheel.  

Displayed tracks Mouse wheel 

Number of displayed tracks, increase/decrease track 
height 

Ctrl + Mouse wheel 

Moving a visible section Shift + Mouse wheel 

Enlarge or reduce the visible section (Zoom) Ctrl + Shift + Mouse wheel 

Menu "View > Arranger > Horizontal scrolling" interchanges the horizontal and 
vertical functions of the mouse wheel. This means you can use Shift and Ctrl+Key for 
zooming and scrolling the tracks instead of for the visible duration. This corresponds 
with the performance of the mouse wheel in the old Music Maker version. 
 

Timeline and grid 
A timeline is located at the upper edge of the arranger. It is used for orientation in the 
project and can be used to determine the playback range or quickly set the playback 
position (see below). 
 

Snap/Grid 

  

At top of the toolbar there is a field for entering the grid step size. 

The grid ensures that the objects and the start, end & play markers only snap into 
place at specific positions so they can be positioned precisely according to the beat. 
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When an object or marker is close enough to a grid snap point, it automatically jumps 
or "snaps" to this position. For example, if the grid has been set to "1/2 Note", the 
objects and markers will snap into position when they are close enough to a half beat 
position (1:1, 1:3, 2:1, 2:3 on the bar ruler). 

Note: "Close enough" refers to the screen display, so the distance of the object from 
the desired position in screen pixels. If you have zoomed in to just a few bars, but 
have the grid set rather coarse (e.g. 1/2 notes), it is possible that objects can be 
moved to positions between grid positions. 

This way, there won't be any gaps between the objects and beat-matched cuts are 
made possible. The selection ranges from full beats to 1/64 notes. Triplet values are 
also possible. The setting "Frames" is important for videos and allows objects to snap 
to single frames in video files.  

In addition to the beat grid, two consecutive objects will seamlessly snap together. 
This prevents undesired gaps or overlapping. This also works if they are located in 
different tracks.  

"Only Objects" deactivates the beat grid and the grid will now only affect the object 
edges. You can also deactivate the grid entirely by selecting "No Grid" or pressing the 
shortcut Ctrl + F12. 

With "Select time signature" you can switch the bar ruler to irregular time signatures, 
such as ¾ beat. 
 

Playback area - Start and end markers 
In the upper area of the timeline, there are two markers between which the playback 
area is displayed, which can be played back as a loop (endless).  

 

The length of the playback area is shown in the colored section. The number before 
the period indicates the number of bars, the number after the number of quarter 
notes. A tilde (~) in the indicator means that the playback range does not have the 
exact pattern length and the loop is therefore "non-circular". Double-click on the 
selection to set the playback range for the whole project. 

This area is also the basis for the commands in the „Edit > Section” (view page 255) 
(Copy, Cut, Paste...). 

To reposition the start marker left-click the upper half of the timeline. The end marker 
is always moved together with the start marker, this means that the length of the 
playback range remains constant. To set the end marker right-click with the mouse. 
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The start marker will not be moved, thereby changing the length of the range. You can 
also drag each of the markers to the desired position with the mouse. 
 

Move playback range with the keyboard 
You can move the playback range also with the keyboard. Alt + cursor keys shift the 
playback range by one full length forwards or backwards. Also press "Ctrl" to shift the 
playback area a quarter of its length. With "Shift + Alt + cursor keys" you can halve or 
double the length of the playback range. With "Ctrl + Shift + Alt + cursor keys" you 
can extend or shorten the playback range by a beat. Use this function to the give the 
playback area a smooth beat length (multiples of 2). 

Note: If you deactivate the option „Cursor keys move playback marker” (view page 
267) in the "View" menu > "Arranger", you do not have to press the Alt key. 
However, it is necessary in order to move the playback marker with the cursor keys. 

When you move the playback area while a playback is running, the old area is always 
played to the end and smoothly changed into the new one after. In this way you can 
remix your tracks in real-time with the keyboard! 
 

Move playback marker 
The playback marker can be moved independent of the start marker. Just click on the 
lower portion of the timeline. Once the playback marker reaches the end marker, 
playback will recommence at the position of the start marker. If the playback marker 
has been set to the right, outside of the area, the project will be played to the end. The 
stretched out playback range will then be played as a loop. 

Use the cursor keys to move the playback marker with the keyboard. The option 
"Move playback marker with cursor keys” in the "View" menu > "Arranger” (preset 
on) interchanges the Alt-Key function. If you deactivate this option, you can move the 
playback marker with Alt + cursor keys and only require the cursor keys to turn down 
the playback range. 
 

Pitch Bar 
A pitch bar can be found below the timeline. 
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When a Soundpool sample is moved to an empty section of the project, the 
corresponding key will be displayed in the pitch bar (the specific key assigned to a 
given pitch may be different from Soundpool to Soundpool).    

The pitch bar can help make sure that the same pitch is always used in order to 
prevent disharmonious sound combinations when adding more loops. 

When the "wrong" pitch is moved into a pitch range, you will be asked to 
automatically adjust the pitch. The selection you make can be saved with "Do not 
show this message again". This means that the program will either automatically 
make adjustments every time from this point on or it will not make any adjustments. 

Note: You can reactivate all deactivated queries with "Do not show this message 
again" by clicking on the tab "Reactivate notice dialog boxes" in the program settings 
(P key or File menu > Settings > Program settings...). 

If several pitches are used within the same duration, several chords will be displayed 
in the pitch bar. 

  

Clicking on the small arrow on a pitch opens a menu where 
you can set the same pitch for all the loops of this duration in 
the project. 

In the "Advanced" submenu, you can find the full offering of major and minor chords. 
A pitch is pitch shifted (view page 143) to achieve the chord. 

You can also divide a pitch range in order to assign a different chord to a single part. 
To do this, switch to the "split" mouse mode (view page 52) and click on the desired 
point in the pitch bar. 
 
  

 
Clicking on a pitch opens a menu where you can load a preset song 
template. Some of these templates are typical chord progressions 
that can help you put loops together to form song parts. Others are 
complete song structures with entire song sections (e.g. verse, 
chorus etc.) that are defined by your chord progressions. 

You can hide the pitch bar by going to View > Arranger. 
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Transport Bar (playback functions) 
The transport bar's functions enable you to control the playback behavior of the 
project using the mouse. 

 

Tip: Using the space bar on your computer's keyboard you can start and stop 
playback much more easily. (Overview of all keyboard shortcuts (view page 277)) 

  

Playing an endless loop (looped object) can be deactivated here. 
Playback will always stop when the end marker is reached. 

  

Back to start: With this button the start marker is quickly moved to the 
beginning of the project. Another click on "Back to start" moves the 
start marker and the playback range to the beginning of the project. 

  

Stop: The stop button stops playback. The playback marker returns to 
the position from which it started. 

  

Play/Pause: This button starts continuous playback of the project. If 
the playback marker reaches the end marker, the range between the 
start and end marker will be played back as a loop. Another click on 
Play stops it at the current position of the playback marker (Pause).  

  

Record: Depending on the settings in the track header (view page 33) 
an audio (view page 67) or MIDI recording (view page 97) will be 
started. With the gear icon next to it you can open the dialog for 
recording audio (view page 68) with additional settings options. 

 

Volume control 

 

The volume control is to the left of the transport controller. With it, you can quickly 
control the overall volume of your project. To regulate the volume of individual tracks, 
use the mixer (view page 204). 

Clicking on the speaker icon mutes the entire sound output. 

Under the volume control there is a peak meter that displays the master signal peak 
level and an indicator for incoming MIDI signals. 
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Time Display 
The time display is beside the 
transport console.  

 

 This is where the current playback position is displayed. By right-clicking it is 
also possible to switch the time display to show the remaining time (relative to 
the end of the project) or to choose various units of measurement, e.g. hh:mm:ss 
or frames. 

 With the position slider you can quickly move the playback marker within the 
visible range. 

 The current pitch is displayed at the top and below it the project tempo in BPM 
(beats per minute). The tempo is determined by the first sample used in the 
project. To enter a new tempo, click on the number and enter a BPM value in the 
field. Finalize the entry by pressing the Enter key. The objects in the arrangement 
are adapted using time stretching. 

 Time Signature: Here there are various time signatures such as 3/4-, 4/4- or 
5/4 which can be selected for the project. 

 Click on BPM to open the Tap Tempo Dialog where you can set the tempo by 
"tapping" it out. Simply click the tap button at your desired tempo or press the T 
key. The tempo is measured and displayed in the dialog. Apply the tempo by 
clicking on "OK". 

 Metronome: This button activates a click track that is played back during 
recording. This helps with maintaining the right beat and tempo when recording 
instruments or vocals. 

 
 

Arranger buttons 
The Arranger buttons for quickly opening and closing all the most important windows 
can be found underneath the last track in the Arranger. 

 
Opens the mixer (view page 204) where tracks can be mixed by adjusting 
volume, setting the position in the stereo panorama and adding effects. 

 
Opens or closes the video monitor (view page 195). The video monitor 
displays the video and images files that have been loaded into Music Maker. It 
can also be used as a peak meter, overview of the project or as an info box for 
help text. 

 
Opens the Live Pads (view page 211). 
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Multi-touch 
In Windows 8, Music Maker can also be easily used with a touchscreen. Provided that 
you have a multi-touch enabled screen, you can also perform all of the normal mouse-
click actions and dragging actions with a finger on the screen. 

To facilitate the touch control, MAGIX Music Maker Premium Steam Edition also has 
a special display mode in which the loops in the media pool, the keys of the virtual 
keyboard, and the menu entries are enlarged. Turn on this mode with the tab key or 
with the special buttons in the relevant mediapool tab. 

Pressing and holding is interpreted as a right-click and opens the relevant context 
menu. 

You can scroll in the arranger and the mediapool with two fingers. To do this, touch 
the screen with two fingers and move them together in the desired direction. 

In addition, you can zoom in the arranger with the familiar "pinch" gesture used on 
smartphones. Touch the screen with two fingers and decrease the distance between 
the fingers to zoom out Increase the distance between the fingers to zoom in. The 
zoom always functions in both directions, that is, it changes both the track height 
(and thus the number of tracks displayed) and the duration displayed. 
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Media Pool 

 

The Media Pool in MAGIX Music Maker Premium Steam Edition lets you search for, 
preview, and load all supported media types, e.g. the audio and MIDI loops included, 
tracks from audio CDs, MP3 files, software instruments or effects. 

The upper edge of the Media Pool contains three buttons that display the Media Pool 
in various ways:  

• Loops offers a database view of all soundpools.  
• Instruments displays a list of the available software instruments (view page 119). 
• The File manager  is very similar to Windows Explorer. It controls and loads 

media files of all types from the hard drive. 
 

Soundpools 
This view in the Media Pool is used to control the Soundpools. You can access the 
included Soundpools through the clearly laid out database view that lets you arrange 
the display of the loops according to styles, instruments and pitch. 

While installing Music Maker, if you no longer have the Soundpools installed on your 
hard drive, insert the installation DVD into the DVD drive. The contents of the 
Soundpool media will now be imported into the database. Other Soundpool media are 
automatically recognized and added to the media database. 

Note: Under program settings -> General (view page 245), you will find different 
options for maintaining and displaying the Soundpool database. 

To import Soundpools already 
present on the hard disk into the 
database, click "Add new 
Soundpools..." in the settings menu 
under the gear icon. 

Soundpools from previous versions of Music Maker or additional Soundpool 
collections that you have purchased can also be integrated into the Media Pool this 
way. 

A Soundpool consists of one or more styles. Styles are sound libraries that are related 
and cover a certain musical style. The sounds (sample or MIDI loops) of one style all 
have a certain tempo. You can mix loops from different styles, and the tempos will be 
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adjusted accordingly. Within a style, loops are ordered according to instruments, and 
one instrument folder contains different sounds. Each sound can have a different pitch 
(except for drums and effects sounds). 

All of the styles that are available in 
the database are displayed in the first 
column above. The second column 
lists the instruments.  

The list of samples found is created 
after entry selection in the two 
columns above. With "Ctrl + click" 
you can reduce or expand a selection. 
Click on Select all  to select all 
entries in this column. If you select an 
instrument (e.g. "Drums" and 
"Percussion") and no style, all drums 
and percussion samples in the whole 
database will be displayed. 

Filter results list 

The results list can be filtered in a variety of ways to reduce the number of search 
results according to different criteria. 

Full text search: Above in the search field you 
can search the list of the samples found 
according to a certain sound file name. 

 

Favorites: Clicking on the star in the sample list marks the loop as a favorite. 
(The star turns yellow once you click it.) 

 

You can use the settings menu option "Only display favorites" under the gear icon to 
display your favorite results only. 
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Audio/MIDI loops: In the same menu there is an option for displaying audio loops, 
MIDI loops or both. For the difference between audio and MIDI loops see below. 

Sort results list 

You can sort the list according to criteria (Instrument category, name, favorite) by 
clicking on the column header. 

Via "Optional columns" in the 
settings menu, you can add in 
additional columns with loop 
characteristics such as BPM, length 
in bars, harmony and type in list for 
use as sort criteria. 

Load loops 

Simply clicking on a loop starts the preview (view page 66). Clicking on the numbers 1 
to 7 beside "Pitch" changes the pitch. The pitch for that loop is set when you click on a 
different loop. 

 
Load the loop you've selected using the arrow. You can also double click or 
drag the loop into the project. 

 
 

Audio Loops and MIDI Loops 
In Music Maker a distinction is made between audio and MIDI loops. Audio loops are 
normal audio files that have a specific number of bars (1, 2, or 4) and can be played 
back as loops. MIDI loops consist of a MIDI Take (view page 61) that contains the 
notes (MIDI file) and the sound settings for a particular software instrument. Both 
types of loop have advantages and disadvantages:  

 Icon Advantages Disadvantages 

Audio • Recordings made on 
professional studio equipment 
with top quality instruments 
and expensive synthesizers. 

• They require less computer 
power than sounds 
reproduced in realtime. 

• If the original tempo of the 
loop is changed with 
timestretching (view page 
143) the sound quality can be 
negatively affected. 

• The melody and rhythm are 
already set in the recording 
and can only be adjusted with 
complicated pitchshifting. 
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MIDI 
 

• Pitch and tempo changes 
don't require additional 
computer power and don't 
affect the sound quality. 

• You can use the MIDI Editor 
(view page 94) to change the 
melody of the loop any way 
you want. 

• Software instruments process 
the sound in realtime and 
therefore require more 
computer power. 

• Even the most high-quality 
samples don't sound quite as 
natural as real instruments. 

 

Instruments 
This button opens the folder containing your software instruments. You can read 
more on this in the Software Instruments (view page 119) chapter. 
 

File manager 
The file manager works in a very similar way to Windows Explorer. It can be used to 
access and load media files of all kinds: Videos, photos, MP3 files and audio CD 
tracks. 

 

 You can access the File manager through the tab at the top. 

 My computer: Displays the top level of the file system for controlling all drives. 
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 My music displays the music folder. The Music folder under My files is preset 
here, but you can select one of your own folders through the program settings 
(More information can be found in the section "Folders" on page 250).  

 Use the arrows to open and close folders. 

  All supported multimedia files and subfolders of the currently selected folder are 
displayed in the file list. All entries can be loaded into the arranger tracks by 
double clicking or via drag & drop. 

Double click on a folder to switch to it. This folder will become the new starting 
point for the tree structure. 

 Go one layer up 

 The file path of the displayed folder 
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Control tab 

 

The Control tab contains tools for creating and editing objects: the keyboard, object 
inspector and templates folder.  

 
• The Keyboard enables software synthesizers to be played and recorded directly 

via the onscreen keyboard. 
• Under Templates (view page 50) you can find the presets for all types of audio, 

video and title effects. 
• The Inspector offers quick access to properties of objects, e.g. audio effects for 

audio objects.  For MIDI objects (view page 89), a smaller version of the MIDI 
Editor (view page 94) is shown, which allows you to edit the selected object. 
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Keyboard 
The keyboard enables software synthesizers to be played and recorded directly via 
the on-screen keyboard. 

 

If a track synthesizer is not present, then a new track will be added and a new 
synthesizer plug-in will be added when the view is switched to "Keyboard" (Vita with 
Sound Acoustic Bar Piano). 

The keyboard always controls the synthesizer in the track for which MIDI recording 
has been activated. 

You can click the keyboard with the mouse to play the instrument. The closer to the 
bottom edge you click on the "virtual keys", the louder the sound will play. Of course, 
you can't seriously play music by clicking with the mouse (this function is more 
suitable for testing out sounds quickly). That's why you can also play the keyboard 
with the keys on your computer's own keyboard.  

Note: This works only after you first click once on the keyboard using your mouse. 
Otherwise, pressing the computer keys will function as keyboard shortcuts (view 
page 277) for the different functions in Music Maker. If the computer keys control 
the program's keyboard, then the piano keys will display the corresponding keyboard 
characters.  

Use the vertical arrow buttons to move the octave range that the 
keyboard can be played in. 

You can use the horizontal arrow keys to select the next or previous 
sound of the synthesizer or they can be selected directly in the list field on 
the side. 

 
This button opens the editor window for the synthesizer for fine tuning 
the sound. 
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Arpeggiator 

 

The arpeggiator is a special function that can be used to create full chords 
or broken chords (arpeggios, i.e. the notes of a chord played in quick 
succession) by pressing a single key. 

 

C note  C major chord C major arpeggio with 1/16 notes 

 

 This button activates the arpeggiator. 

 This switch determines whether the played note will generate no chord, a major 
chord (Dur) or a minor chord (Moll). 

 This switch determines the type of arpeggio. When set to the far right, a normal 
chord is played. The other positions are up, down or up and down. The figures 
are repeated as long as the note is played. 

 The tempo of the arpeggio is set here and can range from 1/4 notes (slow) up to 
1/32 notes (very fast). 

 

Scale 
With the "scale" feature you'll never hit the wrong note! The keys of the screen 
keyboard are replaced with a list of playing areas where you can only play notes from 
the scale that has been selected. 

 
This button activates the scale feature. 

Choose between various scales by clicking on the arrow. 

 

The keyboard in scale mode.  
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The circles on the playing areas will guide you. The doubled circles indicate the tonic, 
which is the note that the scale begins with. The following scales are available: 

Major C, D, E, F, G, A, H 

Harmonic Minor A, H, C, D, E, F, G#, A 

Pentatonic C, D, E, G, A 

Major Blues (Major) C, D, D#, E, G, A 

Major Blues (Minor) C, D#, F, F#, G, B♭ 

Indian C, C#, E, F, G, G#, H 

Japanese C, C#, F, G, G# 
 

Tip: The scale feature also works with the MIDI keyboard. The scale is played on the 
white keys and the black keys play the same note as the white key directly below it.  

 

Templates 
The folders for installed effects presets will be opened. Even saved audio and video 
effect presets as well as title templates end up in these folders, so that over time, a 
complete library of your own presets will be created. 

 

The buttons to the left open the folders for audio effects ("Audio FX"), presets for the 
Vintage Effects Suite ("Vintage FX"), title templates ("Titles"), video effects ("Video 
FX"), and animations ("Visuals"). 

You can also add effects by drag & drop. They can simply be dragged onto the 
corresponding object using the mouse. 

Tip: When an audio effect lands on the audio objects by right-clicking the context 
menu, the dialog for the particular audio effect (view page 135) will open and you 
can adjust it more precisely! 
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Navigation buttons 
Forwards/Back  The "Back" button always returns you to the 

folder where you were previously. 

Up 
 

The "Up" button brings you to the next highest 
folder level. 

View  These buttons switch the file view list between 
icons, lists, or details. 

 
 

Objekt-Inspektor 
Der Objekt-Inspektor bietet einen schnellen Zugriff auf Eigenschaften von Objekten. 
Er kann zwei verschieden Ansichten haben, je nachdem, ob ein Audio-Objekt (view 
page 66) oder ein MIDI-Objekt (view page 89) ausgewählt ist. 

Bei Audio-Objekten wird das Objekt-Effekt-Rack (view page 137) eingeblendet, bei 
MIDI-Objekten eine verkleinerte Ausgabe des MIDI-Editors (view page 94), in dem 
Sie das ausgewählte Objekt bearbeiten können. 

Hinweis:Die Bedienung des MIDI-Editors im Objekt-Inspektor ist identisch zu seiner 
„großen” Variante im eigenen Fenster, allerdings sind das Menü und verschiedene 
Wiedergabe- und Aufnahme-Einstellungen nicht vorhanden. Für mehr 
Informationen lesen Sie bitte im Kapitel MIDI-Objekte den Abschnitt MIDI-Editor 
(view page 94)! 

 

More sounds 
You can preview additional sounds from Catooh , load them into the project and edit 
them further. 

Tip: Read the introduction online. 
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Mouse modes 
MAGIX Music Maker Premium Steam Edition offers special mouse modes for 
arranging and editing objects. 

 
A small arrow next to the mouse pointer symbol allows different modes to be 
set. 

 

Move selection 

 
This is the preset mouse mode in which most changes are made. Left clicking 
selects an object. When the "Shift" or "Control" keys are pressed, multiple 
objects can be selected. 

Hold down the mouse button to move selected objects.  

In this mode the objects can be faded in or out or their lengths can be changed using 
any of the five handles. Please refer to the "Arranging objects" (view page 56) 
chapter. Right clicking on an object opens the context menu with the most important 
effects and settings available for that specific object. 

If an effect curve is active (only available in the Live & Premium version of Music 
Maker), the curve handles can be selected and moved. Double clicking on the curve 
creates new handles. 

Shortcut:   Ctrl + 1, number key 1 
 

Move to track 

 
This mouse mode behaves basically like the mouse mode for individual objects, 
but moving objects  

results in all other objects behind the object moving in sync on the track. This is 
practical if space is needed at the start of a track, since all objects can be moved 
together without moving them underneath each other. 

Shortcut:   Ctrl + 2, number key 2 
 

Move all 

 
This mouse mode behaves in principal just like the "Single object mouse mode",  

but during moving, all objects on all tracks will be moved together from the mouse 
position. 
Shortcut:   Ctrl + 3, number key 3 
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Automation 
 

This mouse mode is used for drawing the volume and effect curves (view page 
220).  

When active, a new curve can be drawn on an object or track using the left mouse 
button.  

 Activate the corresponding effects curve in the "Effects" menu in the track box 
to enable track automation. 

For the object, use the "Automation of this object" command form the "Effects > 
Automation" menu (Key: Ctrl + H) and select the corresponding curve in the dialog. 
Clicking on an object without an activated effects curve activates the volume object 
curve for this object. 

Note: In this mode, the object curves will always be edited, even if a track curve is 
also displayed. If you would like to edit the track curve at this position, then you will 
need to  temporarily move the object somewhere else. 

Individual automation points on a curve may also be created in the normal "Move" 
mouse mode (see above) by double clicking the corresponding curve. 

For more information about automation curves, please read the chapter Automation 
curves (view page 220)! 

Shortkey:   Ctrl + 4, number key 4 
 

Draw 
 

In this mode you can insert further similar objects behind an already loaded 
object. 

Starting from the first object, the following objects are always inserted synchronously 
so that you can also think of this mode as the insertion of a "Mute" automation from a 
continuous loop. You can read more about this in the section "Drawing in loops (view 
page 60)" in the chapter "Arranging objects". 

Shortcut:   Ctrl + 5, number key 5 
 

Split 
 

You can split objects quickly with this mouse mode in order to remove 
unwanted parts or attach various effects to parts 
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of objects. 

Shortcut:   Ctrl + 6, number key 6 
 

Stretch 
 

This special mode is for customizing the length of objects.  

Objects can be on the lower handles stretched or compressed. Audio material is 
therefore lengthened via timestretching without changing the pitch itself The middle 
object handles allow the object's pitch to be changed using pitchshifting in the range 
of -7... +7. 

Shortcut:   Ctrl + 7, number key 7 
 

Preview audio 
 
In this mode you can individually preview audio objects in the project. By clicking 
on the audio object it will be played back from the start to the end of the solo   

for the entire duration and independent of the start and end markers in the timeline. 
The objects are protected against inadvertent moving in this mode. 

Shortcut:  Ctrl + 8, number key 8 
 

Scrubbing 
 

By holding down the mouse button, the project can be previewed at the point 
where the cursor is positioned.  

The playback marker follows the mouse movements. This mode is especially suited to 
searching for specific parts of a project. 

Shortcut:   Ctrl + 9, number key 9 
 

Replace 
 

This mouse mode simplifies searching for suitable samples: Left mouse click on 
a MAGIX   

Soundpool object to switch the object automatically with another from the same 
instrument category. Shift + left mouse click keeps the object but changes the pitch. 
Ideal for quick experimentation! 

Shortcut:   Ctrl + 0, number key 0 
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Context help 

 
This mouse mode allows you to open the corresponding "Help" section by 
clicking on any area of the MAGIX Music Maker Premium Steam Edition 
screen. 

 

Shortcut:   Alt + F1 
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Arranging Objects 
In MAGIX Music Maker Premium Steam Edition you can jointly and uniformly load, 
arrange, edit, and export different multimedia file formats. This chapter describes the 
basic way of working with multimedia objects. This includes audio objects, video 
objects, graphics, midi objects, and synth objects. Later chapters will describe the 
particulars of the respective formats. 

All object editing is virtual, non-destructive, and is calculated in real time during play. 
The multimedia material is thus not destroyed (non-destructive editing) and any 
change can be cancelled with the multi-stage undo function ("Ctrl + Z"). You can 
experiment to your heart’s content without having to fear that you will change or 
damage the original material. 
 

Save/load projects 
"Project" refers to all objects found in the arranger (audio, video, MIDI, songs, 
graphics, synthesizers) along with all their positions, fades, lengths, volumes, 
brightness settings, and effects. 

Projects can be saved via the menu "File"as an MMM file and loaded again.  

When loading projects you must ensure that all media files used (audio, video, image 
files) are available in their respective folders. To save projects completely, to archive 
them, or to edit them using a different computer, use the function " Save project and 
used media..." from the menu "File" > "Backup". The entire project along with the 
media files will then be saved in one folder. 
 

Multimedia files and objects 
All multimedia files supported by MAGIX Music Maker Premium Steam Edition can 
be previewed or listened to in the Media Pool by clicking on the file name and 
dragging it into the arranger with the mouse held down (Drag & Drop). The files are 
displayed as objects in the tracks after the mouse is released.  

Right-clicking on an object opens the context menu with the most important editing 
options available for that specific object. 
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Preview function 
There is a preview function for all entries in the Media Pool and the templates folder 
in the Control tab. A simple click on a loop or audio file starts the preview function via 
the sound card. Video and picture objects are displayed on the video monitor. There 
are also previews for effects that display their effects. 

During playback, there is an advanced preview function (Smart Preview (view page 
66)) for Soundpool samples, which allows you to preview sounds in the context of the 
project. 

Note: Audio files are already adjusted to fit to the current tempo of the project when 
previewed with time stretching (you can disable this in the Audio/Video options). 

 

Select objects 
To edit or delete objects using the menus, you must first select them. To do so, simply 
click on the object you wish to select. When the Shift key is pressed, multiple objects 
are selected. Object modifications like cutting, moving, effect allocations and so on, 
apply to all selected objects together. 

To visually highlight the current selection, the object handles (see below (view page 
58)) of the selected objects are displayed. 

Several objects can be selected quickly by clicking on the first object in the first track 
with the mouse and dragging out a square for selection. All objects entirely or partially 
within the square will be selected (rubberband selection). 
 

Mute objects 
Each object can be muted individually. Simply select the objects you want to mute 
and press Ctrl + M (or use the corresponding command from the context menu). 
 

Build or split object groups 
Several objects can be combined to make up a group and avoid the objects being 
unintentionally moved out of relation to each other. To create a group, select the 
respective objects and the command "Edit Menu > Object > Group > Form group" 
(Keyboard shortcut: Ctrl + G). 

Once they are combined, clicking on one object of a group will select the entire group, 
allowing you to move, copy, or delete the group as a whole. To ungroup objects, use 
the corresponding command in the "Edit" menu or the keyboard shortcut Ctrl + U. 
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Split objects 
All objects can be split. This way, two new independent objects are created. To do 
this select the object and move the playback marker to the position where you want 
to cut by clicking on the timeline.  

 
Click on this button in the upper toolbar (view page 277) or click on "Edit” > 
"Object" and select the option "Split objects” or press the "T” key. It's even 
easier with the mouse mode "Split objects (view page 53)".  

The two new objects keep all object effects (view page 135). For example, you can 
then design a loop in a more varied manner by first overlaying an object as a whole 
with an effect before cutting it into several parts and then varying the effect 
parameters in the individual parts. 

You cannot easily combine two such object parts again. But you can edit them 
together by joining them together in a group. To do this you can select the individual 
parts and select the command "Group" (Ctrl+G). 
 

Duplicate objects 
To duplicate objects select the object(s) and select in the "Edit" menu > "Object" > 
"Duplicate objects" (Ctrl + D). A copy of the object appears right beside the original 
which can be moved to any position with the mouse. 

Tip: Speed up this process by clicking on the object to be copied with the mouse 
while holding down the Ctrl-key. This generates a copy, which you can immediately 
drag to the desired position. 

Another way to duplicate is by using the copy/edit commands from the "Edit" menu 
> "Object" or "Section". For the latter, all objects will be copied in the playback range 
(view page 36). 
 

Object Handles 
 

 

You can fine tune the object start, end, and volume as well as the fade-in and fade-out 
with the object handles for each object. 
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Shorten or loop objects 
Objects can be shortened by dragging the lower right corner to the left. During this 
process the mouse pointer turns into a double arrow. An object can be shortened 
from the start in the same way, e.g. if too much silence was recorded before the 
actual audio began. To do this, simply use the handle in the lower left corner. This can 
be used to shorten samples or recordings without having to cut them. 

To extend the object again, drag the object boarder outwards. If you drag the object 
beyond its original boundaries, it will loop (i.e. repeat) until the end of the object is 
reached. This allows you to create, for example, a complete drum track from a short 
drum loop, or a long video from a short video sequence. 

Normally an object is always looped over the full length of the underlying data 
material (audio or video file). To set a clip from a file as a loop, shorten the object at 
the front and the back with the handles and choose the in the "Edit" menu > "Object" 
> "Loop section" > "Insert user-defined loop". This function is very useful for setting 
your own recording as a loop, as the silence at the beginning of a recording can be cut 
away. 
 

Fading Objects 
An object can be faded in or out with the handles to the left and right upper corners of 
the object. The length of the fade can be adjusted with the handles.  

If an object on a track is moved to a position where it overlaps with another object, 
the length of the overlap will automatically become a crossfade. This means that the 
first object is faded out while the subsequent object is faded in simultaneously. The 
duration of the fade-out is equal to the duration of the fade-in but can be adjusted 
using the upper handles. 

 

Crossfade 
 

Setting object volume 
Using the volume handle located centrally at the top of the object, you can set the 
volume of individual audio, synthesizer, or MIDI objects. 
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In connection with the ability to cut objects (see above), this makes it possible to edit 
the volume progression in detail. 

 

The drum loop in the first bar was cut into individual parts in the second bar and the volume 
varied. 

You can adjust the overall volume of a track or the volume performance between the 
tracks more conveniently in the Mixer (view page 204). 

Note: The handle serves the transparency settings for videos, images, and title 
objects. 

 

"Draw in" loops 
Audio loops can be drawn into the arranger tracks with the mouse. 

 
For this you have to set the mouse mode to "Draw objects" by clicking on the 
corresponding icon in the mouse modes menu. Now an audio sample has to 
be loaded which will serve as a template and which will then be drawn into the 
following area of the track as a loop in the track. This works as follows: 

1. Load any loop from the Media Pool into the arranger. 
2. Click on an area further back on the same track and hold down the mouse 

button to draw in the loop. 

Starting from the first object, the drawn-in loop area is always synchronous with the 
beat. This means that the drawn-in loop is not played from the beginning, but rather 
starts from the position where the original loop would be if you had continued to this 
position. Or, to put it differently, a running loop can be found on the track and you can 
draw in at which position you can hear it ("Mute automation").  

The synchronous start of the object in this mode has another consequence: If an 
object is moved, then only object borders are moved, but the underlying loop, 
however, always remains intact.  
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Takes 
Every object can be saved as a "Take". Takes save all editing done on an object, like 
object length, fade settings and all object effects. MIDI takes save the instrument 
controlled by them (MIDI output or software instrument). 

Takes are saved as "TAK" (*.tak) files and take up virtually no space on the hard disk. 
This means you can cut a sample, add various effects to it and save it as various takes 
in order to use these together with all their editing in other MAGIX Music Maker 
Premium Steam Edition projects. Instead of repeatedly saving the original sample, 
only the object and effect settings are saved. 

 The MIDI loops included with MAGIX Music Maker Premium Steam Edition 
(you'll recognize them in the Media Pool by this icon) are also takes because the 
MIDI files (view page 89) only sound the way they were intended when 
combined with the right synthesizer sound. 

Attention: When loading takes, the audio or video file for which the take was added 
must be in the original folder. 

Keyboard shortcut:  Alt + Shift + S 
 

Live Arranger 
The Live Arranger lets you generate arrangements live. To do this, you need to define 
areas of your project as song parts (intro, verse, bridge...). You can then play these 
parts back exactly according to the beat. You can experiment with different 
arrangements and song structures. You can then record this live performance or 
program it using the sequencer. Afterwards, the result can be transformed into a 
finished arrangement. 

Open the Live Arranger via the menu "View > Mix > Live Arranger" 
 

Define ranges 
To play your arrangement with Live Arranger, you must frame individual area in the 
project and define them as a section in the Live Arranger. 

Open the Live Arranger, define a playback range (view page 36) and then press the 
corresponding key on the keyboard (a-k or y) or click on the corresponding button. 

 



 

62   

www.magix.com 

Repeat the process with all desired playback ranges. 

 

The playback ranges will be displayed directly below the timeline. 

The ranges can be renamed for better orientation. To do so, please right click on a 
range button or the range marker along the timeline and select "Rename". To delete 
an assignment, right click and select "Delete".  

To reassign buttons already assigned to other ranges, right click on a button and 
select "Assign to current range". 
 

Play with Live Arranger 

 
If this symbol is active, the Live Arranger is in playback mode. 

If you click the appropriate key on the keyboard or click a button, the assigned range 
will be played back. 

If you activate a different range, playback will switch to the other range. The time 
point of the switch can be determined using the quantization buttons. 

 
Immediate switch. Warning, this can throw the project out of rhythm! 

 
Switch after one beat (1/4 bar). Interesting rhythmic displacements can 
result. 

 
Switch after one bar. 

 
Switch after two bars. 

 
Switch after four bars. 

 
Switch at the end of the range. The range will be played out to its end, 
irrespective of its length. 
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If the range just played back is shorter as the quantization length, for example if 
"switch after 4 bars" is selected for a 2-bar range, the switch will always be made at 
the end of the range.  

 

Stop button: The "Stop" button discontinues playback. As opposed to the 
normal stop using the transport control or the space bar, the playback will not 
be stopped immediately, but the quantization settings will be taken into 
account. If "Switch after one bar" is selected, the current bar of the range will 
be played to the end and then the playback will be stopped. 

Stop is then also a "range" and can be also programmed in Sequencer (view 
page 63), for example for temporarily undefined breaks. 

 

Sequencer 

 
By clicking on this symbol you switch the Live Performer into the Sequencer 
mode. 

 

Sequencer programming 
Above the range buttons the text line will appear for function control (Sequencer). 
Enter ranges in the order in which they should be played back. Corresponding letters 
will be inserted in the Sequencer. This text line can be handled as any other text line: 
Letters will be added at the position of the cursor (small, blinking vertical stroke), the 
arrows move the cursor, and with Del or Back keys entries can be deleted. 

Warning: In playback mode a range will be played as a loop until a different range is 
selected, and one letter corresponds exactly to a one-time playback of the range. If, 
for example, range D with a length of 2 bars should be played for 8 bars, DDDD 
should be entered. 
 

Playback sequence 

 
This starts the sequence. The range play back always begins at the cursor 
position (the Sequencer cursor). 

A progress bar in the Sequencer shows the position in the progression  where the 
sequence control is found at the moment. Currently playing or played ranges are 
displayed in gray, and the cursor always moves in front of the next playing range. 
When the end of the programmed sequence is reached, this will be repeated from the 
start. 

You can also enter the sequence during playback. The ranges are then entered at the 
end of the sequence. 
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You can also program the stop button (.). When playback reaches stop it will be 
stopped. A repeated sequencer playback start occurs from the cursor position, or 
behind the stop. You can thus program a progression, which stops after each played 
range (cue list for theater or a radio play).   
 

Load and save Live Arranger sequence 

 
This button transforms the programmed or recorded Live Arranger sequence 
into an arrangement. 

A new project will be created, which corresponds exactly to the sequence. This 
means that the defined ranges will be copied one after the other according to the 
order and length defined in the sequencer. Your current project will be lost. 

But the Live Arranger ranges will be applied to the new project. This means that you 
can continue using the Live Arranger in your new project, or you can close it and 
further edit the finished project. 
 

Loading and saving Live Arranger sequences 

 
With the load and save buttons next to the sequencer, you can save and 
later load recorded or programmed Live Arranger sequences. 

Here's a use scenario: Let's assume that you've defined various ranges in a project 
and have created a sequence. Before putting the piece together by creating a new 
arrangement with the "Transform sequence into arrangement" button, first save the 
raw material project and the sequence.  

If you would like to change a certain sample or transition later in your "finished" song, 
you don't have to do this at each point where the sample is used. Simply load your 
output project, change the respective spots, load the sequence and create your song 
anew. You can quickly create variations on a single piece in this fashion. 
 

Live Arranger recordings 

 
This button starts the Live Arranger recording. 

This will record all range switches in your timeline made with the Live Arranger. As 
opposed to programmed sequences, ranges can be played back only partially. The 
recording matches your performance exactly. 

The precise length of such "partial" ranges can not be changed later in the sequencer. 
You can remove them from the sequence, but you cannot insert them into it. You can 
only create them with a Live Arranger recording. 
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If, for instance, the button for playing the sequence is activated when the Live 
Arranger is active, the Live Arranger will automatically switch to Sequencer Mode and 
the recording will be stopped. 
 

Record audio output 
You can record the complete audio output of MAGIX Music Maker Premium Steam 
Edition directly into a WAV file. The option "Write real-time audio in WAV file" can 
be found for this in he "Playback parameter" dialog (Menu "File > Settings> Playback 
parameters" or button "p").   

If this option is activated, with the next start the complete playback of the project will 
be recorded live. With the next stop you can save your recording and load it for 
immediate editing in the project. Use different names to save your single sessions, 
ensuring that no recording will be mistakenly erased.   
 

Mixdown audio 
If the arranger becomes too full to manage, the system is out of RAM, or you just 
want to ”summarize” your production, use the mix down function to convert the 
entire project into a single audio and/or video file. 

To do so, choose the "Mixdown" function from the "Edit" menu. You can choose a 
name and a destination for storing the mix down object. The default directory is ”My 
Projects”. If only audio objects are in the tracks, a wave file will be created. If audio 
and video objects are combined, you can choose whether an audio or a video file will 
be created. 

The objects of the arranger or the area will be replaced by the new object. 

MAGIX Music Maker Premium Steam Edition automatically normalizes the audio file, 
i.e. the loudest part of the wave audio object is identical with the highest figure of the 
16-bit resolution ceiling. This guarantees the same sound quality, even if you repeat 
the mix down procedure or you combine the mix down file with other wave audio 
objects again and again.  

Tip:The mix down function is very helpful if you want to go on working with the mix-
down object. To create the finished end version of the song or video it is 
recommended to select the "Export project" function in the "File" menu instead of 
the "Mixdown" function. 

Shortcut:   Ctrl + Shift + G 
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Audio Objects 

Audio formats 
MAGIX Music Maker Premium Steam Edition can load audio files in the following 
formats: Wave (.wav), Ogg Vorbis (.ogg), Windows Media Audio (.wma), MP3 
(.mp3), AIFF (.aif), FLAC (.flac) and CDA (audio CD tracks). The audio data of a file 
are displayed as an object in the arranger of MAGIX Music Maker Premium Steam 
Edition. The material will be displayed as a waveform, optically representing the 
sound to make editing easier. MAGIX Music Maker Premium Steam Edition can 
export files in all formats listed above.   

In addition the Live & Premium version can load and export the surround formats 
Surround-WMA and wave (6-channel interleaved). 
 

Load and edit audio files 
All importable audio files can be accessed from the Media Pool and previewed (as 
sound) by clicking the file name. Any file can be moved into the Arranger using Drag 
& Drop. Tracks from audio CDs can also be integrated into the project using drag & 
drop. 

Edits, fine positioning, volume settings, and fading in and out may all be adjusted 
directly in the Arranger using the object handles. See chapter "Arrange objects”. 
 

Smart preview for the included samples. 
The included samples can be previewed while the project is being played. They are 
always played in time with the song. This means that if you combine loops from 
different styles that have different tempos they will automatically be adjusted to the 
current project tempo even in the preview. 

You can compose a song in realtime by loading different samples and searching for 
suitable new building blocks during playback. 

Start the playback and select a loop by simply clicking the mouse. The loop will be 
used as a preview on the next available track and played back together with the pre-
existing audio material. Update the preview by selecting another loop. You can then 
try out the all of the soundpool samples in the context. 

As a preview, the loop will always be extended to the entire length of the playback 
range. The result is therefore immediately audible, even if the loop is originally shorter 
than the selected playback range. If you adopt the loop in the project (double-click or 
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press the Enter key), it will be introduced in its original length at the beginning of the 
playback range.  

Tip: You can also use key commands to quickly change the playback area (view 
page 36) by using the arrow keys. This will let you add loops to your project with 
more precision. 

 

Audio recording 
Your own sounds like vocals, speech, noises, or instruments can be easily recorded in 
MAGIX Music Maker Premium Steam Edition using the audio recording function. 

 Click the REC button in the track box to specify the track for the recording.  
 

The display in the track box will change   
 

The input signal will be played back featuring all track effects (if there are any) (live 
monitoring (view page 70)). 

Live monitoring requires the use of ASIO drivers (view page 247). 

 

Click the red button on the transport bar to start the actual recording. 
Click on the gear icon next to it to open the dialog box "Audio 
recording" (view page 68) with various settings options. This dialog 
box can also be opened after starting the recording. 
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Audio recording dialog 

 

Audio Input: Selects the sound card for the recording. 

Save audio file as/storage location: Here you can select the title of the audio file you 
wish to record. You can also select the folder where you wish to store the file. 

Recording quality: Sets the sound quality of the recording. In the preset menu you can 
choose between AM Tuner, FM Radio, CD Audio, and DAT (Digital Audio Tape). 

Mono/Stereo: The recording can be made in mono or stereo. Mono recordings are 
recommended for song and instrument recordings made using only one standard 
mono microphone. This reduces the required memory space in half. 

Peak control: This opens the Windows system dialog for the selected sound card 
drivers. There you can customize the input level  and deactivate the system 
monitoring (view page 70).  

Level indicator (L/R): Use the level indicator (peak meter) to monitor the strength of 
the input signal. Please read more on this in the section 'Adjusting levels'. 
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Direct monitoring: Select this option to switch the live monitoring on and off. Please 
read more on this in the section Listening to the input signal - monitoring (view page 
70). 

Advanced: Use this button to open a window containing a selection of three special 
functions. 
 

Advanced settings 
• Normalize after recording: This option raises your material to the correct volume 

level after recording is completed. In order to achieve good audio results, you 
should try to record the source as loud as possible without overmodulating it. 
The Peak Meter display here helps in the recording dialog. 

• Realtime adaptation of the sample rate: This automatically adapts the sample 
rate if the file you wish to record to the sample rate of the current project. 

• "Ducking" (reducing the sound volume): This is a function for video dubbing. To 
add narration or other sound material to a video that already has sound volume 
levels set, activate the option ”Automatic reduction of sound volume of 
remaining audio tracks”. This automatically reduces the volume of audio objects 
in the project during the recording session (”ducking”). This is achieved using an 
automatically configured volume curve: Before and after the recording other 
tracks will be faded in or out, resulting in a homogeneous total volume level. 
(Lowering of volume level during spoken comments is also called "Ducking".) 

 

Adjusting the signal level 
Adjusting the signal level to the sound card is also recommended to get the best 
sound quality when recording digitally. 

Once a recording source is connected to the sound card, the small gear wheel button 
next to the Record button opens the recording dialog and starts the recording source. 
You can now adjust the recording level with the help of the LED display in the record 
dialog. 

If the adjustment is set too high, distortion occurs and the incoming signal must be 
reduced. If you have linked the sound source directly with the sound card without a 
mixer, this can only be done via the Windows system settings "Sound". You can 
access this directly from within the recording dialog via the “Recording level” button. 
You will see which sound card input is already being used with the amplitude in the 
small peak meter in the settings dialog. Double-click on this and change in the tab 
"Level", 

If you reduce input sensitivity by using the input fader, the resolution at which the 
analog signal is digitized is also reduced. Try to set these automatic controllers to the 
loudest sound level possible! The yardstick for the optimal level setting is the loudest 
part of the material. The loudest part should be adjusted to the maximum. 
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Note: Not all sound card drives fully support the Windows system mixer; this 
functionality can also potentially fail. Some sound cards also come with its own 
mixer application in which you can control the input level. If both fail, you need to 
match the level to the analog source. 

 

Listening to the input signal - monitoring 
You usually want to listen when you record something. This is called monitoring. 
There are different ways of monitoring in Music Maker. 

Live monitoring 

This is the preset method and allows you to listen to the input signal via the audio 
processing of Music Maker, that is, with all effects, i.e., the track effects as well as the 
AUX send effects and master effects. 

You can therefore hear your vocals or guitar recordings with the necessary effects 
while recording or jam live to a finished project. 

An ASIO driver is needed for monitoring. Professional soundcards come with such 
drivers. For any soundcards that don't have this there is the MAGIX Low-Latency 
driver, which provides any sound card or on-board sound chip that is fitted with 
WDM drivers with an ASIO driver. For more information see the Menu "File" > 
"Settings" "Program Settings" > "Audio/MIDI" (view page 247)section. 

There will be a short delay (latency) caused by processing the audio signal. This delay 
amounts to just a few milliseconds with modern sound cards. You can deactivate this 
option should it still disturb you. To do this, uncheck the "Direct monitoring" box in 
the recoding settings dialog. 

System monitoring 

You may already hear your input signal or two input signals with live monitoring 
before you have activated the track for recording. This is due to the fact that the line-
in input is configured so that its signal is directly routed to the output. This is a feature 
of the Windows operating system and not of Music Maker. The purpose of this is to 
allow you to connect external audio sources, such as MP3 players, via the input and 
listen directly through the computer speakers.  

To disable this unwanted "monitoring", click on "Peak control" in the "Audio 
recording" dialog box, double-click on the input used (identifiable on the peak meter 
amplitude), and change the tab "monitor" in the subsequent settings dialog. There 
you can deactivate the option "Use this device as playback source". 

On the other hand, you can also use this type of monitoring if the live monitoring is 
not suitable, because the ASIO driver does not function in a stable way. Or if you 
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don't want to use the live monitoring because you find a small latency disturbing. 
However you then cannot listen to the Music Maker effects. 

Note: Not all sound card drives fully support the Windows system mixer; this 
functionality can also potentially fail. Some sound cards also come with its own 
mixer application that provides monitoring. 

External monitoring with a mixer 

You can also monitor without using the computer with an external mixer. Small 
mixers with a USB connection that are both mixers and sound cards are suitable for 
this. It is the same as with the system monitoring (no latency but also no effects). But 
it has the advantage that you have direct access to the input level and monitoring 
level in the mixer. The external mixer enables you to use the in-program live 
monitoring. But you must be careful not to create any feedback loops, thus avoiding a 
repeat recording of the output signal. 
 

Import audio CD 
Entire music tracks from audio CDs can be imported into the project through the 
Media Pool in the same way as importing files from the hard drive. 

1. Insert an audio CD into the CD/DVD drive of the PC 
2. Go to your CD/DVD drive in the Media Pool (File Manager, Computer). The 

individual CD titles appear in the file list. 
3. A simple mouse click starts the playback of the CD title for sampling purposes 
4. Drag & drop the track from the CD into a track of the current project and it will 

be digitally scanned and copied to the hard drive. The files will be saved in the 
import folder (may be specified in "File" > "Settings" > "Program..." > "Folder" 
(More information can be found in the section "Folders" on page 250)). 

5. The CD track appears in the track as an audio object and can be played back or 
edited immediately. 

Use the CD import dialog for more advanced control of the import process, e. g. 
importing sections from music tracks. You can access this dialog box via "File" > 
"Import" > "Import audio CD track(s)..." (Keyboard shortcut: C) 
 

CD import dialog 
In the CD import dialog box you can select tracks from audio CDs and partially or fully 
import them into the project. You can also select and configure the used drive if you 
have more than one drive. The data is imported digitally which eliminates any loss in 
sound quality. The CD tracks are imported into the project as wave files. The files are 
saved in the import folder. (File menu > Properties > Program settings > System > 
Path settings (More information can be found in the section "Folders" on page 250)) 
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To import audio CD tracks, insert an audio CD into the drive and select "Import > 
Import audio CD track(s)" from the File menu. A dialog with a list of the CD tracks will 
open. If you have more than one drive, you may have to first select the drive 
containing the CD. You can do this in CD drive options . 

 

On the left-hand side in the list you can choose which track(s)/title(s) you wish to 
import from the CD. Several subsequent tracks can also be selected by holding the 
"Shift" key + mouse clicking; "Ctrl + mouse-click" selects several individual tracks. By 
clicking on "Select all tracks", all audio tracks will be selected, e.g. for copying the 
complete CD.  

Now click on "Save selected tracks..." This will open the "Save audio to..." dialog, 
where you can specify the name and target address of the audio files. The audio files 
are subsequently numbered depending on their names (name -> name_1.wav, 
name_1.wav...). "Save" starts the audio copying process. A progress bar is displayed. 
Once ripping is complete, the dialog will be closed and the tracks are inserted into the 
project as individual objects. 

In the top right field, details on the total length and the memory capacity of the 
selected track/section are displayed.  

Transport control: This lets you start and stop playback 
just like on a real CD player and skip forward and 
backward in the playlist. 

With the faders below it you can go to a specific position 
in a track. To import just a specific section of a CD track, 
choose "Start selection" at the beginning of the section 
and "End selection" at the end.  
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Use the small "Volume" faders to control the preview volume. The chosen drive 
appears below it. In the right selection box you can select the read speed, and in the 
left one you can select the export mode (see Configuring the CD-ROM). 

CD drive options: Here you can change the settings and select the drive for importing 
the CD if you have installed several CD drives (see also CD-ROM drive dialog). 

Copy-protected audio CDs 

According to the copyright act it is forbidden to copy a CD with copy protection. 
However, an owner of a CD may create a backup copy for himself  - even if it's a 
copy-protection CD. The problem is, however, that you cannot create a copy from 
copy-protected CDs, as they cannot be read with a conventional PC drive. In order to 
create a backup of such a copy-protected CD you have to play it on an audio CD 
player and record it as a regular analog recording via the sound card. 

Keyboard shortcut:  C 
 

CD/DVD drive list 

 

Configuration: This button opens the configuration dialog, where various special 
settings can be made. 

Reset: sets drive settings back to default. 

Add: Creates a new drive in the list, which first requires special settings. 

Delete: Deletes selected drive from the list. 

Load setup: Loads the current drive list and all configuration data from a *.cfg file. 

Save setup: Saves the current drive list and all configuration files in a *.cfg file. 
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CD/DVD-ROM configuration 

 

Drive Name: Lets you edit the name of the drive in the list. This is useful if you create 
more than one entry accessing the same physical drive.  

Host Adapter Number: Lets you specify the number of your SCSI adapter - normally 
0. 

Bus ID: Here you can enter the ID of your CD-ROM drive. Be sure to set the correct 
ID, there is no error checking! 

Bus LUN: sets the LUN parameter, normally 0. 

Alias: Lets you select the manufacturer type of your CD ROM drive. 

Normal copy mode: copies audio files without any software correction. 

Copy mode sector synchronization: copies audio files with a special correction 
algorithm. This is especially useful, since many CD drives have problems finding an 
exact position again and gaps can occur.  

Burst copy mode: optimizes the speed of the copy process, no software correction is 
used.  
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Sectors per cycle: defines the audio sector count that should be read from the audio 
CD in one cycle. The higher the number of sectors, the faster the copying process. 
Numerous SCSI systems have problems with more than 27 sectors. 

Sync sectors: sets the count of audio sectors, which should be used for software 
correction. A higher number results in a better synchronization but also in a slower 
copying process. 
 

Change the playback tempo or pitch 
If you want to combine audio material you have recorded yourself from different 
sources, samples from Soundpools, or songs from CD with each other, then you will 
often need to adjust the tempo or pitch of audio objects to match each other. There's 
an automatic function which automatically adjusts the tempo of audio objects when 
they are loaded to the project's tempo, plus advanced tools like the Remix Agent and 
the Time Processor (view page 143). 
 

Automatic tempo adjustment when loading 
In general, MAGIX Music Maker Premium Steam Edition automatically adjusts audio 
files to the project tempo. In normal cases, you won't need to worry about the 
different tempos of audio files and Soundpool samples, since these are automatically 
matched. But since automatic processes can fail too, the following process explains 
when you may need to "manually" adjust things. 

In the new project (empty), the tempo will be determined by the first samples loaded 
into it. All additional audio files will then be automatically adjusted to this tempo. If 
you are planning a remix which is composed of different samples with different 
tempos, then try to add the most important sample first. This minimizes sound 
distortions compared to the other samples via timestretching. 

In order to be able to correctly adjust an audio object to the tempo, its output tempo 
must first be detected. If the sound is a Soundpool sample, then the tempo saved 
therein ("patched") will be used, and the tempo adjustment will always work. 

For all other (short) samples, an attempt will be made to automatically provide the 
tempo. If the sample is not cut exactly, i.e. it does not contain an exact number of 
beats or is incorrectly interpreted by the automatic detection process, then this may 
not work. The sample will then be incorrectly stretched. In this case you can try to 
manually adjust the sample. 

The Remix Agent launches optionally for longer samples ( > 15 seconds), e.g. entire 
songs from CD or MP3s. This also gives you the option of either adjusting the sample 
to match the project or the project to the sample. 
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MIDI objects for controlling synth objects always have the correct tempo because 
they are always aligned with the project tempo. 

In the dialog Program settings ("Y" key) -> Import, you can deactivate the automatic 
tempo adjustment or limit it to patched samples. In the dialog Program settings (view 
page 246) ("Y" key) -> Import, you can deactivate the automatic tempo adjustment 
or limit it to patched samples. 
 

Changing the tempo or pitch of individual objects 
manually 
You can change the pitch and the tempo of selected audio objects. You can access 
these tools via the effects menu or the object effects rack. 

The playback tempo can be quickly changed via the stretch mouse mode, i.e. by 
compressing/stretching the audio object's lower handles, in which case the tempo 
will change but the pitch will not be influenced. 

For example, to fit a "non-circular" loop with the stretch mouse mode (view page 52) 
in a current project, proceed as follows: 

1. Load the sample. Music Maker will try to fit it into an even number or bars. Set 
the appropriate track to solo and place the playback range exactly above the 
sample. 

2. Select it and click on "Enlarge Object" at the bottom left of the arranger window 
. The object will be displayed at the maximum size. 

3. Turn off the grid (in the list field at the top right of the arranger or with Ctrl+F12) 
4. Now start playback and move the end marker of the playback range to the right 

until the loop runs smoothly. You can rely on your hearing and not just on the 
waveform display. 

5. Now shorten the object to the playback range length. 
6. Deactivate "Enlarge Object" and turn the grid back on. 
7. Switch to the stretch mouse mode (Ctrl+7) and stretch or compress the object 

into an even number of bars. 
8. Deactivate "Solo", set an even playback range, and start playback. The loop 

should run perfectly in time. To set the object as a loop, select "Edit > Object > 
Loop section > Set custom loop". 

To match the pitch of the loop to the current project, you can also change the pitch 
using the mid handles on the object in the stretch mouse mode. 
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Change project tempo 
The tempo setting in the transport controller (view page 40) allows the project's 
tempo to be changed retroactively. All audio objects contained in the project will be 
altered via timestretching to match the new tempo. In some circumstances this can 
lead to an increased demand on the system and dropping out during playback. 

If this occurs, use the Combine audio (view page 254) feature.  

Another option is to use the "Èlastique Efficient" timestretching algorithm, which 
provides a slight decrease in sound quality, but uses less computing power.  

Choose a couple objects which are not so important. Open the Inspector by double 
clicking on Tempo Pitch/Resample (SHIFT + P) and then click the "Setup" button. You 
can switch to Èlastique Efficient here. If the pitch still isn't being retained (drums, 
percussion, FX sounds), you can switch to Resampling, which uses even less 
computing power.  
 

Remix Agent 
To create a remix, elements from a completed song or components of a song are 
added and removed creating a new song. In order to combine your own loops and 
beats with a given song, it is important to know the exact tempo (in BPM - beats per 
minute) of the song. The Remix Agent in Music Maker allows you to define the tempo 
of MP3s or imported tracks from a CD. 

Once the tempo has been determined, you can optionally match the tempo of the 
project to the tempo of a song, the tempo of a song to the tempo of an existing 
project, or divide a song into individual beats (remix objects), which can then be 
rearranged as desired. 

Requirements for using the Remix Agent 
• The song must be longer than 15 seconds. 
• The songs have to contain "rhythmic" music. 
• The track must be in stereo. 

Note: If one of the above requirements is not fulfilled, the Loop Finder can be used. 

If audio files longer than 15 seconds are dragged into the project, the Remix Agent is 
started automatically. 
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Workflow of Remix Agent 
The Remix Agent works in 4 steps: 

Step 1: Checking the start marker 

Step 2: Tempo recognition 

Step 3: Specifying beat starts 

Step 4: Application of BPM and beat recognition 

 

Step 1: Checking the start marker 

Place the play cursor at the position where detection should start in the object by 
clicking the timeline. If the object contains a longer intro without beats but rather 
calm synthesizer pads, you should position the start marker after the intro. 

Furthermore, the start marker should always be positioned just before a beat hit, even 
better, just before a beat at the start of the bar. 
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Step 2: Checking the automatic tempo recognition 

After opening the Remix Agent by pressing the "Continue" button, it will begin to 
analyze the audio material and try to determine the tempo. The object is played back 
while a metronome click relative to the event can be heard and numbered green beat 
lines appear in the waveform. 

The following will be indicated: 

• Position of the start of the measure (one): red lines. 
• Position of the other quarter notes (two, three or four): green lines. 
• Reliably recognized positions: thick lines. 
• Unreliably recognized positions: thin lines. 
• Tapping is indicated by additional blue lines. 

Note: If the tempo or bar information of the object you wish to analyze is already 
available, these are displayed as dots at the respective positions above the display of 
the wave shape. 

Under the waveform on the left side the established tempo is displayed in BPM. There 
is a small transport console in the middle to make navigating easier. The slider serves 
as a position controller. To set the metronome volume, an additional fader and mute 
button are provided on the right-hand side. 

Change beat positions and tempo 
The automatic tempo recognition doesn't always work right away. If you don't hear 
the metronome clicking in time with the music, click the "No" button in the upper 
section of the dialog in order to access the manual tempo input dialog. 

To correct the metronome speed and any timeshift that may occur between the 
metronome clicks you can use the tempo correction as well as the "Tap tempo" 
button: 

Tempo correction: The Remix Agent provides various speed settings – the speed the 
Remix Agent determined as the most probable is preset. If this tempo isn't correct, 
you can choose another one from the list. The next time you play back the song it 
should be in sync with the metronome. 

On/Off beat correction: Now it may happen that the tempo is right, but the beats 
have been displaced. "On/off beat correction" provides a number of alternatives for 
moving the beats according to the complexity of the rhythm. Try out various 
alternatives until the metronome clicks are in sync with the beat. 

Tap tempo: Instead of selecting the tempo under "Change Tempo", you can click 
rhythmically on the "Tap tempo" button or press the "T" key. Additional blue lines are 
displayed in the wave display. After at least four taps, the Remix Agent attempts to 
select the correct tempo from the list in "Tempo correction". The display next to the 
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"Tap tempo" button displays the current status. Keep tapping until the red display 
showing "Unlocked" changes to the green "Locked" setting. 

Use the "0" key to manually set the quarter beats while the music plays. Surrounding 
markers will automatically be removed to ensure that the set tempo remains intact.  

You can move the markers with the mouse. If you hold down the "Ctrl" key 
simultaneously, the subsequent markers are also moved. If the metronome clicks now 
correspond with the music, you can continue to the next step. 

Step 3: Determining the start of a bar: 
Next you can set the time signature. The default setting is 4/4 but you can adjust this 
if necessary. The beat at the start of the bar should coincide with the high sound of 
the metronome, or the red line in the waveform display. 

It can now be corrected in just one step: If the start of the bar can be heard, click on 
"Tap One" once using the mouse or press the"T" key on the keyboard. Alternatively, 
select how many quarter notes the "One" is to be moved back. Use the "0" key to 
manually tap the position of the beginnings of the bars during playback. This allows 
you to correct the beginnings of the bars in longer sections. 

Continue to the last step if the starts of the bars are now correct. 

Step 4: Applying BPM and bar recognition 
This lets you determine what you want to do with the analyzed audio material. The 
following option is available: 

• Create remix objects from the analyzed audio material 
• Adjust the project tempo to that of the analyzed audio material and vice-versa. 
• Save only the tempo and beat information in the audio file for possible editing 

later on. 

Following this, you can also start the Remix Maker (view page 82) and the Harmony 
Agent (view page 84). 
 

Create remix objects 
The song is split bars into individual objects according to beats. The following uses 
are possible: 

• Create loops from complete songs which you can then use with your own 
material. Important: Not all remix objects are suitable for loops. Less complex 
material such as drums from an intro are ideal. 

• To remix songs, that is, change the order of the objects, cut and duplicate 
individual parts or beats of the song, or enhance the song with various other 
loops or synth objects. Why don't you try placing a techno beat under your 
favorite tune? 
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• For mixing 2 songs: The beat and tempo match perfectly so you can fade 
without "side effects". 

You also can activate this function from the "Object" menu only if the tempo 
information has been saved. 

Audio quantization: The new objects are precisely fitted into the bar grid of the 
project. 

There are slight tempo variations in “hand-made” music, so that different bar lengths 
can occur. To make sure the objects fit into the bar grid of the project, the time 
processor is automatically activated and object-timestretching used so that the 
difference in length is corrected.  

Use resampling for small corrections: If the required corrections are not too 
significant, you can use higher-quality resampling instead of time-stretching. You 
should then no longer change the master tempo as this may result in considerable 
pitch changes. 

Remix objects in loop mode: New objects are put into loop mode. When extending 
the length of the object using the right object mouse handle, the object is 
continuously played back in original length. 

Set project tempo to object tempo: (See "Adjust tempo”) 

Note: The time correction allocated to the objects can be undone later if the time 
processor is opened and edited (menu item: Timestretch/Resample Object Menu). 

Cancel: The dialog will be closed. 
 

Adapt tempo 
Set object tempo to project tempo 

Adjusts the object length to the existing project. There are three different options: 
Time stretching, resampling or audio quantization. 

• Use Time stretching: The pitch of the song remains constant in time-stretching; 
however, the sound quality may suffer. 

• Resampling changes the pitch (similar to changing the speed of a record player), 
but retains most of the sound quality.  

• During Audio quantization the tempo adjustments are calculated into the audio 
file in such a way that it appears as if remix objects were created and then 
immediately compiled into a new audio file (see below). If recognition is 
unreliable, the result can show extreme tempo variations. In this case, it is 
particularly important to set the playback marker at such a position (before 
opening the Remix Agent) that the tempo can be reliably recognized. The 
advantage of audio quantization is that smaller tempo variations can be 
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balanced in the music. The beat starts of the music always correspond with the 
beat starts of the project. They do not slowly drift apart. 

Set project tempo to object tempo 

The project assumes the found BPM value. If you would like to use the cut-up song as 
the basis for a new composition like with remixes this option should be active. 
 

Save tempo and bar info 
Only the information will be saved in the Wave file. This makes sense if manual 
correction is required for defining the bar/tempo. Once the information has been 
saved the tempo and bar adjustment will no longer be required for future tempo or 
bar adjustments or when creating remix objects. 
 

Remix Maker 

 

The Remix Maker can be run directly following the Remix Agent. 

Use the Remix Maker to automatically create remixes. Here, the remix objects 
created by the Remix Agent are moved, copied, and newly compiled according to 
specific criteria. You can select one of four DJs who each represent different styles 
and specify the length of the remix and the form of the compilation. 
 

Opening the Remix Maker 
1. New song 

• Load the new song you want to remix. This should contain clearly defined 
rhythms.  

• When the song is loaded, the Remix Agent pops up to give you the option of 
dividing the song into its structural segments (see "Remix Agent" above). 

• Select the option "Open Remix Maker" from the Remix Agent dialog box.  
• Once the Remix Agent has sliced your song, the Remix Maker is started 

automatically.  

2. Existing, edited song (in the arranger) 

• Load a song project that is made up of loop objects. 
• Select one of the loop objects. 
• Select "Remix Maker" from the shortcut menu (right mouse click). 

3. Long, unedited audio object (in the arranger) 
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• Load a project containing a long, unedited audio object. 
• Select "Remix Maker" from the shortcut menu (right mouse click). 
• You are then given the option of generating remix objects.  
 

Presets 
Choose one of four virtual DJs with different remix characteristics. We recommend 
you try them all out and see which results you like best! 

Remix length 

Very short: around 20 seconds 

Short: half the length of the original song 

Normal: regular length of the original song 

Double: twice the length of the original song 
 

Shuffle mode 
This determines the selection and order of the objects. 

Do not change: The order of the objects is not changed. 

Change slightly: A "pattern" (sequence of objects) is either repeated or the next 
pattern inserted. 

Distant: Objects that are far apart in the original song are placed close to each other. 

Random: The objects are ordered randomly. 
 

Fill mode 
A "fill" or "fill-in" is created when the loop object sliced by the Remix Agent again to 
produce very short objects that are looped or played in rapid succession. Fills are used 
to liven up the regular beat.  

None: No fills are included. 

Use slightly: A few simple fills are included. 

Strong accentuation: Many complex fills are included. 

Use randomly: Different kinds of fills are used in a random order. 
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Loop Finder 
The Loop Finder has been developed to find the BPM in short rhythmic passages, to 
integrate short loops in an existing project, or to yield drum loops from short rhythmic 
passages. Otherwise, the BPM Finder helps in this regard. 

More information under “Effects” menu. 
 

Harmony Agent 

 

The Harmony Agent is designed to analyze harmonies. 

The music track is analyzed first when you open the Harmony Agent. The Harmony 
Agent tries to automatically identify the harmonies for each beat of the music. Thus 
the right beat information is an important prerequisite for a properly-functioning 
Harmony Agent. 

During subsequent playback, the detected harmony is played by an internal generator 
for verification purposes. You can adjust the volume with "Volume Generator". 
"Mute" deactivates the generator. 
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The transport control controls playback of the music track. The position slider below 
lets you quickly move to a certain passage. 
 

Check and correct the automatic harmony recognition 
After the analysis, you can manually correct harmonies which were not correctly 
identified. Note that major chords are written with capital letters and minor chords 
with lower-case letters. To select a chord left click on the respective harmony symbol 
in the waveform display. Hold the key if you want to mark several subsequent 
harmonies. 

Recommended alternatives to the recognized chords are displayed in the section 
"Correction" under the menu Suggestions. The initially recognized harmony is 
marked with an *. If none of the alternatives apply, you can select the correct "Root" 
or "Chord" from the menu. Use the option "Replace marked harmony in the entire 
song" if you are sure that the incorrectly recognized harmony is not included in the 
entire song. Usually, major and minor keys have been mixed up. 

Once you are sure that all harmonies are set correctly, click "Continue". 
 

Use harmony recognition 
You can apply the information from the Harmony Agent here. There are different 
ways to output harmonies: 

Generate chords in arrangement: In the project two tracks are created, one that 
contains the chords symbolized as guitar chords, the other contains other title objects 
with the respective chord symbols. You can graphically display harmonies in the video 
monitor in sync to the music. 

Save information about harmonies from the audio file: This also ensures that the 
harmonies are available later. For instance, to display the harmony information in the 
timeline (Edit -> Show object marker -> Harmony marker). 

Display: You can choose between different displays of the harmony symbols. You can 
choose between German, English or Roman symbols to "name" the tones. 
Furthermore, you can set "Predraw" to force single harmony interpretation. "#" 
shows all notes as "sharps" (C#, D#, F#,...), and "b" displays them as flats. 
 

Song Maker 
With the help of the Song Maker, you can automatically arrange multiple audio 
objects (loops) using included samples for songs or song parts without having to drag 
them individually from the Media Pool into the corresponding tracks. Considering the 
relatively random selection of loops that are combined you shouldn't expect the Song 
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Maker to produce a chart-topping hit, but it can be very helpful as a basis for making 
your own adjustments and additions to create a cool project. 

Activate the Song Maker by pressing the “Song Maker” button or from the Effects 
menu. 

 

 Select a music style. 

 Select the instruments that you want to use. If, for example, you only want a 
rhythm section with drums and bass, deactivate the other instruments with a 
mouse-click. 

 Select the song part or parts that you want to create. The parts differ in their 
harmonic structure and instrument density, for example verses have fewer 
instruments than refrains, while there are accompaniment variations between 
the 1st and 2nd verses as well as in the refrains. The pitch sequence from verse 
to verse remains the same. If you activate all parts, Song Maker creates a 
complete song in the typical structure of a classic pop song, i.e. intro-verse-
chorus-verse-chorus-bridge-(transition or solo)-chorus-outro. 

 Use the sliders to the right to set the speed and the length of your song.  

 "Chaos" draws a different loop of the corresponding instrument for each new 
object. Normally, the same loop is continuously used in various pitches for each 
element of the song such as verse, chorus etc. If you use "Automatic", a new 
song in a randomly generated style will be created automatically, as soon as a 
song has been played. 

 Now click on "Create Song". Song Maker automatically compiles a project. The 
following is only a suggestion. 

 Use the play button to preview the song maker's suggestion. If you don't like the 
results, you can repeat the process. Before you do this, right-click on the 
instruments you want to keep in the project to prevent them from being 
overwritten. You can return to a previous status anytime by clicking on "Undo" 
or "Redo". 
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 Once you're happy with Song Maker's suggestion, click on "Apply". The building 
blocks are only now added to the arranger. A click on “Cancel” closes Song 
Maker and returns to the original project status. 

Tip: If you start the Song Maker for a project that already has audio material in it, 
this material will not be affected. This means you can apply the Song Maker 
repeatedly saving only the parts you like until you have a final project. You can also 
create song parts one after the other. The results from the Song Maker are always 
added at the start marker position. If you decide you want to replace the chorus you 
can simply set the start marker (view page 36) at that position. 

Keyboard shortcut:  W 
 

Text to speech 
In this dialog under the "Effects" menu > "Audio", you can make the computer "talk" 
by typing in text. You can choose from a range of different types of voices. You can 
change the speed and volume of the spoken passages. Once you've settled on a 
suitable voice, a WAV file will be created. This can of course be used in the arranger 
like any other audio object. 

Load text: Here you can load a text file in the formats: *.txt or *.rtf.  

Save text: Your entered text can be saved. 

Test: After entering your text, you can preview the result.  

Voice: If additional voice packages (TTS engines) have been installed, you can select 
a different voice here.  

Speed: Playback speed can be regulated with this controller. 

Volume: Output volume is regulated with this control. 

Format: Here you can determine the quality of the created wave file (.wav).  

File: Path selection for the wave file to be created. 
 

MAGIX Music Editor 
During installation of MAGIX Music Maker Premium Steam Edition Producer Edition, 
the audio recording and audio editing program "MAGIX Music Editor" will also be 
installed.  

MAGIX Music Editor offers a recording function, many additional effects, various 
ways to eliminate noise and professional editing options for audio material of any 
type. 
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To edit an audio object in MAGIX Music Editor, right-click on the object and select 
the option "Additional options > Edit externally" in the context menu (or you can 
select the object with a left mouse click and select the same option in the "Effects" 
menu > Audio"). 

See the "Help" file for more details concerning MAGIX Music Editor! 
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MIDI objects 
MIDI objects do not contain audio material. They are used to control synthesizers that 
then create corresponding sounds. They are comparable to notes that still have to be 
brought to life by a musician.  

MIDI is a standardized command language that helps control synthesizers. In addition 
to the command to play a note (Note On, Note Off), there are control commands 
(Ctrl Ch) for internal parameters of the synthesizer (volume, panorama, the pedal for 
piano, filter settings and others), program change commands (Prg Ch) to activate 
saved sound programs, and others. These commands are called MIDI events. A MIDI 
object contains a series of events and the times at which they occur. 

You can create MIDI objects by loading MIDI files, playing and recording with an 
external MIDI keyboard, or by drawing notes in an empty MIDI object with the MIDI 
editor. 
 

Arrange MIDI objects 
MIDI objects can be arranged, the volume may be modified (middle handle), or fades 
(in or out) may be added (top right and left handles) in the same way as audio, video, 
or synthesizer objects. Use the lower handles to "stretch out" individual MIDI loops so 
that they easily fit onto a whole track. 

Pay attention to the following: 

• Volume changes in MIDI objects (mid handles or fades in/out) are controlled by 
adjusting the velocity (MIDI Note On velocity). Many synthesizers do not 
change the volume, but rather the sound in relation to the velocity level. If you 
do not want that, adjust the volume in the mixer instead or by using a controller 
curve (view page 103) (usually controller 7).  

• MIDI objects always control a single synthesizer per track. If you move a MIDI 
object onto another track, then a different synthesizer will be controlled and the 
sound of the project changes accordingly. 

• Self-recorded MIDI objects are not available as a loop. 
 

Transpose MIDI 
Using this function from the "Effects" menu, the pitch of MIDI objects can be altered. 
You can find this function in the "Effects" menu > "Audio > Pitch & Tempo > MIDI 
transposition..." Just enter the number of half steps to transpose all the notes in the 
MIDI object up or down! 
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Note: For drums each note corresponds to a different percussion instrument (kick 
drum, snare, toms, etc.). Transposition of a drum track is therefore not 
recommended. Instead, directly adjust the pitch of the respective synthesizer.   

 

Load and save MIDI files 
The file format with file extension *.mid is used to save and load MIDI data. Many pop 
hits are online free to download as MIDI edits. They may serve as a good springboard 
for your first musical experiments or cover versions. 

You can save the content of a MIDI object as a file in the MIDI editor. In the "File" 
menu of the MIDI editor (view page 94) use the command "Export MIDI". 
 

Preview of MIDI files 
Like audio files, MIDI files are loaded by using the Media Pool. A simple click will start 
the preview.  

Since the number of possible sounds is virtually unlimited and because such files 
should be universally applicable, they are usually arranged so that they require certain 
standard sounds. This number of standard sounds is called General MIDI (GM) or in 
an expanded form General Standard (abbreviated GS). To preview a MIDI file in the 
Media Pool MAGIX Music Maker Premium Steam Edition uses "Microsoft GS 
Wavetable SW Synth", this is a software synthesizer that is part of the Windows 
operating system and contains these sound programs.  

Its sound quality is rather modest compared to "proper" software synthesizers. For 
further work with imported MIDI data, we recommend using the software synthesizer 
supplied. And due to another reason: "Microsoft GS Wavetable SW Synth" is not part 
of MAGIX Music Maker Premium Steam Edition and the sounds it produces are 
therefore not included in a finished song that has been exported. 

Note: MIDI data that contain a complete arrangement should be copied onto 
multiple tracks and filtered by MIDI channels with help from the MIDI channel filter 
(view page 99). 

 

Problem solving preview in Media Pool 
If the preview in the Media Pool does not work: 

• Check the output device for MIDI in the "Program settings" window in the 
"Audio/MIDI" tab (P key or via "File" menu > Settings > Program settings"). 
"Microsoft GS Wavetable SW Synth” should be selected here! 
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• The sound card synthesizer's volume is set via the the sound card mixer. Double 
click the small loudspeaker icon in the notification area and find the controller 
for the SW synthesizer. 

• Several sound cards cannot use the SW synth simultaneously with ASIO drivers. 
 

Connect MIDI Keyboards 
You can use MAGIX Music Maker Premium Steam Edition in conjunction with a MIDI 
keyboard to play and record the included synthesizer plug-ins or VST plug-ins. You 
can also control sound generation from external devices using MIDI objects in the 
project of Music Maker. 
 

Basics of MIDI interfaces and cabling 
MIDI interfaces are system devices that enable communication between the 
computer and an external MIDI device. They provide music programs one or more so-
called MIDI ports. The music software (in our case MAGIX Music Maker Premium 
Steam Edition) sends and receives MIDI data via this port, everything else is handled 
by the drivers and operating system. You can set the ports for MIDI input and output 
in Music Maker in the Program settings (view page 247) (key P, tab "Audio"). 

MIDI interfaces can be integrated into the computer system in different ways. It can 
be part of the sound card built into the computer or externally connected via USB or 
Firewire. 

 

MIDI connectors  

In this case, two MIDI jacks MIDI IN and MIDI OUT are 
located on the sound card. With older sound cards an 
additional adapter cable must be connected, which 
provides the typical 5-pin DIN jacks. 
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MIDI connection cable 

Connect your MIDI keyboard to the MIDI In (MIDI input) via its MIDI Out jack using 
a MIDI cable on your MIDI interface on your computer. If your MIDI keyboard can 
generate its own sounds and you would like to use this, connect also the computer's 
MIDI Out jack to the keyboard's MIDI In jack.  

With USB MIDI keyboards the MIDI interface is part of the external hardware. USB 
MIDI keyboards are a separate class of devices designed to control software 
synthesizers. They usually no longer produce any of their own sound, but only consist 
of a keyboard, various controllers and a USB MIDI interface. They are connected via 
USB to the computer, in this case, no MIDI connection cables are required.  

Note: Even on "proper" keyboards and other synthesizers you can now find a USB 
MIDI interface alongside traditional MIDI connectors. 

Normally for these keyboards no special drivers are needed. All you have to do is 
connect them. Make sure that the device is switched on and is able to be detected 
prior to starting MAGIX Music Maker Premium Steam Edition, since the available 
MIDI ports are only able to be discovered during program launch! 

Under some circumstances, you may have to select the port for the device as the 
MIDI input device via the Program settings ("Audio" tab) (view page 247). This is 
usually called "USB audio device" 

Note: Some older devices do not function in some cases in Windows XP. Even 
though the device has been detected, the corresponding MIDI drivers do not appear 
in the list. In this case, please contact MAGIX customer support! 

In the event that your external device does not have a USB port and the sound card 
does not have MIDI connectors, you will need to purchase an additional USB to MIDI 
interface. 

MIDI Local Off: If the MIDI keyboard has an internal sound source, it must be shut off 
when you use its keyboard for recording. This enables you to play the software 
instruments without hearing the sound of your keyboard at the same time. This 
function is referred to as "Local OFF" and can be directly set on your keyboard. If 
necessary, refer to the user manual for your keyboard to find out exactly how to do 
this. 
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External synthesizers 
MIDI objects can also be played back over a MIDI interface onto external 
synthesizers, sound modules, etc. Set as default, the "pure" MIDI output (i.e. without 
using software synthesizer plug-ins) is sent to the system software synthesizers 
(Microsoft GS Wavetable SW Synth). This is required to preview (view page 90) 
MIDI files. 

If you set the MIDI port of an external synthesizer as the MIDI output device (see 
previous section), the content of each MIDI object will be output in this manner. 

Note: If the MIDI object is in a track containing a software synthesizer, the object 
will control this synthesizer. To output MIDI via an external sound synthesizer, 
select "no VSTi" from the list of software synthesizers. 

 

Convert MIDI objects into audio files 
By using VST instruments, you do not need to convert these MIDI objects into audio 
files before exporting your entire arrangement as they create sound and are 
processed by your computer. All MIDI objects that control external synthesizers via a 
MIDI interface (view page 93) will have to be converted into audio objects if you want 
them to be exported as well. They only contain control information for sound 
reproduction. 

The output of the MIDI sound generator (e.g. the synthesizer) must be connected to 
the input of the sound card. The MIDI data can now be played and recorded 
simultaneously via the record function. The result is an audio file that can be edited 
and exported together with the multimedia files. 
 

Playing and recording MIDI synthesizer 
MAGIX Music Maker Premium Steam Edition allows you to play and record software 
synthesizers or external MIDI devices from the arranger. The MIDI editor does not 
have to be open. 

Presuming that the MIDI input and output devices are set correctly (see above), you 
should be able to play software synthesizers with the MIDI keyboard. 

 MIDI recording mode must be activated in the corresponding track by 
clicking "Rec" twice in the track box. Now, all of the notes that you play 
via the keyboard will be played back through the synthesizer. 

If a software instrument is loaded via the track box or opened via the MIDI Editor, 
then MIDI recording mode is activated automatically. 
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Tip: You can also play a synthesizer live without an external MIDI keyboard. The 
Media Pool features an On-screen keyboard that may also be operated via the 
computer keyboard. 

 

In order to record a new MIDI object, simply click the red "Record" 
button in the transport bar 

 
 

MIDI editor 
The MIDI Editor makes it possible for you to edit MIDI objects. The MIDI Editor 
provides different sub-editors, views, areas, and aids to do this. Double clicking a 
MIDI object opens the MIDI Piano roll editor for advanced recording/editing of MIDI 
objects. 

Tip: The Media Pool features a smaller version of the MIDI Editor. Select the MIDI 
object you would like to edit and then click the Settings Object Inspector button. 
This MIDI Editor may be operated identically to the "larger" version that features its 
own window; however, the menu and various play and recording settings will not be 
available. 

 

In the center you'll find the Piano Roll Editor (view page 100), in which the notes are 
displayed as bars and from which they can be edited using the mouse. There are 
various buttons located just above the Piano Roll: 
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Clicking on this button opens the Event list (view page 105). In this list 
you can view all MIDI data of a MIDI object, including those that cannot 
be edited in the piano roll or controller editor. You can use the event list to 
remove unwanted switch program commands included with imported 
MIDI files. 

 
Use this button to switch to Drum Editor (view page 107) mode. 

 
You can use this to leave the Drum Editor and return to the Piano Roll 
section. 

 
Clicking on this button opens the Controller Editor (view page 103) in the 
bottom area. This allows you to edit features such as the note velocity, 
pitchwheel, and controller data.  

 
Deletes all MIDI data from the object. Now you can start from the 
beginning again. 

 
Of course, "Undo/Redo" is also available for all changes you make in the 
MIDI Editor. 

Along the top edge, you will also find buttons for selecting the editing tools (view 
page 100), for the Piano Roll, quantization (More information can be found in the 
section "Quantization settings" on page 112), for the output (view page 95) used by 
the MIDI object (MIDI out or VST instrument), and for step recording (view page 97). 

The MIDI editing window features its own menu (view page 115) with its own 
keyboard shortcuts (view page 117). 
 

Select sounds 
The sound of virtual instruments (VST plug-ins), is produced by the synthesizer chip 
of the sound card or by external MIDI synthesizers. Each MIDI object can produce as 
many sounds as the corresponding synthesizer offers. The sounds themselves can be 
specified in the instrument – regardless whether its a virtual VST Instrument or a 
hardware device.  

If there is no VST instrument loaded, the MIDI object uses the MIDI output for the 
external synthesizer or for the Microsoft™ Windows® supplied synthesizer. The MIDI 
output can be adjusted in the "Program settings" window in the "Audio/MIDI" tab (P 
key or via "File" menu > Settings > Program settings" 

 

Select the desired VST instrument from the menu. You can test the same MIDI object 
with various VST synthesizers. You can set the sound of VST instruments in the VST 
instrument editor (view page 122). You can open the instrument editor with a right-
click on the VSTi name or a left mouse click on the cogwheel symbol.  
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You can set up the MIDI output channel under MIDI channel. This is important for 
VST instruments which can receive MIDI notes on multiple channels and play several 
different sounds simultaneously (multi-timbral). 
 

Play/ PlaySolo 
Play solo only plays the MIDI object for which the MIDI editor is opened 
(corresponding with the filter settings of the options menu). 

Play all plays the entire project. 
 

Playing instruments with the keyboard 
Open the MIDI editor to be able to play software instruments directly via the 
computer keyboard. The assignment of the notes to the computer keyboard is 
displayed in the following graphic. 

 

"Page up" and "Page down" move the octave up or down. 
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MIDI Record options 
You may also begin MIDI recording directly in the MIDI Editor. To do so, simply click 
the red "REC" button. Compared to the simple "Record" featured directly in the 
"Arranger", this version features several additional options for you to select 

Overdub: Normally, existing notes are deleted with each new recording. "Overdub" 
simply adds new MIDI notes to the existing MIDI recording. "Overdub" allows you to 
create a completely new MIDI song step-by-step (or take-for-take). 

Cycle: This plays the MIDI object in a loop during recording. This enables you to let 
the object play through a few times before you get started recording your own 
melody. 

Metronome: In order to play back the proper tempo, you can activate the MIDI 
metronome to provide the beats. This is only for orientation while you play and is not 
recorded. 

 
Play project during recording: If this option is active, then the project will 
play during recording. 

 

Step Recording with a Keyboard or Controller Keyboard 
In the MIDI editor, you can also carry out so-called "Step recording" using the 
computer keyboard or MIDI keyboard. Step Recording means you can enter the notes 
with the computer keyboard or another keyboard but you do not have to enter them 
in realtime. You can allow for as much time as you like between notes.  

The notes are added with a predetermined length and after each entry the playback 
marker moves one step farther. Step length and note length can be specified by the 
grid and length quantization values. The note lengths cannot, however, exceed the 
step lengths. 

 
Activate Step Recording with this button. 

The play cursor shows the scope of the current octave in which the following entries 
take place. Now you can enter MIDI notes step-by-step. Push multiple keys 
simultaneously to enter chords. The most important keyboard shortcuts for entering 
MIDI notes using step recording: 

TAB One step forwards (set pause) 

Shift + Tab One step backwards 

Page up/Page down Enter octave upwards/downwards 

<YXCVBNM... (the precise keys 
depend on the type of keyboard 

Enter notes in current octave (see Playing 
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you have) instruments with the keyboard (view page 96) ) 
 

Edit MIDI events 
MIDI data can be edited in three main areas in the MIDI editor:  

• Piano Roll (view page 98)  
• Controller Editor (view page 103)  
• List Editor (view page 105)  

Here various tools are available, for example, pencil or eraser and editing functions, 
such as quantize or thin controller.  

With few exceptions, editing such as moving or deleting notes always apply to all 
selected MIDI events. Changes to the selection in a range always apply to every other 
range as well. You can, for example, select a group of notes in the Piano Roll and then 
change the velocity for this group of notes using the Controller Editor, modifying all 
selected notes simultaneously. 
 

Selecting MIDI events 
Selection of MIDI events is generally the same in all three editing areas (Piano Roll, 
Controller Editor, List Editor). The differences are visible in the table: 

Selection Mouse action 

Select event  Left-click on event 

Add/Remove event from selection Ctrl + left-click on event 

Select current event, deselect all 
other events 

Double-click on event 

Marquee selection Left-click on a free space and click and drag 
selection. (Selection tool in Piano Roll and 
Controller Editor) 

Clear selection Left-click on a free space (only in selection 
mode, not in the List Editor) 

Set or change current events within 
multiple selection. 

Left-click on selected event 

Selection of section of events  Left-click on first event, Shift + left-click on 
last event (only in list editor) 

Selection of all notes of a pitch Double-click on a free space with this pitch 
or press the appropriate key on the 
keyboard (only Piano Roll) 

Selection of all events Ctrl + A, depending on the editing section, 
includes the selection of notes (Piano Roll), 
Controller events (Controller Editor), or all 
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events (List Editor). 

Select next or preceding note Arrow left/right (only Piano Roll) 
 

Meaning of the colors in the Piano Roll and Controller Editor 
Notes which are not selected within the editor are displayed in blue. The intensity of 
the color represents the velocity: With increasing velocity the color will become 
darker/stronger. 

Selected notes: Multiple selected notes are displayed in yellow. Here too, a more 
intense color symbolizes increased velocity. 

Alternatively, the color in the Piano Roll can symbolize the MIDI channel of a note. 
Select in the "Options" menu "Use MIDI channel colors" 

Current event: Appears with an orange border. If an event is selected with the mouse, 
it turns into the current event. 

Filtered Events: Events filtered with the MIDI channel filter (view page 99) appear in 
gray. 

Muted Notes: For test purposes you can mute notes (Menu "MIDI Functions (view 
page 114)"), which then for selected and unselected events will be displayed with a 
fainted color. 

Events outside of the object borders: Events in front of or behind the beginning/end 
of the object – recognizable by the blue lines in the Editor – also appear fainter and 
have a white border. 
 

MIDI channel filter 
You can control multiple instruments with one MIDI output via the MIDI channels. A 
MIDI object can contain events in up to 16 channels.  

Events in one object from all channels or only from selected channels can be played 
back with the MIDI channel filter in the MIDI editor. To play back or edit events only 
from certain channels, select the appropriate channels in the "Options" menu > MIDI 
channel filter". Events in channels that are not selected will be filtered out. "Play back 
all" deactivates the channel filter. 

Events that have been filtered out appear in gray and can be edited using the selection 
tool. They can be hidden with the command "Hide filtered MIDI data" in the "Options" 
menu. 

Note: The list editor (view page 105) provides additional filters (such as filter by 
event type, controller number, Note Off events) that only function within the list. 
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Using the MIDI channel filter 
Completed songs in MIDI files as you would find them on the Internet usually contain 
a complete arrangement in which various instruments are played on different 
channels simultaneously. The standard software synthesizer for Windows that is used 
to preview MIDI files (view page 90) can receive MIDI on multiple channels and play 
several different sounds at the same time. This is called a multi-timbral synthesizer. 

If you load a MIDI file, it will load as a MIDI object on a single track. However, MAGIX 
Music Maker Premium Steam Edition can only control one software synthesizer per 
track, and most software synthesizers, also those available in MAGIX Music Maker 
Premium Steam Edition, can only play back one instrument at the same time and are 
thus not multitimbral. 

For this reason, duplicate your MIDI one beneath the other as often as there are 
different instruments involved and set the corresponding Channel filters (view page 
99) in the MIDI objects ("Options" menu in the MIDI Editor) so that each object only 
plays the notes for a single channel. Next, assign software instruments for the 
individual channels via the Track (view page 33) menu. 
 

Piano Roll 
For notes inside the Piano Roll, various editing tools, so-called mouse modes, are 
available. 

When clicking existing notes all tools generally act in the same manner: You can 
select notes simply by clicking on them (see Selecting MIDI events (view page 98)) 
and by clicking and dragging notes, whose start time, pitch or note length you are 
editing (see Editing notes (view page 102)). There are two exceptions: The eraser tool 
deletes notes by clicking on them and with the velocity tool, notes are not moved but 
rather their velocity is adjusted (see below). 

The mouse modes display their special functions by clicking or clicking and dragging 
into empty sections of the Piano Roll: 

 
Selection 
(Ctrl + 1) 

Simple click: Clear existing selection. Click + Drag: Draw 
out a rectangular selection frame. For additional selection 
options see Selecting MIDI events (view page 98). 

 
Draw 
(Ctrl + 2) 

Draw note. The start position and the length snap 
respectively to the current quantization settings. Draw 
mode can be activated in all modes by pressing the Shift 
key .  

 
Draw Pencil  
(Ctrl + 3) 

Draw sequence of notes. The lengths and distances of the 
notes are set according to the current quantize settings.  
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If H is pressed while drawing, the pitch of the first note 
will be applied to all subsequently drawn notes. Moving 
backwards with the mouse when drawing removes notes 
already drawn. 

Pattern Pencil  
(Ctrl + 4) 

Draw note pattern. A selection of existing notes can be 
saved as a pattern (phrase) and then drawn in different 
pitches. 

To create a new pattern select the respective notes and 
press Ctrl + W or select in the "Edit" menu > MIDI/Drum 
Editor > "Create pattern from selection".  

Draw the pattern at the position of the deepest note of 
the pattern. This makes an original pitch sound. You can, 
of course, draw in different pitches. If H is pressed when 
drawing, the basic tone pitch from the beginning will be 
retained. 

Moving the mouse back (to the left) while holding down 
the mouse button removes the notes which were just 
drawn. 

 
Velocity mode (Ctrl 
+ 5) 

Click an empty section like in selection mode. 
Left-clicking on notes and dragging them vertically alters 
the velocity of the notes. The velocity of notes can be 
edited directly in the Piano Roll and the Controller Editor 
remains free for other outputs. 

 
Delete 
(Ctrl + 6) 

Left-click: Delete note. Clicking one selected note deletes 
all selected notes when multiple notes are selected. Click 
and drag: Delete all notes that come into contact with the 
eraser. 

The Delete mode can be activated anytime by clicking 
with the right mouse button. You can add new notes with 
the Drawing pencil by using a left-click and remove 
existing notes with a right-click, without having to change 
the tool. 

 
Magnifying Glass 
(Ctrl + 7) 

Left mouse button: Zoom in 

Right mouse button: Zoom out 

Left mouse button + drag: Zooms in on the range. 
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Edit notes with the mouse 
Edit existing notes by clicking and dragging. Depending on where you click on the 
note bars several options are available, which are visible by different mouse pointers. 

 Change note start time: Grab note bar at the beginning, note end 
remains the same 

 Change note length: Grab note bar at end 

 + Shift Set fixed note length for multi-selection: Hold Shift key and drag current 
reference note longer/shorter. This sets all selected notes to the same 
length. 

 + Ctrl Scale note length for multi-selection: Hold Ctrl key and drag current 
reference note longer. All notes will be lengthened by the same factor. 

 Move note freely, pitch and start time change 

  If Alt is also pressed in Move mode, the note will only be moved 
horizontally, retaining the pitch. 

 If Shift is pressed while in Freehand Draw mode, only the pitch can be 
changed, the position will remain the same. 

/  If the setting "Ranges for limited movement" is activated in the "Options" 
menu, clicking and dragging the first half of the note results in a change 
to the position, while clicking the end half changes the pitch.  

Pressing the Alt key  while moving the mouse temporarily deactivates the 
quantization grid. 
 

Moving and zooming 
The vertical and horizontal view or zoom are adjusted with the Scroll bars just like in 
the project window. 

Mouse wheel:   Scroll horizontally 

Alt + mouse wheel: Scroll vertically 

Shift + mouse wheel:  Zoom vertically 

Ctrl + mouse wheel:  Zoom horizontally 
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Controller Editor 
The Controller Editor is a graphic editor that allows you to edit the velocity of notes in 
the Piano Roll and Controller events. A Continuous Controller abbreviated as CC or 
simply referred to as the Controller allows you to transfer control values such as for 
filter, volume and panorama position. 

Tip: All control elements for MAGIX Vita Solo Instruments and MAGIX Vita can be 
controlled via the MIDI controller (view page 128).  

 
The Controller Editor is preset as hidden. Unhide it by clicking the button 
below the Piano Roll or with the key shortcut "Alt + V". 

The velocity values of note events are displayed as colored bars in the Controller 
Editor, whereby darker and higher bars symbolize larger values. The bars are located 
directly below the respective notes. 

The values of other controllers are shown as bars. The width of the bar extends to the 
next event. Because the controllers typically change in small time intervals more or 
less continuously - regardless of note events -, they appear as ascending or 
descending ramps. In this case, the height of the ramps and their color intensity also 
represent the last defined value of an event. Selected controller events also appear in 
yellow. 
 

Tools 

 

Controller Editor for editing the velocity of existing notes (left) or controller values (right) 

  Selection tool: Specifically select existing controller events or notes and 
adjust their values. 

  
Freehand drawing tool: Freely draw new controller values or a gradient. 

  
Draw line: Use the line function to quickly insert a straight controller 
gradient (ramp). 
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  Controller Selection. Select a controller to edit by clicking the menu. 
Controllers, whose data is already available for the MIDI object, are 
marked by an asterisk. 

 

 Velocity values are only available at time positions of the corresponding notes 
and in the case of multiple notes occuring simultaneously, several appear on top 
of each other (view page 105). Controllers are independent of the notes. 

Selection tool 

Select multiple controller bars by clicking and dragging a range in the Controller 
Editor; individual values can be selected by single-clicking within the bar. When 
selecting a velocity bar, the corresponding notes will also be selected.  

By clicking and dragging the upper edge of a velocity or controller bar, you can 
immediately change its value. For multiple selection, the following rules apply: Each 
controller is increased or decreased by the same absolute value. Holding Ctrl while 
dragging changes the values relative to each other. 

For example: Two controller values are selected; the first is 30 and the second 60. If 
you drag the end of the larger bar up by 30, then the values will change to 60 (30 + 
30) and 90 (60 + 30). If you increase the larger bar with relative values (by holding 
Ctrl) by 30, it will result in an increase of 50%. The smaller bar will also increase by 
50%, meaning a increase by 15 (50% of 30), resulting in a final value of 45. If you 
instead drag the smaller bar (+ Ctrl) and move it from 30 to 60, it will result in an 
increase of 100%. The larger bar will accordingly be increased to 120. In other 
words: The relation between the selected values will remain the same when they are 
relatively changed. 

If you hold Shift while changing the value of a multiple selection, all of the selected 
events will be set to the same new value. 

Drawing tool 

With the Freehand drawing tool (Mouse pointer: pencil) you can draw any number of 
controller curves. With the Line drawing tool (Mouse pointer: crosshairs) you can 
create a linear controller gradient (ramp). By dragging backwards, you can delete your 
curve during drawing. You can temporarily activate the Freehand drawing tool with 
the Selection tool by additionally pressing the Alt key before clicking. The Shift key 
temporarily activates the Line drawing mode when using the Selection tool as well as 
the Freehand drawing tool. 

Hint: If you edit velocity with the draw tools, no new notes are generated; only 
existing velocity values are modified. 
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Tips for editing velocity 
In polyphonic events, meaning when multiple notes are played simultaneously, the 
bars appear on top of each other, making it difficult to edit the end of a particular bar. 
To edit only notes of a certain pitch, e.g. all C1 notes in the Controller Editor, click on 
the respective key on the keyboard to the left of the Piano Roll. The key and the 
background of the selected pitch are highlighted. Now only the velocity values of 
notes of this pitch are displayed in the controller editor. 

This also works for several pitches. You can add additional notes with Ctrl + click or 
space between two notes with Shift + click on a second note. These are simply view 
options of the Velocity Editor. Multiple note selection is also possible using double-
click 

A further possibility is to selectively edit velocity bars located on top of each other, 
which is based on the fact that the bar of the currently selected note is 
selected/edited using the mouse. Therefore, first click on the note within the Piano 
Roll, or click on the bars located on top of each other and then select the required note 
using the cursor keys. Then change the controller value by dragging the highlighted 
(current) bar. 

Besides directly changing the velocity values of a selected note, you can change 
several velocity values at once by clicking in a free space and dragging the mouse 
over several velocity values while holding down the key. You can then also create 
sequences by moving the mouse in a curve. A previous (multi-)selection is ignored. 
For example, you can easily create a crescendo or decrescendo effect. 
 

Quantize controller events 
MIDI controller events can be quantized and thinned out; select the "MIDI functions" 
menu and the "Quantize/Thin out controller" command to do this. Quantization 
occurs according to the quantization settings (view page 112). 
 

List Editor 
In addition to note and controller events, which can be edited with the Piano Roll or 
Controller Editor, MIDI objects usually contain other types of events, e.g. program 
change commands (Prog Ch) to change the sounds in the software synthesizers. The 
MIDI editor has an integrated display of all events in list format. Here, you can edit 
MIDI data in detail. 

 
This List Editor is opened either with a click on this button or by using the 
shortcut "Alt+L". 
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The List Editor lists all MIDI events in 
tabular form. The time position in beat: 
quarter note: tick is at the very front. 
Ticks are the 192 subdivisions of a 
quarter note. After that is the event 
type, the MIDI channel, and depending 
on the event type one or two data fields. 

When the List Editor is opened and 
activated for editing it has a narrow red 
border. This makes it clear that certain 
functions, for example, select 
next/previous event (cursor keys) or 
the command "Select All" (Ctrl+A), 
only refer to the list. 

Mute Controller: MIDI controller commands can be filtered during playback.  

Show Note Off: Each note contains a "Note On" and a "Note Off" event, which are 
always selected and edited together, therefore, Note Off is preset as hidden. Use this 
check box to see Note Off events. 

Display filter: To edit specific events only, the List Editor provides a view filter for 
each column. These are small check boxes above the list editor columns.  

Select a representative event. This can be, for example, a note with a certain pitch. 
Then click on a display filter for a specific column to only display events of this type, 
here with the selected pitch. All other events will now be hidden.  

Display filters can be combined with one another. This way, you can, for example, 
when working with the "Select All" command (Ctrl+A), select and edit all control 
change events of type 10 (volume) on MIDI Channel 6. 

  

To add special events use the button below the 
List Editor. 

Select an event type in the list field on the left and click "Insert". The event will then be 
added with preset parameters, which can be adjusted in the List Editor. 
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Drum Editor 

 
Clicking this button switches the MIDI editor to Drum Editor mode. 

 

The same content of a MIDI object can be edited with the Drum editor like in the 
"normal" MIDI editor. The same tools are available. The "Piano Roll" here is specially 
adapted to edit drum sequences: 

• For each pitch there is a Drum editor track header instead of simple piano keys. 
Here, you can assign a name to each drum instrument or rather to each pitch, as 
well as set the output note and channel, grid and quantization settings, and 
velocity scaling in %. 

• Cell mode (view page 108) is used. The display width for each drum event in a 
cell can be individually set for each instrument as well as in the respective track 
header. 

• All individual settings for each note can be edited as a whole in a drum map. 

Important: When you switch from Drum Editor mode back to the normal Piano Roll, 
you will be asked if you wish to apply mapping (view page 109) or not. If you add 
mapping, all mapping settings will be applied to the MIDI object. For example: You 
changed the output value for an instrument with a pitch of 35 ("Bass drum 1" in GM 
Standard) to 36 ("Bass drum 2"). If mapping is applied, these notes will be replaced 
by corresponding "real" notes with a pitch of 36. 
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Cell mode 
"Cell" mode serves to improve the overview as it limits the display to only the most 
important information, note starting points, and velocity. 

Each time position of a bar is displayed as a row of cells in on/off states. The note 
length is not displayed, but rather a unified display width is used. This way, it all looks 
similar to the step sequencer of a drum computer (see Robota). 

The set quantization grid can be read from the width of cells. "Swing" and "Offset" 
settings of the quantization options are also made clearer thanks to cells of various 
widths and by repositioning. 

The height of cells displays the velocity of the note. When drawing new drum notes 
the velocity can be specified via the vertical drawing position within the cells. In 
connection with the "Drum draw" mode, increasingly loud drum rolls can be drawn in 
easily. 

By clicking on the upper edge of a cell and dragging it vertically with the mouse, the 
velocity can be adjusted directly without having to use the controller editor. In 
"Velocity" mouse mode ("Ctrl + 5") it's even easier; all you need to do is click 
anywhere on the cell. 
 

Drum Editor trackbox 
In the drum editor, each individual note has its own trackbox, and individual settings 
can be specified for each instrument. When zoomed out, each trackbox can be 
increased in size with a simple mouse click. 

 

S/M: Each individual instrument can be played solo (S) or muted (M). 

Note number: The output note from the instrument can be set here. This can be 
different to the note currently displayed in the MIDI object so that individual drum 
instruments can be substituted. To put the display of notes back into the usual order 
(deep notes at the bottom, highs at the top), click on "Map" at the top and use the 
"Sort drum map" command. 

Instrument name: Double clicking on this field lets you rename your drum instrument. 

 Quantization options/colors: Use this menu to assign any one of the eight 
different colors to the cells of a drum instrument. The dialog for the instrument's 
quantization options is also opened here. 
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The dialog is the same as for global quantization options (view page 112), but the 
settings only apply to the individual quantization options if an individual grid value is 
set for the note as well.  

K Output channel 

# Quantization grid, "Glo" refers to the global value (More information can be found 
in the section "Quantization settings" on page 112) 

L Note length, # corresponds to the grid value, "Glo" to the global value 

 Length of the notation, # corresponds to the grid value (i. e. the entire cell width), 
"Glo" refers to the global value of the note length 

V Velocity scaling: The velocity value of each note is multiplied by the value set here 
in %. 

Scaling is audible, but is not visualized further. The purpose of this setting is the 
customization of the volume ratio between the individual drum instruments. Software 
instruments usually provide their own mixers. 
 

Drum Maps 
Drum synthesizers usually respond to notes with different pitches and different 
sounds. You are then able to control an entire drum kit and an array of other 
percussion instruments via one MIDI channel. Assigning a MIDI note to a particular 
drum sound is called "mapping". A "General MIDI" map is used by default. 

It may be the case that your synthesizer (regardless if real or virtual) uses a different 
mapping setup. This means that when you play the drum event, the sound you wish 
to hear may not be heard (for example, instead of a bass drum, you get a high tom). In 
this case you must adjust the mapping. The settings for individual instruments can be 
specified in the track header (the number/note value next to the solo/mute buttons).   

For more extensive changes we recommend using the Drum Map Edito (see below). 
There you can save your Drum Map as a file. 

A project may contain various different Drum Maps. All Drum Maps saved in the 
project can be selected via the menu. If you require a Drum Map from a *.map file, 
you will have to load it into the Drum Map Editor first so that if can be shown in the 
menu. You can edit the individual Drum Maps in the Drum Map Editor. 

The Drum Map can be set in the Drum Editor by clicking on 
the list field above. 
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Drum Map Editor 
The drum map editor can be used to create and edit drum maps. 

The "Drum maps" list on the left-hand side displays all drum maps which are available 
to the project. The drum map GM General MIDI is always available to start off with. 

New: Creates a new, empty drum map. 

Copy: Creates a copy of the existing map. This way you can quickly create variations 
of a drum map with various note allocations which can then be toggled via the drum 
editor. 

Load/Save: Use this to save a drum map (*.map file). This way you can use a drum 
map you created for a synthesizer in other projects as well. All loaded maps will be 
displayed in the "Map" menu of the drum editor. 

Delete: Removes the selected drum map from the project. 

Use the name field to rename the selected drum map. The settings (mapping) of the 
individual notes for each drum map will be displayed below this in tabular format. 

Pitch: This is the incoming MIDI note. 

Instrument: Displays the name of the drum instrument, e.g. "Bassdrum 1". 

Grid: If desired, you can set up a grid for the starting point of the drum events. 

Length: In this field you can set the grid for the note length. 

Output note: This is the note value to which the drum instrument (the incoming MIDI 
note in the "Pitch" field) should be routed or mapped. 

Channel: You can set up an individual channel for each instrument here. 

Quantization options: This opens the dialog for the each instrument's quantization 
options (view page 112). 

Instrument, grid, length... apply to all: This applies the corresponding setting of the 
selected instrument to all other instruments. 
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Quantize 
Small irregularities during recorded playing can be smoothed with the quantization 
function. In contrast, mechanical sounding sequences can be made a little more 
groovy by applying the "Swing" function. 

  
Clicking on the Quantize button shifts all selected notes to a 
customizable quantization grid. All notes are quantized without 
previous selection. Right-clicking on the symbol opens the 
quantize settings (view page 112). 

 

 

 

1/4, 1/8, 1/16, and 1/32 notes and corresponding triplets can be 
selected as starting points (grid) and lengths.  

The Quantize button always performs standard quantization (the note's start point 
and length are preset). In the menu MIDI functions (view page 114) > Advanced 
quantization provides other quantization modes (e.g. length only or Soft Q). 

The quantization options enable the type and scope of the quantization to be set 
more precisely. 
 

Quantization Grid ("Snap") 

 
If snap is activated, the notes "snap" to the quantization values when they are 
created or edited. 

The snap positions are displayed within the Piano Roll as a matrix. A swing 
quantization is displayed by the different intervals of the vertical partitions in the 
Piano Roll. The grid can be hidden with the "Show Quantization Grid" command in the 
options menu (Ctrl + G).  

You can deactivate the snap function while creating or editing notes by holding down 
"Alt" as you draw them. 

Keyboard shortcut:  Ctrl + G 
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Quantization settings 
The quantization settings can be found in the menu "MIDI functions -> Extended 
quantization" in the MIDI editor. The dialog with the settings is not "modal", i. e. you 
can open it as required and test certain passages with different settings. 

 

The selected quantization settings may be visualized in the top of the dialog. The blue 
lines indicate the target positions for the quantized notes, i.e. the snap points. The 
gray area around this show the quantization window, i.e. the target positions that are 
affected by the quantization. 

Q-grid/length: The quantization grid and length at the target points within the bar on 
which the note start points or lengths move. (See above) 

Q threshold/Q window: With the parameters Q threshold/Q window you can restrict 
the quantization to certain notes in order to retain the genuineness of an MIDI 
recording. The parameter "Q threshold" can be used to exclude notes from 
quantization that are very close to the next snap point. Only notes that are far enough 
from the raster will be quantized. Conversely, by reducing the "Q Window" notes that 
deviate too much from the raster can be excluded from the quantization. It is 
therefore possible, for example, to quantize quarter and eighth notes and retain the 
sixteenth notes that lie between by reducing the appropriate window. 
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In summary this means: Events less than the "threshold”-distance or more than the 
"window"-distance from the grid point will not be quantized. The time range affected 
by the quantization is indicated in gray in the dialog graphic. 

Swing: Starts swinging, groovy playback (for example, triplet). Specifies the division 
for uneven grid points. 

• 50 ... “50-50” division: The odd eighths are exactly halfway between the even 
eighth notes (“even” playing method) 

• 67... triplet playing method, 3-2 division 

Offset: The value range in this parameter stretches from -100 to +100. By changing 
the offset values, you move the whole quantization grid. Negative values move the 
quantization to the left, i.e. forward in time; positive values move to the right, i.e. 
backward in time. The maximum of 100 corresponds with an offset distance of half 
the grid width. 

Presentation of blue grid points in the dialog as well as of the grid in the MIDI editor 
directly reflects changes to these values. 

Humanize: The "Humanize" parameter creates another variation option, i.e. notes are 
able to be assigned according to the randomization principle up to a specific interval 
to positions around the exact quantization value. The setting occurs in % of a 16th 
note. The specified value thus regulates the maximum possible spacing of the 
quantized notes at the exact quantization value. 

Soft Q: This value sets the strength or "Soft Q" value of the quantization. 

• “100” moves the event precisely to the quantize grid point  
• "50" shifts the event to the middle between the current position and the 

quantization grid point,  
• "0" means no movement, i.e. quantization off 

The command "Soft Q" considers the current level value in the quantization options. 
The simple quantization command always occurs at 100%. In this manner, you can 
always select between approximation (soft) and hard quantization without having to 
adjust the quantization options every time. 

Standard quantization settings: Select the quantization action from the list (see MIDI 
functions (view page 114)) to be performed by clicking the "Quantization" button. 

Reset quantization: All notes will be reset to their original positions. 

Standard settings: Restores the default values. 
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MIDI Functions 
The "MIDI functions" menu contains advanced quantization (More information can 
be found in the section "Quantization settings" on page 112) and editing functions for 
MIDI notes. The commands in the "MIDI functions" menu always affect the selected 
events. If nothing has been selected, the functions are applied to all events. 

Legato: If necessary, notes may be lengthened until the next note to be played in 
legato. 

Quantize notes (default):  A standard quantization will be used on all selected notes. 
If no notes are selected, all notes will be quantized. The standard action can be 
defined in the Quantization Settings Dialog (view page 112). "Quantize notes (start 
and length)" is set as default. This function can be accessed via the "Quantization" 
button in the MIDI editor. 

Advanced quantization 
This submenu contains additional quantization commands. 

• Start Q: Selected notes will be quantized corresponding to the set grid 
quantization value. Note lengths remain unaffected. 

• Start and length Q: Selected notes will be quantized corresponding to the set 
grid and length quantization values. Hard quantization always occurs at 100%.  

• Soft Q (Quantization approximation) : This command considers the current level 
value in the quantization options. The simple quantization command always 
occurs at 100%. In this manner, you can always select between approximation 
(soft) and hard quantization without having to adjust the quantization options 
every time. 

• Length Q: Selected notes will be quantized according to the set length 
quantization value. The start time remains unaffected. 

• Quantize notes to grid: The end of selected notes will be quantized according to 
the set grid quantization value. The start time remains unaffected, but the note 
lengths will change. 

• Undo quantization: Use this command to reverse all completed quantization 
steps. This works even after the project has been saved. 

• Quantization settings: Opens the dialog for the Quantization settings (view page 
112). 

Quantize controller events: Allows you to quantize controller events (view page 105) 
to reduce their number. 

Humanize:  Use the Humanize function to make quantized notes sound more 
"human" meaning less perfect. Notes will be moved to a random value. See 
Quantization settings (view page 112). 

Mute notes (Mute): Mutes and unmutes notes. 
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Remove overlaps (polyphonic): Notes are shortened so that there are no longer any 
overlaps. Chords (simultaneously played notes) are recognized and left uncorrected, 
i.e. chords are not split up. 

Remove overlaps (monophonic): Notes are shortened so that there no longer are any 
overlaps. Forces monophonic voice leading. 

Convert sustain pedal to note lengths: This function converts sustain pedal controller 
events (controller 64) into note lengths. All notes which were started after a "Pedal 
pressed" event (CC64 > 64) will be extended to the "Pedal released" event (CC64 < 
64), and the pedal events removed. 
 

Menu reference MIDI editor 
File 
• Import MIDI: Load a standard MIDI file (*.mid) to the MIDI object. See Load and 

save MIDI files (view page 90). 
• Export MIDI: Export the content of a MIDI object as a standard MIDI file (*.mid). 
• New (Delete all MIDI data): Deletes all MIDI data in the object 

Edit 
• Undo/Redo: The last editing function is undone or restored. 
• Copy/Cut/Paste: Depending on the editor area, the copy actions can be used for 

notes (Piano Roll), controller events (Controller Editor), or all events (List 
Editor). You can copy and paste within one MIDI object or between different 
ones. Events are inserted at the position of the playback marker. 

• Duplicating: If the grid is activated, the notes selected in the Piano Roll are 
copied and inserted from the next grid point following the selection. They are 
otherwise inserted immediately after the selection. 

• Select all: Select all events in the MIDI object. Depending on the editor area, the 
selection includes notes (Piano Roll), controller events (Controller Editor), or all 
events (List Editor). 

• Reverse selection: All non-selected MIDI events are selected and selected 
events will be deselected.  

• Create pattern from selection: Selected MIDI notes are saved as a pattern. The 
length of the pattern is quantized when the grid is active. Afterwards, the 
pattern can be drawn in the Piano Roll in Draw pattern mode (view page 100). 

• Delete selected MIDI data: Selected MIDI data are deleted. 
• Delete all MIDI data = File > New 
• MIDI recording: Same as the REC key and starts the MIDI recording (view page 

97). 

MIDI Functions 
see MIDI Functions (view page 114) 
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Options 
• Hide MIDI channel filter/filtered MIDI data (view page 99) 
• Use velocity colors/Use MIDI channel colors: Changes the colors of the MIDI 

notes from a graduated representation of the velocity values to different colors 
for each MIDI channel. 

• Scoll mode/Soft scroll mode: In Scroll mode (preset) the displayed section of 
the MIDI object follows the playback marker. In Soft scroll mode, this is done 
continuously, meaning the section moves behind a fixed playback marker. 

• Show event list/Show Matrix Editor (Piano Roll)/Drum 
Editor/Velocity/Controller Editor: Shows or hides the elements of the MIDI 
editor. (corresponds to the functions of the buttons above in the MIDI editor) 

• Step input (view page 97) 
• Play notes that have been clicked: Deactivates the playback of notes that have 

been clicked or the piano keys on the left 
• Zones with restricted movement for notes: If active, the notes react differently to 

the movements of the mouse, depending on where you click on the bar in the 
Piano Roll, see Edit notes with the mouse (view page 102). 

• Quantization grid active: Activates/deactivates the quantization grid (view page 
111). 

• Show quantization grid: Shows/hides the quantization grid. 
• Automatically quantize selection: If active, quantization takes place 

automatically after recording. 
• MIDI Panic (End all notes): In rare cases, after a Note On event the 

corresponding Note Off event may not be sent to the synthesizer and the notes 
"freeze". Use this command to send Note Off events to all channels in all 
pitches. 

Mouse Mode 
Mouse mode for editing events, see Piano Roll (view page 100). 
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MIDI Editor shortcuts 
Playback/Stop Space 

Stop at position '0' (Number block) 

Delete all selected events Ctrl + Del 

Delete selected MIDI notes Del 

Select all non display-filtered notes (piano roll) or 
events (list) 

Ctrl + A 

Mute notes Ctrl + M 

Create pattern from selection Ctrl+W 

MIDI recordings Ctrl+R 

Undo (Undo) Ctrl + Z 

Restore (Redo) Ctrl + Y 

Cut Ctrl+X 

Copy Ctrl+C 

Insert Ctrl+V 

duplicating Ctrl+D 

Imported standard MIDI file Ctrl+I  

Exported standard MIDI file Ctrl + E 

Fade in/Out Event Editor Ctrl+L 

Fade Velocity In/Out Ctrl + T 

Show Quantization grid Ctrl+K 
 

Mode selection Ctrl + 1 

Drawing mode Ctrl + 2 

Drum (Draw Mode) Ctrl + 3 

Pattern (Drawing) Mode Ctrl + 4 

Change velocity Ctrl + 5 

Delete Mode Ctrl + 6 

Zoom Tool Ctrl + 7 
 

Quantize Ctrl + Q 

Quantization options Alt + Q 
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Select previous Note/Event Up/Left arrow 

Select next Note/Event Tight/Down arrow 

Play selected notes Ctrl+N 

End all notes Ctrl+P 

Grid on/off Ctrl+G 

Auto-scrolling during playback Ctrl+F 

Vertical zoom in Ctrl + Up arrow 

Vertical zoom out Ctrl + Down arrow 

Horizontal zoom in Ctrl + Left arrow 

Horizontal zoom out Ctrl + Right arrow 

Horizontal scrolling Mouse wheel 

Vertical scrolling Shift + Mouse wheel 

Zooming Ctrl + Mouse wheel 
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Software Instruments 
MAGIX Music Maker Premium Steam Edition has many software synthesizers for 
creating your own sound material. 

Software Instruments are always loaded to one track and controlled by MIDI objects 
in the track. VST instruments cannot be freely moved between tracks like audio 
objects. Effects may be only applied at the track level. 

The software synthesizers included are based on VST plugin technology (VST 
instruments). A plugin is an independent software component that can be loaded in 
Music Maker. Various standards were developed for including plug-ins. The "VST" 
standard has become the most widely used. "VST" stands for "Virtual Studio 
Technology". This means you can add to the collection of instruments included in the 
program with additional instruments (andeffects (view page 135)) from third-party 
providers. 

The following instruments are included:  

• DN-e1 is a virtual analog synthesizer that is suitable as an all-round instrument 
for many styles and areas of use. 

• MAGIX Vita is a universal sample player that specializes in realistic playback of 
"real" instruments for which it uses sampling technology. It contains sound 
programs for various conventional instruments: guitar, bass, acoustic drums, 
piano, strings, horns 

• Revolta 2 (Live & Premium version only): another virtual analog synthesizer for 
advanced explorers in sound. 

• VITA Sample  The Vita Sampler is a simple sampler, which you can use to play 
sections of samples via MIDI, for example individual drum sounds from drum 
loops 

• Vita Solo Instruments: Individual instruments based on the same technology as 
Vita. The interface has been customized and expanded for each different 
instrument. The following Vita Solo Instruments are included in the different 
versions of Music Maker:  

Music Maker: Concert Grand, Pop Drums, Drum Engine,  

Music Maker Live: like Music Maker, but with additional Jazz Drums, Lead Synth 

Music Maker Premium: like Music Maker Live, but with additional Church Organ, 
Cinematic Soundscapes and Choir 
 

Using synthesizers 
In order to use a synthesizer, you first need to insert it into a project track. There are 
several ways to do this: 
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Load synthesizers from the Media Pool 
Software synthesizers can be loaded via the Media Pool. To do this open the 
Instruments tab in the Media Pool. 

 

You will see a list of all synthesizers found in the VST folder (More information can be 
found in the section "Folders" on page 250). The color and the symbol correspond to 
that of the Soundpool loop category. 

When the mouse is moved over a software synthesizer, a play button appears that 
allows you to play a sample of the synthesizer. The synthesizer can be loaded to the 
next available track by double clicking the instrument or just clicking the arrow button. 
The synthesizer interface also opens. 

You can add VST plugins to the list 
with "Add new instruments" in the 
settings menu under the gear icon. 
This opens a file selection dialog 
where you can specify a folder 
containing the VST plugins. 

 

 
The overview is quickly lost when a large 
number of plug-ins have been installed, so you 
can also use the full text search above. 
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In the settings menu under the gear icon you can specify whether you want 
the synths to appear alphabetically or according to category. 

 

Loading synthesizers via the track header 
Another way to load synthesizers is to use the synthesizer menu in the track header. 

At the start of an arranger track, the track header contains an empty field for the 
instrument icon. 

 

Left-clicking on this field opens a menu with the sounds from the included 
software synthesizer which can be loaded to the track. 

 

 

Tip: You can also access this menu via the MIDI editor (view page 94) and the 
keyboard (view page 48)! 

 

Removing synthesizers 
To remove a synthesizer, select the first entry in the right-hand column "No VSTi" in 
the instruments menu (accessible via the track header, MIDI editor or keyboard). 
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VST Plug-in Editor 
The VST Plug-in Editor can be opened by right-clicking on the instrument's name in 
the MIDI Editor, via the corresponding plug-in slot in the Mixer, or via the "VST 
Instruments Editor" entry in the instrument list. 

The Instrument Editor has two views, the so-called "GUI" of the plug-in (Graphical 
User Interface) and the parameter view. This is either automatically activated when 
the VST plug-in does not have its own GUI or can be used if the GUI of the plug-in is 
too unclear or takes up too much space on the screen. The parameter view displays 
the eight parameters of the plug-in as sliders. In the File menu you can change 
between these views (plug-in dialog/plug-in parameter). 

Load/save patch/bank: The instrument settings can be saved and loaded in the 
patch formats typical for VST plug-ins (*.fxp) and bank formats (*.fxb). 

Random parameters: This function can be an important source of inspiration. 
However, before using it please save the current preset you've just created as this 
feature does not ask before it is applied. 

Menu program: Here you can select the presets integrated into the plug-in or loaded 
via the File menu. 
 

Revolta 2 
Revolta 2 is a further development of Revolta. It is polyphonic and playable with up to 
12 tones, including an additional noise generator, a step sequencer, and an extra-
flexible modulations matrix. An effects section with 9 different effects and presets 
(created by a professional designer) make it a full-fledged synthesizer for all kinds of 
lead, sequence, and pad sounds. 

REVOLTA 2 has a whole array of presets. The sounds have been created by 
professional sound engineers and demonstrate the huge potential of this instrument 
from the word start. First off, however, we would like to encourage you to try out the 
various control functions and to experiment as much as you like. The sky's the limit to 
your creativity. 
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Revolta 2 interface 
Note: The following is only a short description of the Revolta 2 interface. 

 

 

For a comprehensive documentation of this complex synthesizer please click 
the help button on the Revolta 2 interface!   

The Revolta 2 interface can be displayed in two sizes. In "Rack" mode only the 
elements necessary for preset loading are visible: 

 

By clicking the edit button you can open the complete interface. 

 

1. Main parameter: Sets the volume, panorama position, pitch characteristics 
("Transpose"), and play modes ("Poly", "Mono", "Legato"). "Glide" regulates the 
portamento time. 

2. Oscillator section: Two oscillators are available with smoothly adjustable curve 
forms and a noise generator. Both oscillators can be tuned to each other and used to 
modulate frequencies. 

3. Amp: This is the volume envelope. Here you can influence the temporal 
progression of a track's volume. A(ttack) stands for the volume increase at the start, 
D(ecay) for the length of time the decrease in volume takes on a section set with 
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S(ustain) at the maximum volume. R(elease) is the length of time it takes for the 
sound to ring out. "Vel" specifies how much the envelope curve depends on the 
velocity. 

4. Filter: Here you can switch on different filters to influence the sound. "Filter type" 
selects a filter type. "Cut-off" regulates the filter frequency, "Resonance" controls the 
strength of the amplification of the filter frequency. VEL" indicates how much the 
velocity influences filter frequency, and "Key" changes the filter frequency depending 
on the note pitch ("Key tracking"). The filter envelope (ADSR slider) influences the 
filter frequency depending on the time. "Env mod" controls the strength of the filter 
envelope curve, and with "drive" the filter can be overmodulated. 

5. FX1/FX2: Here you can mix in 2 different effects out of a total of 9 available effects. 

6. LFO1/LFO2/Step sequencer: Two LFOS and the step sequencer can be used to 
modulate single parameters of Revolta 2. 

7. Options and modulations matrix: The two buttons open the Revolta options page 
for general and preset-specific settings and modulation matrix. In the modulation 
matrix modulation sources are connected with modulation targets. Simple 
modulations like the oscillator (the pitch will be modulated via an LFO) can be set 
quicker directly on the interface. Much more complex modulations are possible in the 
matrix because the matrix offers more modulation sources (e.g. MIDI controller, 
oscillators) and the modulation source can influence more targets.   

8. Value display: The value display shows the exact value of the parameter which was 
just modified. In addition, you can find out the load of the twelve voices. 

9. Preset section: Here you can select Revolta presets. Every sound can be listened to, 
and an A-B comparison between two sounds is also possible (for example, an edited 
and an unedited sound). 
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MAGIX Vita 
MAGIX Vita Synthesizer specializes on realistic playback of "real" instruments for 
which it uses sampling technology. This means that short samples of real instruments 
in different pitches, playing techniques and volumes are used, combined, and played 
again at the correct pitch. 
 

The Vita interface 

 

1. Layer selection/Peak meter: The Vita sounds, also known as layers, can be selected 
here using the arrows. Right-clicking on the display opens the layer menu. 

2. Main parameter: Here the volume, panorama position, pitch characteristics 
("transpose") and the fundamental frequency ("master tune") can be set. 
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3. AMP: This is the volume envelope. With this you can control the timing of a 
sound's volume. A(ttack) stands for the volume increase at the start, D(ecay) for the 
length of time the decrease in volume takes on a section set with S(ustain) at the 
maximum volume. R(elease) is the length of time it takes for the sound to fade out. 

 

4. FILTER: Here you can switch on a filter which influences the sound. With FILTER 
TYPE you can select the kind of filter you want to use. Cutoff controls the filter 
frequency and "Resonance" controls the strength of the emphasized filter frequency. 
"Velocity" indicates how much the velocity influences the filter frequency, using 
"Gain" you can balance the volume. The filter envelope (ADSR slider) influences the 
filter frequency depending on the time. 

5. DELAY: Here you can switch on an echo effect. "Time" controls the delay time and 
"Level" controls the strength of the echo sound. 

6. REVERB: Here you can switch on a reverb effect. "Time" controls the delay time 
and "Level" controls the strength of the echo sound. 

7. TUBE DISTORTION: This is a tube distortion effect like those found in guitar 
amplifiers. This is normally used for electric guitars but you can also get creative and 
use it for other things. "Drive" controls the strength of the distortion. "High-cut" and 
"Low-cut" filter out the high and low frequencies. 

8. VALUE DISPLAY: This always displays the exact values of the parameter that was 
just adjusted. 

9. DYNAMIC RANGE: Usually the relationship between the created volume and the 
MIDI velocity is proportional. You can compensate for the fact that some MIDI 
keyboards need to be pressed forcefully to produce loud sounds (or conversely 
produce loud sounds with a soft touch) using the "MIDI Input Curve". Using 
"Dynamic and "Dynamic curve" you can manipulate the dynamics of a sound, i.e. the 
relationship between the loudest and quietest sounds. 

10. Voices: Here you can control the number of voices played simultaneously. If notes 
are no longer played, as is the case in some fast passages, you can increase the 
number of voices at the expense of performance. 
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11. Keyboard: Here you can preview the Vita sounds. This only works during playback 
or recording. 12. lets you hide the keyboard. 
 

Additional Vita Solo Instruments 
MAGIX Music Maker Premium Steam Edition includes some more synthesizers that 
are based on the Vita Sampler engine. The Vita Solo Instruments are contained in a 
sample player with customized interfaces for each of the instruments. 

The basic controls are identical for all synthesizers.  

 

One click on the arrow symbol opens a fold-out menu where you can determine the 
general sound of the instrument. If "ECO" appears in the description, this refers to 
especially performance-improving settings which may not sound so "smooth". In 
addition, you can also save your settings and add them to a favorites list for later use.  

 

You can control the overall loudness of the instrument.  

 

You can turn the instrument keyboard on or off with this controller.  

Because these samplers are enhanced for each instrument by tuned effects, the rest 
of controls function analogously to the already familiar synthesizers such as Vita. If 
you would like to know which result certain effects have, you will find explanations in 
the Essential FX (view page 163), Vintage Effects (view page 178), Reverb and 
Distorsion & Filter chapters. 
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Articulation 
Some Vita Solo Instruments have a special feature: In a bass octave (on the keyboard 
(C0-H0), there are special notes, which let you control the playing style 
(articulation). An alternative sample set is loaded, which lets the bass sound even 
more realistic using various playing styles such as note bending and flageolet. 

Articulation is switched on and continues until normal articulation is switched on 
again through the corresponding note (C0).   

   

On the keyboard at the bottom of the synthesizer interface are the buttons to switch 
articulation, displayed in different colors. In the MIDI Editor appearing above, you can 
watch a practical application of articulation. The notes on 1:4 and 4:1 will be played 
back with varying articulation. Before the next "right" note, normal articulation will be 
switched on again through C0. 
 

Automation of Vita and Vita Solo instruments 
In MAGIX Music Maker Premium Steam Edition it is possible to automate Vita Solo 
instruments. This allows you to change a specific value during playback using an 
automation curve automatically. Below we describe how to work using an automation 
curve.  

1. Right-click on an effect knob. This opens a context menu where you can select a 
MIDI controller number for the automation using "midi ctrl #". A few standard 
controller settings are preset, e.g. 7 for volume, 10 for panorama, 91 for reverb.  
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2. Open the MIDI Editor (Y key) and switch into the "Velocity/Controller Editor". 

 

3. At the bottom right you can now select the pre-selected controller number in the 
MIDI controller selection field.  

 

4. You can now draw the desired automation curve. 

Additional information can be found in the Controller Editor - Select and edit events 
(view page 103). 
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Tip: If you are using an external controller, you can also use it to control and 
automate values. To do so, select "Learn MIDI" in the Vita Solo Instruments context 
menu. Also read the Using external equipment (view page 91) chapter. 

 

DN-e1 
The DN-e1 is a virtual analog synthesizer that is suitable for all conceivable styles and 
application areas. It works in a subtractive way, i. e. first a basic sound is selected that 
is then filtered with the aid of a filter curve. 

The DN-e1 is played with a MIDI keyboard or with the aid of MIDI objects. You can 
use the keyboard in the program to set the sounds. 

 

Sound selection 
Select the sounds and sound configurations at the top. 

Bank: Here you can switch between three banks with various complete 
configurations. 

Category: Here you can select a sound category. 

Rndm (Random): Here you can activate a random selection of the parameter settings 
in order to experiment with the sound. 
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Patches/Name: Here you can select a sound that will then be modulated. 

Output 
The end of the signal chain is edited in this area. 

Volume: Sets the total volume. 

Voices: Controls the number of voices generated (polyphony). 

Glide: Controls the glide function. You can access sliding pitch transitions between 
the individual notes. 

Unisono: Switches to monophonic, but generates a number of slightly varied voices 
for "thickening” the sound. 

Filter en. 
In this area the filter curve used to filter the output sound is modulated. 

Attack: Sets the time duration that the filter curve requires in order to reach its 
maximum. 

Decay: Sets the time duration that the filter curve requires in order to go from its 
maximum to the sustain level. 

Sustain: Here you can set the degree of filtering that should take place after the decay 
phase. This filtering remains the same until the key on the keyboard is released; in 
contrast to the other three parameters, it does not also control a time duration, but a 
specific level. 

Release: Sets the time duration which the filter curve requires in order to go from the 
sustain level to the zero point after the key is released. 

Reverb 
An additional reverb effect can be set here. 

Type: Sets the sound coloration of the reverb effect. 

Pre Del: Sets the time that passes between the direct signal and the arrival of the 
early reflections. The reverberation time comes only after this time span. 

Damp: The corner frequency at which a damping of the highs should be implemented 
for each delay is defined here. This is useful, for  example, for making the delays 
reverberate more naturally or for creating special effects (reggae/dub-style effects). 
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Decay: Sets the complete reverb time. 

Low Cut: Sets the filter frequency of a high-pass filter. All signal components below 
this frequency will be filtered out. 

Amount: Here you can set the mixing ratio between the effect and the pure sound, i.e. 
the original sound without any effect applied. 

Delay 
An additional echo effect can be set here. 

Type: Different types of echo can be selected here: normal echo, ping-pong echo 
(where the sound swings through the stereo panorama) and various other forms. 

Color: Sets the sound coloration of the echo. 

Feedback: Sets the number of echo repeats. 

L Rate: Sets the time duration for individual echoes for the left channel. 

R Rate: Sets the time duration for individual echoes for the right channel. 

Amount: Sets the mixing ratio between the effect and the pure sound, that is to say, 
the original sound without any effect applied. 
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Vita Sampler 
The Vita Sampler is a simple sampler, which you can use to play sections of samples 
via MIDI, for example individual drum sounds from drum loops. This function as a so-
called "beat slicer", which means that it automatically finds the individual elements in 
samples (e.g. kick drum in a drum loop), which in turn are available as destinations for 
eight drum pads. 

 

 Wave form: Your own samples in the file formats .wav. .aiff, .ogg, and .mp3 may 
be loaded into the Vita Sampler via drag & drop simply by dragging them there. In 
this case, the sample segments ("slices") are detected automatically and marked 
in the sample. 

 Assigned slice: Of all the detected slices, 8 are selected randomly, assigned to the 
drum pads, and specified as random playback modes (5,6). 

 .Drum pads: Slices may be played using the mouse with the drum pads and via 
MIDI with the white buttons starting at C3 (MIDI note number 60, 62, 64, etc.) 
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 Selected slice: Slices may be selected for advanced listening by clicking them. The 
associated drum pad is also displayed at the same time. 

To change the slice assignment for this drum pad, drag the colored frame around 
another wave form slice. 

To change the size of the assigned slice, drag the edges of the frame using the 
round handles. The edges will snap onto the specified slice borders. Pressing the 
ALT key shuts off the snapping grid. This enables imprecise positions in the slice 
detection to be corrected. 

Note: Slices may not be assigned to multiple drum pads, which is why 
sometimes, the selection cannot be dragged as desired.  

 

 Clicking the symbol 
changes the playback 
direction of the slice:  

Forward 

  

 

Reverse 

 Clicking the symbol 
changes the playback 
mode of the slice:  

No loop.  The slice is played back for as long 
as the drum loop or the MIDI not is active, 
but only until the end. 

  

 

Loop. The slice is played back in a loop for 
as long as the MIDI note is active. 

  

 

One shot. The slice is played back 
independently of the length of the MIDI 
note until the end 

 Lock pad: Lock the pad out 
of the random function 
(see below).  

Not locked 

  

 

Locked 

 

 Random: A new, random selection of slices is added to the drum pads and 
random playback modes (4,5) are assigned. Locked pads are not included. You 
can use the random function repeatedly to discard unwanted results and keep the 
good ones. 

 Zoom: The zoom buttons enable you to enlarge the wave form display, to 
recognize more details,which is practical for correctly slice edges with the ALT 
button (see above) 

 



 

 

Audio effects 135 

 

Audio effects 
MAGIX Music Maker Premium Steam Edition offers a variety of progressive, intuitive 
and adjustable audio effects. 

The following effects are available in Music Maker: 

• For editing the sound spectrum, there is a graphic 10-band EQ and a parametric 
EQ (view page 146) with 6 bands. 

• The stereo processor (view page 144) lets you correct stereo width and 
direction. 

• Reverb (view page 148) provides an artificial room sound. 
• Delay (view page 152) creates an artificial echo. 
• The compressor lets you compress volume levels. 
• Filter (view page 154) and distortion (view page 154) let you add subtle to 

drastic levels of distortion. 
• The Tempo-Pitch/Resample (view page 143) effect can be used to change the 

tempo and pitch of objects. Vocal Tune (view page 139) can be used to fix the 
melodies from recorded instruments and vocals (autotune). 

• The Vocoder (Live & Premium version only) can transfer the sound sequence 
from one audio signal to another. You can use this to teach synthesizers to talk 
or to create ghost voices. 

Effects from third-party developers in VST format can also be used for effects editing. 
Some of the included effects are plug-ins. 

Music Maker contains the following plug-ins: 

• Vintage FX Suite (view page 178): Includes tiny guitar effects (also known as 
"stomp boxes") and recreated standard effects, including Analog Delay, Flanger, 
Chorus, Vintage Filter, Vintage Distortion and Bit Machine (Live & Premium 
version only). 

• Essential FX: A collection of "bread and butter effects". Includes 
efx_StereoDelay, efx_Phaser, efx_ChorusFlanger und efx_VocalStrip (Live & 
Premium only). 

• VandalSE (view page 189): The light version of MAGIX Vandal, a guitar amp 
simulator. 

• Am-Track SE (Live & Premium version only): This analog vintage compressor 
produces an especially warm, powerful sound. 
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Using audio effects 
Audio effects can be added at different positions in the project, to individual objects, 
to a complete track, or to the master (i.e. everything you hear). 
 

Object effects 
Object effects do not affect the entire arranger track, but rather individual objects. The 
advantage to this is that effects which are only required at a specific point in the 
project only use up processing power at that particular point. 

To activate an effect for an audio object, double click on the audio object or select the 
object and switch to the "Inspector" view in the Control Tab. The object effects rack 
(view page 137) will be displayed. 

The most essential effects are already listed here. Clicking on the +- icon will provide 
you with a menu with additional effects you can select. 

Right clicking on an audio object or going to "Effects > Audio" opens individual audio 
effects which can be activate via menu commands. 

Tip: The most important effects have keyboard shortcuts (view page 280). If you 
favorite effect doesn't have one, you can assign (view page 250) one to it! 

 

Track effects 
Besides the object audio effects, a separate track effects rack with an equalizer, 
reverb/echo, compressor and the Vintage Effects Suite plug-ins can be used. 

 You can open the track audio effects rack with the FX button in the mixer. A lit 
FX track button signifies that effects are active in the track. 

 

 

You can also open the track effects rack by 
going to the track effects menu in the 
Arranger track header (view page 33). 

Track effects always apply to the entire audio output of a track. They are used when 
software synthesizers (view page 119) serve as audio source, instead of audio objects. 

Note: The Vocal Tune, Tempo-Pitch/Resample and Vocoder effects (Live & 
Premium version only) cannot be used as track effects! 
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Master effects 
Master effects influence the mixed sum of all audio tracks.  

 The master effects rack is opened in the mixer window by using the FX button 
up and to the right over the master volume control. A lit FX track button 
signifies that effects are active in the track. 

The controls work similarly to the object and track effects racks. The Live & Premium 
version includes the MAGIX Mastering Suite for perfect sound. 
 

Effects rack 
The audio effects rack for objects can be opened by double-clicking an audio object. It 
is displayed in the Inspector in the Control Tab. The audio effects rack for individual 
tracks or for the entire sound ("master effect") can be opened using the FX buttons in 
the mixer window ("M" key). 

 

The effects rack comes equipped with the most 
frequently used effects. At first, they are 
deactivated and won't use up any computing 
power. Clicking on the effect name opens the 
effect's interface. 

Once you have selected an effect preset (view 
page 138) or have set the parameters manually, 
the effect will be activated. 

You can tell an effect is active if the on/off 
button is lit.  

  

You can also use this button to temporarily bypass effects without losing their 
settings. 

 
Clicking this button lets you activate additional effects.  

 
This button removes effects from the rack. Since deactivated effects don't use 
up any computing power, this option is used mostly for maintaining an 
overview. 
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The effects unit interfaces are controlled by using slider controls, knobs and buttons. 
The individual effect descriptions provide more detailed information. Several effects 
contain two special features:  

 

Sensor fields: Sensor fields allow you to control two 
parameters at the same time by moving a circle 
around on a flat surface. The horizontal and vertical 
positions correspond to the parameters. 

 
A/B: If you have selected a preset for the effect and 
make manual changes to it, you can compare the 
original preset sound with the new settings using the 
A/B button. 

 
 

Effects presets 
Presets are useful because they prevent you from having to change effects settings 
every time you use an effect. If you need to find fitting setting quickly, presets can be 
very helpful. 
 

Presets for individual effects 
Each rack effect has a range of presets that can be easily loaded by clicking on them. 
You can scroll through the list with the mouse wheel. Some lists also contain 
subfolders. Each list contains the "Reset" subfolder, which in turn contains the entries 
"Standard setting" and "Settings before opening the dialog". You can use these to 
completely reset the effect or reset it to its last value. 

 

The list can be hidden using the arrow to the right. 

Tip: Presets often contain more effect parameters than are normally accessible 
through the control elements of each effect. It's worth spending some time turning 
the knobs and trying out the available presets. 
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Object effect and track effect presets 
The "Audio FX" and "Vintage FX" folders can be found in the "Templates" tab in the 
Control Tab. These contain a range of presets for the most important effects and 
effect combinations. The presets have a preview feature, which lets you here an 
example of the effect when you click on it. You can drag & drop presets into audio 
objects in the Arranger. 

The current settings for each applied effects device in the object effects rack can be 
saved together as an effect preset, e. g. so that it can be used for other objects. To 
save your own effect preset, go to "Effects" > "Audio" > "Save Audio Effects". Your 
own templates will also be available to you in the Control Tab (Templates > Audio 
FX). 

 You can find presets for track effects sorted according to the instrument type 
in the track effect menu in the Arranger track box (view page 33). 

In this menu you can also save and load your own effect settings or completely reset 
the track effects. 
 

Effect curves 
Many effects can be adjusted using the effect curves for a more dynamic application 
of the effect. This means that certain effect settings can be changed during playback. 
The effect curves are available as object curves and track curves. Object curves are 
always object-related, i.e. they only apply to one object and are moved or copied 
together with the object. The track curves are saved in the track and affect all of the 
objects the track.  

To learn more about editing effect curves you can refer to the chapter „Effect curves“ 
(view page 220). 
 

Vocal Tune 
The Vocal Tune effect can be used to edit the pitch progression of an audio object. On 
the one hand, it is possible to rebalance "distorted” vocal passages. Depending on 
what you want, this can be as inaudible as possible or even drastically distorted (see 
Automatic pitch correction (view page 142)). On the other hand, however, the 
melodic line like in a piano roll can also be completely changed (see MIDI Editor (view 
page 94)). 

To customize the pitch correspondingly, the original pitch of the audio material must, 
of course, be known. Fundamental to the functionality is therefore a preliminary pitch 
analysis of the material. This is basically only for tonal, monophonic audio material 
like solo vocals, solo instruments, and speech. Polyphonic material, effects such as 
reverb or chorus and background noises do not provide good analysis results. 
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The analysis function starts automatically when the vocal tuner is opened. For larger 
objects, the analysis can take longer. After the analysis the audio object is divided into 
individual slice objects according to the detected pitches; a slice object corresponds 
more or less to a sung note. If the pitch deviations within a note are too large or the 
audio material contains noisy components that interfere with the analysis, this also 
results in two or three slice objects per note. 

 

 Slice Object: The mid pitch of a slice object determines its position in the 
graphic independent of the set progression of the pitch inside the slice object. 

 Pitch Curves: The resulting pitch progression is displayed with a yellow pitch 
curve. The original pitch progression is displayed as a blue curve.  

 Selected Slice Objects can be edited with the Move Tool. (see below)  

 The vertical axis is the pitch, the corresponding notes are displayed as a piano 
keyboard on the left border. Individual keys can be removed from the pitch grid 
(see below) by clicking on them (displayed in gray). 

 Similar to the arranger (view page 34), the displayed time section or the pitch 
range can be controlled with the +/- buttons and the scroll bar. 

 The play and stop buttons at the bottom left can be used to start and stop the 
playback of the project. S causes the audio object to play solo in the Vocal Tuner. 

 Tools for editing pitch (see below) 

 „Auto” Automatic pitch correction 
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 „Reset” removes all edits and returns all settings to their original status. 

 Activates the pitch grid for automatic pitch correction. 

 The Naturalness slider sets the intensity of the automatic pitch correction 

 „Bypass” temporarily deactivates the effect 
 

Editing Pitch 
There are three tools available for editing pitch: 

Move tool: You can use this tool to select slice objects for the 
editing by simply clicking on them. 

Ctrl+click enables the multiple selection of individual slices. Clicking on an empty area 
of the editing window and dragging a selection frame is another method for selecting 
several slice objects simultaneously. Selected slices can then be moved vertically, i.e. 
moving the pitch. 

If "pitch grid” is active, the slice objects always snap precisely 
to the semitones of the chromatic scale.   

To limit the snap function to specific keys (e.g. G minor) individual notes on the piano 
keyboard can be deactivated by clicking on them. The slice objects will then snap to 
the next "allowed" semitone. 

On the borders of the slice objects two handles are created on the pitch curve. These 
handles can be moved in order to produce an increasing or decreasing pitch 
characteristic while retaining the small changes in the basic frequency (vibrato). 

 

The handle at the end has been moved up to create a rising pitch progression. The small pitch 
fluctuations remain intact. 

Double-clicking on an individual pitch slice makes it possible to enter the pitch more 
precisely in a +/- cent deviation from the corresponding semitone. 

Cut Tool: You can use this tool to cut slice objects and create 
two slice objects that can be edited separately. This does not 
affect the pitch of the slice object. 
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It is possible, however, that a slice moves when cutting because the pitch of a slice 
displayed is only ever an average value across the total pitch progression within the 
slice. 

Draw Tool: This tool can be used to directly draw the pitch 
curve. If you hold the Shift key while drawing, a straight line will 
be drawn between the start position of the drawn curve and the 
current mouse position. 

If a pitch curve extends beyond the borders of a slice object, the two slice objects will 
be joined together.  
 

Automatic Pitch Correction 
The "Auto" function for automatic pitch correction can be found beside the draw pitch 
function. The "Auto" button moves all selected slice objects to the next semitone. 

Single notes can be deactivated by clicking on their respective keys on the piano 
keyboard. The will result in the note being moved to the next available semitone 
during the correction process. This makes it possible to limit the automatic correction 
to specific notes in a key. 

The "Naturalness" slider determines how much the original pitch progression is 
retained. With small values, the natural vibrato of the voice is radically "flattened” and 
the famous "Cher effect” results. 
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Tempo pitch/resample 

 

This effect device changes the object’s speed and/or pitch.  

Note: This effect may start automatically if you use loops with different original 
tempos in a project or when you make changes to the project tempo at a later stage. 
This effect is also used when you use the stretch mouse mode (view page 54). You 
can find more information about this in the audio object chapter, Change the 
playback tempo or pitch (view page 75). 

Tempo: This control changes the tempo independent of the pitch ("time-stretching"). 
The object acts as if it were compressed or stretched on the track. 

Pitch: This control changes the pitch independent of the object’s speed ("pitch-
shifting"). 

+/- buttons: With this function you can change the pitch in semitones. 

Setup: This button opens a settings dialog where you can set the algorithm for tempo 
and pitch correction. 

• Élastique Pro:This algorithm is used by default and provides optimal results for 
most audio material. 

• Élastique Efficient: This is a version of the algorithm that saves computer power 
and has reduced sound quality as a result. 

• Monophonic voice: This is a special algorithm for vocal solos, speech or solo 
instruments. It is also used for the Vocal Tune (view page 139) effect. 
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• Resampling: This effect corresponds with faster or slower playback of records or 
tapes. Every change in tempo results in a simultaneous change in pitch. This 
function requires very little processing time and is a popular design element for 
"Mickey Mouse" voice effects or drum loops, for example. 

Note: Other algorithms (e.g beat marker stretching) are available for older 
soundpool samples. These ensure that older Music Maker projects sound exactly 
the same as before in the new version of Movie Edit Pro. However, these algorithms 
cannot be used once the sample has been changed to the default Élastique 
algorithm and the settings dialog has been closed. 

 

Stereo processor 
With the stereo processor, you can determine the positioning of the audio material in 
the stereo panorama. If the stereo recordings sound unfocused and undifferentiated, 
an extension of the stereo base-width can often provide better transparency. 

Use the maximize feature to move the echo (e.g. into the foreground) and improve 
the stereo picture. 

 

 Volume controller: Adjusts the volume of every single channel, thereby adjusting 
the entire panorama. The reduction of left and right levels is displayed under the 
control buttons. 
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 Panorama: Use this controller to move the sound source from the middle into 
stereo panorama. The signals at the outer edges of the sound picture remain 
unchanged. 

 Bandwidth/maximize sensor field: Adjusts the base width between mono 
(extreme left), unchanged base width (normal stereo), and maximum base width 
(wide, extreme right). Raising the base width (values over 100) diminishes the 
mono compatibility. This means that recordings edited this way sound hollow 
when listened to in mono. 

Maximize strengthens the spatial component of the recording, which also 
increases the stereo transparency without influencing the mono compatibility. 

 Multiband: This can be used to switch Stereo FX to Multiband mode. Stereo 
editing only applies to the middle frequency, the bass and highs remain 
unchanged. 

 Stereo meter (correlation gauge): This provides a graphical display of the phasing 
of the audio signal. You can use it to check the alignment of the signal in the 
stereo panorama and the effect of the stereo enhancer. To maintain mono-
compatibility, the "cloud" shown should always be higher than it is wide. 

 

Compressor 

 

The compressor is an automated dynamic volume control. It limits overall dynamics, 
maintains the volume of loud passages so they stay loud, and increases the volume of 
low passages.  

Processing is carried out using a "look-ahead" method, similar to high-quality studio 
appliances.  There are no peak overmodulations or other artifacts as the algorithm can 
never be 'surprised' by sudden level peaks. 
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Threshold: Sets the volume threshold. Compression will be applied above and below 
the threshold. 

Ratio: This parameter controls the amount of compression. 

Attack: Sets the algorithm's reaction speed to increasing sound levels. Short attack 
times can create an undesirable "pumping" sound, as the volume is quickly reduced or 
increased correspondingly. 

Release: Sets the algorithm's reaction speed to falling sound levels. 

Gain: The gain controller amplifies the compressed signal. 

A/B: If you have selected a preset for the effect and make manual changes to it, you 
can compare the original preset sound with the new settings using the A/B button. 
 

Parametric EQ 
The parametric equalizer has six filter bands that you can use to shape the sound of 
the music track. Each band is a filter with a typical "bell shape". Within a certain 
frequency range around an adjustable middle frequency, you can increase or reduce 
the signal level gain. The width of this frequency range is called bandwidth. The 
bandwidth is defined by the Q value. The higher the Q value, the narrower and 
steeper the filter curve.  

You can influence the basic sound of the mix by boosting or cutting specific frequency 
ranges (low Q value) to give it more "depth" (lower mids 200-600 Hz) or more "air" 
(Highs 10 Khz). You can also decrease very specific frequencies (high Q-value) to 
remove unwanted noise. 
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 Sensor field: The sensor field displays the resulting frequency response of the 
equalizer. The frequency is displayed horizontally and the increase or decrease 
of the respective frequency is displayed vertically. 

 Bullets 1-6 symbolize the six frequency bands. You can move them around with 
the mouse until you find the frequency response you want. The bandwidth (Q 
value) can be adjusted using the mouse wheel. 

 The faders under the filter graphic display the parameters of the currently 
selected band. You can use the knobs to set the values for each band more 
precisely:  

 

 Frequency: The center frequency of the individual bands can be set between 10 
Hz and 24 kHz with the frequency controller. Freely choosing the frequency 
enables multiple filters to be set to the same frequency in order to have a greater 
effect. 

 Gain: This controller allows you to raise or lower the filter. Setting the controller 
to 0 deactivates the frequency band so it does not use any processing time. 

 Q factor: Here the Q factor (bandwidth) of the individual filters can be set. 
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 Band 1 and 6 are special in that they can be operated using three different filter 
curves. 

 
Peaking: This is the same bell shape used for the center bands. 

 
Shelving (basic setting): Starting from the set frequency, there is a 
gentle increase or decrease in the frequencies.  

 
High-pass and low-pass: Starting from the set frequency, all higher and 
lower frequencies are filtered out.  

 It is possible to control the output level of the equalizer with the Peak Meter, and 
with the output amplification beside it, you can balance level changes resulting 
from EQ adjustments. 

 
 

Reverb/Echo 

 

The reverb effect device offers realistic reverb algorithms to add more room depth to 
your recording. You can control the sound of the reverb effect using the following 
parameters: 

Room size: Defines the size of the room (or the system for the plate and spring). The 
larger a room, the longer the sound travels between walls or objects. With some low 
"size" settings you can also reduce the distance between the individual reflections. 
This allows resonance to develop (accentuated frequency ranges), which can sound 
oppressive if the reverb sustain is too long. 

Tone quality: You may influence the sound characteristics of the effect within certain 
limits. The effect of this controller depends on the used preset. In rooms, "tone 
quality" controls the dampening of the highs in the reverb (from dark to bright) as 
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well as pre-filtering of the signal. With plate and spring presets, this fader determines 
the dampening of the basses as well. 

Reverberation time: With this knob you can adjust the reverberation time and 
determine how much of it will be absorbed and, simultaneously, the reverb's decay. 

Pre-delay: The reverb portion ("Mix") and the early reflections play a big role in the 
spatial perception of the sound. Here the time required for the perception of the early 
reflection is know as "Pre-delay". For sound sources that are close, the reverb portion 
is usually low and the early reflections reach the ear noticeably later than the direct 
sound. In contrast, sound sources that are far away usually have a high reverb portion 
and the early reflections reach the ear almost simultaneously with the direct sound. 
The length of the pre-delay can be used to influence the perceived "distance" between 
the sound source and the listener. 

Mix: This controller sets the mix ratio between the original and the edited signal. For 
rooms you can move a signal further into the room by increasing the effect share. 

Note: The presets contain basic settings for different room algorithms which can be 
varied with the parameters above. The presets need to be used in order to achieve 
all the reverb effect variations.  

 

Fundamentals 
Our everyday experience shows that not every room matches every instrument. Thus 
we have designed “virtual” rooms. However, it still remains important to find the 
correct parameters. Here are some examples of parameters that are decisive for the 
sound impression in real and virtual rooms: 

• Size of room: The larger a room, the longer the sound travels between walls or 
objects. Our brain “calculates” the size from the time difference. The size 
impression is mainly determined from so-called first reflections and the discreet 
echo. We don’t notice a (diffused) reverb. 

• The reverberation time is mainly influenced by the composition of the walls, 
ceilings and floors. This reverb time is highly frequency-dependent. For instance, 
the highs and mids are dampened more in rooms with curtains, carpets, 
furniture and some corners than in an empty and tiled room. 

• The density of the reflection: The sequence of the first reflection is particularly 
important. A room with many individually recognizable echoes feels alive, 
especially if they are quite far apart. 

• The Diffusion: Simple reverb machines do not take into account that reflections 
become more and more complex as they develop. They blur the first echoes at 
the beginning, which sounds artificial and “two-dimensional” for many signals. 
Our reverb effect works like a real room instead where individual echoes can still 
be heard at the beginning of the reverb but then reflect amongst each other 
more and more until they disappear in the signal sustain as a so-called “diffused 
hiss”. 
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The 24 presets include many rooms that were designed for certain instruments and 
applications and whose internal parameters have been optimized for these 
applications. However, you can influence most of the characteristics of the room 
using the provided sliders. 

In addition to the rooms we have modeled two device types in the reverb effect that 
allow you to create an artificial reverb for a longer time: Plate Reverb and Spring 
Reverb. 

Plate Reverb: A plate reverb consists of a large metal plate (often 0.5 to 1m2 thick or 
more), that is put into motion by a magnet and coil system (similar to a loudspeaker). 
On the reverb plate so-called “taps” are positioned at different locations. These are 
pick-ups comparable to those on a guitar. Reverb plates have a very dense sound 
(high diffusion); no direct echo can be heard. They are therefore ideal for percussive 
metal. With vocals a plate reverb generates a smooth “wellness effect”. 

Spring Reverb: You probably remember Spring Reverb from guitar and keyboard 
amps, particularly older ones. At the bottom of these amps a unit consisting of two to 
four spirals is mounted on a vibration-free carriage. As with the reverb plate it uses 
systems for transforming the electric signal into a mechanical one. There are different 
designs and sizes of spring reverb; however, they all have the same quite peculiar 
sound: the typical “bloing” sound when the springs are moved, similar to splashing. 
When the reverb dies away the basic pitch of the spring(s) can usually be heard quite 
clearly. Furthermore, the frequency range is considerably limited due to the losses in 
the spirals and in the used pick-up/transmitter. Despite this, the sound is special and 
some of the latest music styles (e.g. dub & reggae) would hardly be possible without 
spring reverb. 
 

Presets 
The presets are primarily sorted by instruments; however, you can (and should) 
choose which preset you want to use for which instrument. The rooms in particular 
have completely different characteristics which are noticeable for some and more 
subtle for others. Generally we recommend reverb with many individually audible 
reflections and slight diffusions for dense projects. On the other hand you can use 
Plate Reverb for minimally arranged songs in order to create a dense atmosphere. 

However, you should avoid adding reverb to too many instruments. Sometimes some 
extra mixing is sufficient to move an instrument slightly away from the total sound. It 
is often recommendable to adjust the sustain to the song tempo, i.e. the faster the 
track, the shorter the reverb. Otherwise the sound easily sounds washed-out and 
indifferent. 

Here is a list of the presets and their characteristics: 

Drums and percussion 

Drums: Studio A: small room, high diffusion, e.g. for percussion instruments 
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Drums: Studio B: slightly larger & more lively than A, medium diffusion, distinct first 
reflections, signals seem closer than A 

Drums: Medium-sized room: medium-sized room, moderate reverb, medium 
diffusion, relatively few first reflections 

Drums: empty hall: medium-sized empty hall, medium diffusion 

Drums: Snare reverb plate A: plate reverb, high diffusion, relatively bright sound 
character, typical hissing of a reverb plate. 

Drums: Snare reverb plate B: reverb plate, high diffusion, slight dampening of highs & 
basses, sound moves more to mids with time, stereo panorama narrower than for A 

Vocals 

Voice: main hall A: standard hall, e.g. for monitoring/recording, medium-sized room, 
medium diffusion, minimum sustain time 

Voice: main hall B: like A, but as a small hall (longer delay times than A), distinct 
reflection pattern, longer reverb time 

Voice: early reflections: medium-sized room, low reverberation share, very distinct 
early reflection pattern, e.g. for spreading vocals 

Voice: warmer room: small, intimate room, dark character 

Voice: studio reverb plate A: reverb plate with medium diffusion, slight dark 
adjustment, comprehensive sound characteristics 

Voice: studio reverb plate B: Like A, but more diffusion and bright to medium sound 
adjustment, slight vintage character 

Voice: large hall: large hall, medium diffusion, relatively long reverb time 

Voice: cathedral: delayed attack, slight diffusion, complex echo pattern, some hard 
reflections, dark voice adjustment, long reverb sustain 

Guitar 

Guitar: Spring reverb mono A: spring reverb simulation, typical oscillating sound of 
the springs, limited frequency range 

Guitar: Spring reverb mono B: Like A, slightly broader frequency range, greater 
diffusion 

Guitar: Spring hall stereo A: similar to spring hall mono A, but one 
spring/transmission system per channel (L/R)As a result of the mechanical 
interlinking of the systems, the reverberations meet at the middle of the stereo field 

Guitar: Spring reverb stereo B: Like stereo A, slightly broader frequency range, 
greater diffusion 

Keys (Piano, Synthesizer) 
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Keys: Stage reverb: Larger room with stage, high amount of complex first reflections, 
slightly delayed attack, medium reverberation 

Keys: piano reverb: concert hall, long reverberation, medium diffusion, minimum dark 
adjustment 

Aux (to be used as a send effect in a mixer FX track) 

Aux: Room: Standard room for the aux path, mix 100%, medium-sized, medium 
diffusion, some distinct first reflections, low reverberation 

Aux: Hall: Medium-sized hall (100% wet), medium diffusion, short reverberation 

Aux: Reverb plate: Reverb plate (100% wet), high diffusion, light bright adjustment 

Aux: Spring reverb: Reverb spring (100% wet), stereo, high diffusion, slightly medium 
sound characteristics 
 

Echo (delay) 

 

This effect creates an echo. This results in the signal being played back with a delay. 
Since the output signal is sent back to the input of the effect line, the echo repetitions 
are more or less long. 

Delay: This sets the period of time between the individual echoes. The more the 
control is turned to the left, the faster the echoes will follow each other. 

Feedback: This adjusts the strength of the echo. This determines how long the echoes 
are. If you turn the dial completely to the left, there is no echo at all; if you turn it 
completely to the right, there are seemingly endless repetitions. 

Mix: This fader determines how much of the unprocessed original sound (dry signal) 
is subjected to the echo (wet signal). 
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Presets: Presets serve different purposes. In the upper part of the list there are presets 
that allow the delay time to be set using musical units. This is very useful for adding 
beat-synced echo to rhythmic material such as drum loops or arpeggios. The other 
settings can be used for special effects involving very short or very long delay times, 
e.g. "metallic" or "robotic" sounds. "Simple Echo" can be used to set the echo 
repetitions between 0 and 4 using the feedback slider. 
 

10 Band Equalizer 
The 10-band equalizer subdivides the frequency spectrum into ten areas (bands) and 
equips them with separate volume controls. This way it is possible to create many 
impressive effects, from a simple boosting of the bass to complete distortion. If low 
frequencies are boosted too much, the overall sound level is heavily increased, which 
may lead to distortion. In this event, adjust the overall volume downward by using the 
"master volume" control situated at the bottom center of the effects rack. 

 

Bullets 1-10: Each of the 10 frequency ranges can be separately made louder or softer 
with the 10 volume controllers. 

A/B: If you have selected a preset for the effect and make manual changes to it later, 
you can compare the original preset sound with the new settings by using the A/B 
button.  

Link: Using this feature randomly combines the frequency ranges with each other in 
order to avoid artificial-sounding overemphasis of an individual frequency range. 
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Distortion 

 

This is a distortion tool that overmodulates the audio object. 

Gain: With these faders you can specify the degree of distortion. 

Cut-off frequency: Here you can set the frequency range you want to distort A 
specific frequency band will be made stronger with a bandpass filter. The filter 
deactivates if the cut-off frequency is set to 100%. 

Threshold value: You can have the distortion applied once the level exceeds a certain 
threshold value, so that quiet signals remain undistorted.  

Volume: Here you can set the volume of the distortion. This allows you to even out a 
stark increase in volume which can be caused by the distortion. 

Tip: Be sure to try out Vintage Distortion (view page 184) or, if you have the Live & 
Premium version, the VANDAL SE (view page 189) amp simulator for authentic 
guitar sounds! 

 

Filters 
Note: This effect is only contained in Music Maker for the sake of compatibility with 
older projects. You can get better results by using the parametric 6-band EQ (view 
page 146) or the Vintage Filter!  (view page 181) 

The filter controls the volume of specific frequency ranges similarly to the Equalizer. 
You can use the filter to completely suppress frequencies, which can in turn create 
quite strong distortions. 
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Frequency: Here you can set the frequency you want to filter. 

Level: Here you can set the strength of the filter. The frequency can be increased or 
decreased. 

Q factor: This is the filter Q factor. This defines the filter bandwidth around the 
frequency to be increased. 

Volume: Here you can even out volume differences resulting from the filtering. 
 

Vocoder 
The vocoder works as follows: Carrier material (e.g. a string instrument pad or synth 
chord) is affected by a modulator (e.g. language or singing) to give the impression 
that the pad sound is “speaking” or “singing”. In addition, rhythmic pads can be 
created by modulating an area with a drum loop. 

This works by transmitting the modulator's frequency characteristics (language) to 
the carrier (chord). 
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Select the carrier signal for the vocoder here. Click the arrow button to select one 
of the predefined carrier samples in the list field. The carrier sample can be 
previewed via the small "Play" button. Another carrier sample can be loaded via 
the folder icon. 

 

By switching to "Track", the output signal of another of the project's tracks can be 
used as the carrier signal. 

 

 

By clicking the double-arrow button you can swap carrier and modulator signal. 
The object's audio signal will then be modulated by the selected sample or track 
signal. 

 Set carrier signal volume with the "Carrier input" in the middle. 

 Material containing all frequencies in equal amounts, such as strings, orchestra 
chords, broad synthesizer pads, hissing or wind noise, are particularly suitable for 
carrier samples. If this is not enough, additional white noise can be mixed into the 
carrier signal with the "Carrier Noise" fader to improve speech clarity. 

 Filter graphic: Here you can draw any frequency progression you want with the 
red line in order to optimize the vocoder output. For example, you can get rid of 
disruptive bass frequencies by adjusting the curve downward in the left area. Or 
you can boost weak highs by adjusting the curve upward in the right area. The 
yellow line shows the frequency curve without filters, the blue line the frequency 
curve with filters. 

 Dynamic Reduction: Influences the dynamics of the modulator signal to reduce 
the modulation depth of the vocoder.  This prevents two often undesired side 
effects of modulation. On the one hand the volume change of the modulator 
signal is added to the output signal in a slightly more moderate form, which may 
improve the power of the Vocoder voice. On the other hand, the low-level 
portions of the modulator signal are ignored in order to prevent modulation of the 
carrier by breathing or noise. 

 Dynamic Release: Influences the speed of adjusting the vocoder to the modulator 
spectrum. As this value increases the vocoder starts to follow the modulator more 
slowly resulting in softer, reverberated sound changes in the carriers. 
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 In the Mixer you can also mix parts of the carrier and modulator signal to the 
vocoder output signal. If the output signal of a track is used as a carrier in the 
vocoder, this track will first be muted. In the vocoder mixer you can then make it 
audible again. 

 

MAGIX Mastering Suite 
MAGIX Mastering Suite is a special effects rack for use with the mixer master 
channel. The effects in the Mastering Suite are used as part of the mastering process, 
in which the mixed music piece is given a final polishing. 

 
The On/Off switches switch the effects on and off individually or the Mastering 
Suite as a whole. 

 
 
 

Auto Mastering 
The Auto Mastering feature enables you to automatically apply the sound of typical 
musical styles from the past and present (e.g. 70s disco, 90s club, jazz etc.). The 
sound of the source material is analyzed and appropriate equalizer and dynamic 
effects are applied.  

Now choose the musical style. 

 

MAGIX Music Maker Premium Steam Edition will analyze the audio material in the 
project.   
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The Auto Mastering results will be played back immediately. You can now click 
through the different styles to compare them. 

 

Selecting "Original" allows you to compare the edited version with the original. 

You can also create your own styles. Select any type of audio file as a template in 
"Load & Analyze" if you want to emulate its sound. Formats such as MP3 or OGG are 
converted beforehand into WAV format. After the analysis, your new style is 
available in the selection list. 
 

Stereo processor / parametric EQ 
The stereo processor (view page 144) and the parametric EQ (view page 146) in the 
Mastering Suite are identical to those in the FX rack for objects, tracks and the 
master. 
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Multimax 

 

Multimax is a compressor with three independent frequency bands. The dynamics are 
edited separately for each band. 

The advantage of a multi-band compressor versus a "normal" compressor is that the 
"pumping" tendency and other unwanted side effects are dramatically reduced while 
editing the dynamics. For instance, it can prevent a bass top peak from "dragging 
down" the entire signal. Multiband technology also lets you specifically edit individual 
frequency ranges. 

Setting the frequency bands: The settings of the frequency bands are changed 
directly in the graphic. Simply click on the separator lines and move them. 

Lows/mids/highs: These knobs control the level of compression for each frequency 
band. 

Link: When this button is activated and a fader is adjusted, all other faders are 
changed proportionally. However, the way the dynamics are edited is not affected. 

Presets:In MultiMax, you can use Presets 2 to open further special features: 

• Cassette NR-B decoder: MAGIX Music Maker Premium Steam Edition simulates 
decoding of Dolby B + C noise suppression if a Dolby player is not available. 
Cassettes recorded with Dolby B or C sound more muffled and slurry if played 
back without the corresponding Dolby.  
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• De-esser: These special presets help to remove overstressed hissing sounds 
from speech recordings. 

 

Non-real-time effects 
All the effects mentioned above are calculated in realtime. Some audio effects are not 
calculated in realtime. When you apply the effect to an object, copies of the audio 
material are created for calculating the effect after the settings dialog is closed. You 
cannot change the effect parameter in realtime during playback. However, no 
additional calculations are required during playback. 

To change these effects, use the undo feature. 

The following effects do not work in "realtime": Freely-drawn filters (only in the Live & 
Premium version), gater, reverse, invert phase.  
 

Sketchable filter 
This allows you to draw the craziest effects simply with your mouse. The left side of 
the graphic represents low tones, the right side high tones. You can switch on real-
time playback by clicking on the "Test" button.  

From now, all changes of the red line can be heard immediately. A “slope” in in the left 
graphic causes a strong increase of the bass, a “slope” in the right side strongly 
increases the highs. An interesting effect is to delete a filter curve over an entire area, 
i.e. setting all the values in the display to low values). This practically cancels the 
sound. 

From now on, you will be able to hear all changes in the red line. A "hill" in the left part 
of the graphic results in a strong increase in the bass, a "hill" on the right side 
considerably increases the treble. 

Great effects are frequently achieved if a filter curve is initially deleted over the entire 
area (if everything in the display is set to low values). This removes almost all the 
sound. 

Now, only individual frequency ranges can be made audible in the upper section of 
the display with a few clicks of the mouse. This rapidly turns a normal drum loop into 
Science Fiction noises! 

The filter curve can quickly be reset to its original condition with the Reset button. 

The option “Prevent clipping” attempts to automatically prevent an over-addressing 
of the audio material. 

The “volume” control controls the volume of the material. 
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Filter-Sweeps/Morphing 
The creation of so-called “Filter-Sweeps” or “Morphing” is also possible: 

1. Activate the “Start curve” button on the far right. 
2. A red filter curve for the beginning of the audio material can now be drawn, e.g. 

a ‘hill’ in the left half of the display (increase bass). 
3. Activate the “End Curve” button. 
4. A blue curve for the end of the audio material can now be drawn, e.g. a ‘hill’ in 

the lower part of the display (increase treble). 
5. Real-time replay can be started with “Test” – A soft filter sweep bursts out from 

the red to the blue curve. Really cool morphing sounds can be created in this 
way! 

 

Invert Phase 
With a stereo signal the phase of a channel is inverted. In other words: The waveform 
is flipped from top to bottom, all positive values are replaced by negative values and 
vice versa. This cancels all the signal components that are identical in both channels. 
The result is a special, hollow sound that only contains the extreme right and left 
positions in the stereo image. One side effect of this function is that the object is only 
played back through the rear speaker in a Dolby Surround system. 
 

Gater 

 

This special effect "chops up" a sample into a given number of parts (16-128) Select 
the number of steps, which will then be distributed over the duration of the sample. 
Additionally you can set the volume for each individual step using the fader, so that 
the hard sections can be produced in the same way as soft levels. 
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The Gater function can also work as a filter to create interesting sound deformations 
which are particularly good for Techno! This is useful when you want to create a cool 
sample from a sound without its own rhythm. 

In "Division" you can set more than 16 sections to produce even more variations in the 
 sound. . The fader settings are then repeated which means that step 17 has the same 
value as step 1 etc. 

A real-time monitoring function allows immediate musical control of any fader 
change. 

Principally, there are two operating modes which can be combined with each other: 
 

Volume or filter progressions 
The objective of this function is to change the volume or the sound character of the 
audio material in 16 or more steps with the aid of the 16 faders. The default setting of 
every fader corresponds with one sixteenth of the audio material – i.e. a sixteenth note 
in a 1 bar loop or an eighth note for a two bar loop, etc. 

This leads to interesting rhythmic results, e.g. by lowering the volume of individual 
faders or through stepped volume increases. Various progressions can also be quickly 
created with the help of the random function. The real-time screening function 
permits constant acoustic control while this is being done! 

Gater progressions make it very simple to create rhythmic sounds from a simple 
strings or synthesizer section or to emphasize or tone down certain beats in a drum 
loop. 
 

Reordering 
The playback sequence of the 16 steps can be changed with the colored key fields 
located below the faders. This makes it possible to repeat a beat from the first 
sixteenth in the fourth sixteenth. To do this, the number under Fader No. 1 must be 
the figure 1. The fact that item 4 will now play back the material in item 1 is shown in 
color.  

Does this sound complicated? 

If so, simply try the Random function. It instantly pronumerous variations. If you have 
the Real-time screening function running, you can then quickly decide for yourself, 
which groove you like better! 

You can use the Re-order function to derive totally different variations from a drum 
loop quickly and impressively. 
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Backwards 
When Backwards is applied the sound file will be played in reverse. This way you can 
create very interesting effects, not to mention the “hidden messages” in many songs... 
 

essentialFX 
MAGIX essentialFX (view page 165) is a collection of "bread and butter effects" for 
the most important applications. 

These are simple but solid tools with clear feature sets for daily application. They 
include fewer controllers and require less resources. 
 

MAGIX plug-ins 
Console 
Some MAGIX plug-ins show a so-called "Console" at the top edge when they are 
opened – a display bar for managing presets with expanded settings options. 

 

A menu containing available presets is located behind the display. To the right is a 
prev/next button, which lets you leaf through presets. 

 This button is used for saving presets. MAGIX plug-ins use a proprietary 
preset save format (*.fxml) 

 
You can return the presets to their initial settings by clicking on the 
"Reset" button. 

 
Bypass switch: Routes the signal directly to the output instead and 
bypasses processing. Internally, processing is continued so that you can 
toggle between processed and unprocessed material anytime. 

 
A/B comparison: Very useful for trying out settings. The controller 
setting "A" memory is normally activated when the interface is opened. 

As this is the initial status, "B" also contains the same settings. If you would like to 
experiment without losing the current setting, press the "B" buttons and try other 
settings. To transfer the values to "A", press the copy button between the two letters. 

 
"?" button: This opens the online help for the plug-in. 

 

Parameter smoothing/ Controller knobs 
Each plug-in offers soft controlling. Pot settings are softly faded internally from the old 
value to the new one. This is particularly noticeable when playing in "Live" mode. Due 
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to performance reasons, switches (e.g. on/off) and some settings of VariVerb II that 
change delay times directly or indirectly are excluded from this action. 

Use the mouse wheel to move the knobs (pots). A combination of the mouse wheel 
and "Shift" key slows down the increase or decrease by a factor of ten. Double-
clicking resets the knob to the original value. 
 

Vpot Controls 
Some controllers snap to the middle setting, which may be useful for quickly returning 
to a "neutral" status. It is extremely difficult to adjust the fine settings within close 
proximity of this snap point. You can temporarily deactivate this snap mode by 
holding "Shift" before touching the controller. 

Use the mouse wheel to adjust the controllers. A combination of the mouse wheel 
and "Shift" key reduces the increase/decrease by factor ten. 

Apropos the controller movement, note that all plug-ins follow the host settings 
regarding linear or circular mouse movement.  You can usually choose whether you 
prefer up/down or a circular movement to adjust the value. 
 

essentialFX Presets 
By clicking on the tool symbol in the graphic display, you can open the presets.  

Under "Tweak" you can find specific settings options for each effects device. 

Under "eFX Globals" you can find settings options for graphic level display as well as 
mouse control. 

 

eFX Globals 
These settings apply to all Essential FX. 

Metering: Here you can set the meter display.  

• Decay Time controls reaction speed.   
• Peak Hold controls the hold of the highest peak. 
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• Brightness controls the display brightness. 

Mouse: Here you can set the display reaction to mouse movements in the essential 
FX graphic display. 

• Linear mode lets the faders move in response to vertical and horizontal mouse 
movements. 

• Circular mode lets the faders be controlled by circular mouse movements. 
• Mode As Host lets the faders move in response to the mouse exactly how 

mouse settings in MAGIX Music Maker Premium Steam Edition  specify it. 
• [Shift] Factor specifies the factor for fine adjustment of individual faders with 

the mouse with simultaneously held Shift key. 
 

Chorus/Flanger 
This plug-in offers a simple way to make signals sound more interesting, "spacier", 
thicker, etc. by modulating or delaying the pitch - the classical domain of application 
is for guitars, Hammond organs, electric pianos, or synths. 

Chorus and flanger are two closely related effects, which are combined into a single 
plug-in. They normally differentiate in terms of delay time, type of modulation, and 
degree of internal feedback. 

 
 

Chorus flanger parameters 
IN / OUT: Here you can set the input and output level. 

mode: 

- Stereo chorus:  Compared to mono chorus, two copies of the original are created, 
modulated against each other in pitch, and then fed accordingly to the set mix ratio to 
the left and right output channel. 
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- Mono Flanger & Stereo Flanger In contrast to the Chorus Effects the lower delay 
periods and a slightly changed modulation are processed. 

- Ensemble: This creates a denser chorus, similar to Boss/Roland CE-1: Instead of two 
voices, six are generated. Two internal sine LFOs for de-tuning, whereby for both 
LFOs the second and third voice phase length by 120°. This results in a denser-
sounding effect that is also less warped. 

• Rate: This specifies the speed of the modulation. Lower rates provide slight 
hovering effects, and high speeds produce a wobbling, typically distorted 
"underwater" sound. 

• Depth: This parameter specifies the depth of the modulation, i. e. the maximum 
deviation of the modulation and the resulting pitch bending. 

• phase: This fader moves the right channel's oscillator phasing relative to the left, 
wave is put back to the right. So that the Tremolo effect drifts apart in the stereo 
field with ever increasing values. At 180° both oscillators work in reverse, 
therefore the stereo effect is at its strongest. 

• Feedback: This parameter defines the portion of the delay that is sent back to 
the input. Feedback causes the effects of modulation to be more drastic and 
cutting. Nullification of the feedback is set at the middle of the fader. Set to the 
right, the feedback is fed to the input equi-phasal; to the left, the feedback 
occurs. Both variants may sound very different depending on the signal, since 
they prefer different frequency ranges for dissonance. 

• Mix: Regulates the mix ratio of the original signal and the delayed portion. 

Tweak  

• Low Cut: This knob sets the filter frequency of a high-pass filter. Signal 
components below this frequency will be filtered out. 
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Phaser 
The phaser is often mistaken for a flanger due to its typically sharper and cutting 
effect. In any case, the pitch is not modulated. Instead, the modulation process 
burrows multiple notches into the frequency response, somewhat like a comb filter. 
Just like an airplane taking off, the phaser functions with a similar jet effect. It is 
suitable for enduring signals like synth surfaces or for producing sound designs to 
create atmosphere or distortion effects. 

 
 

Phaser parameters 
IN / OUT: Here you can set the input and output level. 

Mode: The selection includes a number of filter stages. At 4 stages/8 stages, a more 
plastic effect is achieved, and more complex patterns are reached at 16 stages. Please 
note that the more stages are involved, the more computing time will be needed. 

• Rate: Speed of filter modulation. The essential effect is the same for both chorus 
and flanger. 

• Depth:  Similar to chorus/flanger, whereby it's the filter notches that are 
addressed, and not the pitch modulation. 

• phase: This fader moves the right channel's oscillator phasing relative to the left, 
wave is put back to the right. So that the Tremolo effect drifts apart in the stereo 
field with ever increasing values. At 180° both oscillators work in reverse, 
therefore the stereo effect is at its strongest. 

• Feedback: The feedback portion produces a more drastic effect in this case. 
Similarly to the chorus/flanger, co-phasal or opposite-phase feedback is 
possible.  

• Mix: Regulates the mix ratio of the original signal and the delayed portion. 

Tweak  
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• Center Freq: Sets the mid-frequencies of the phaser. The filter modulation acts 
on these frequencies. 

 
 

Stereo Delay 
The stereo delay is a simple too for typical bread and butter delay effects. The stereo 
delay offers the "analog algorithm", which features the sound of echo devices of 
yesteryear. 

 
 

Stereo delay parameters 
IN / OUT: Here you can set the input and output level. 

Mode: This selects between the essential algorithms. 

Digital: Normal, transparent delay 

- Analog tape: Analog tape delay simulation. In this mode, a band echo is simulated 
with a typical compression and saturation behavior, including phase shifts with high 
feedback settings. 

Analog BBD: Simulation of a bucket brigade delay (BBD, bucket brigade delay). These 
devices, which originate from the pre-digital era, used analog building blocks for 
storage. The signal was held for a short time in a relatively simple circuit and then 
moved on to the next. This "bucket brigade" principle created a longer signal delay. 
BBDs create different delay times by varying the system beat (clock), meaning  that 
for short delays the beat is faster, and for longer it is slower. 
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• Tempo sync: If this button is active, the plug-in is directed at the 
host/sequencer tempo. In this mode, changes are made to the delay period via 
the L/R delay using the musical snap grid (e. g. 1/4 note). 

• Delay L/Delay R: Specify the delay period for the left and right channels here. 
• Damping: This specifies the cut-off frequency at which the highs are dampened 

during the delay. This useful  for making the delays reverberate more naturally or 
for creating special effects (reggae/dub-style effects). 

• Feedback: This parameter regulates the internal amplitude of the delayed signal 
that is fed back to the input. In "Digital" mode, this process is completely 
transparent; in "Analog", on the other hand, higher values, a very loud input 
signal, or the sum of these will make the use of dynamics compression audible. 
In both modes, the nullification of the feedback parameter is in the center of the 
fader. To the right, the plug-in works in "Dual delay" mode (both sides work 
independently), and to the left, "Ping pong" mode will be activated (the delayed 
signal alternates between the left and right sides). 

• Mix: Regulates the mix ratio of the original signal and the delayed portion. 

Tweak  

• Feedback Low Cut: This control sets the filter frequency of a high-pass filter for 
the "feedback". Signal components below this frequency will be filtered out.  

• Tape / BBD Noise: Here you can control system noise for both analog modes. 
Especially if you work with high feedback rates, noise can create quick or stable 
oscillation, making the effect even more authentic. 

• BBD Stages: Here you can determine the count of  For very long delays, chips 
with many memory cells are used. This explains why bucket brigade echoes with 
long delays sound so muffled and dirty. Please keep in mind that the shorter the 
delay, the faster is the "virtual" system beat. For performance reasons, the 
system beat is limited. The limit is displayed below the delay control (with 
deactivated "tempo sync") as soon as it is reached, e. g. 46 ms (min). 

• BBD Compander: Here you can simulate Compander settings. Due to per-cell 
loss, BBDs have low system dynamics. For this reason, some have an integrated 
compander (compression at the input, counter-expansion at the output). Strong 
compander settings interact noticeably with the input signal, especially with 
high feedback, because the input effects the expansion ration at the output, even 
when there is no signal at the input. 
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• BBD Clock Drift: This parameter can add drift (during audible jitter effects) by 
slightly varying the system beat of BBD cells. It works similarly to an LFO, but is 
randomized. 

 
 

Vocal Strip 
This plug-in combines several components in one special tool which is ideal for 
working with speech or vocal tracks. Virtually all recurring voice signal edits are 
integrated in a compact, simple interface. 

 

The signal flow is set by the e_FX_VocalStrip and is directly represented by the 
position of the fader. 
 

Vocal Strip Parameter 
IN / OUT: Here you can set the input and output level. 

• highpass: This fader determines the cut-off frequency for a steeply sloped 
highpass filter (24dB/octave) to remove part with low frequencies, such as 
rumbling or noises created when touching the microphone. 



 

 

Audio effects 171 

• gate: With gate you can attenuate the signals that fall below the threshold. Here, 
a smooth curve and a maximum 'softening' of up to 24dB is used to avoid hard 
transitions. 

• DeEsser: The effect is very similar to that of the eFX_DeEsser. Here, however, 
the application frequency is set. The filter used in eFX_VocalStrip works in 
another range. The fader determines the degree of reduction. 

• compression: For the most part, an eFX_Compressor component contributes to 
working parameters for optimizing voice recordings. The further the fader is 
turned the lower the threshold and higher the compression ratio. The Attack and 
Release times are selected according to the program.  

• tone: This EQ corresponds principally to the filter network, which is also used in 
the eFX_TubeStage plug-in. With this you can simply and effectively calibrate 
the sonic balance of the voice signal, e. g. for better integration into the mix. 

Tweak  

• DeEss DetFreq: Determines the frequency of the filter used for detection, and 
filter blocking in the signal route. Typically the sibilants in speech or singing 
voices are in the 6 - 8 kHz range. 

• CompAutoMakeup: The maximum level is retained while overall level is 
reduced. 

• Comp Attack: Here you can determine how fast the compressor responds after 
reaching the threshold. 

• Comp Adapt.Rel.: Rising values cause the compressor to work increasingly with 
"Adaptive Release". This means that the longer and harder the compressor 
intercedes upstream in the signal path, the longer is the resulting release phase.  

 

Note: Detailed information about compressor-specific settings can be found under 
"essentialFX > Compressor > Compressor Parameter". 
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Analogue Modelling Suite AM-Track SE 

 

AM-Track SE is a purely analog compressor simulation. The tape simulation 
contained in the full version (Analog Modeling Suite AM-Track 
http://pro.magix.com/de/audio-plugins/analogue-modelling-suite.175.html) is not 
included. This is used primarily for so-called "tracking", i.e. editing individual channel 
strips or subgroup signals. The compression takes place in the "vintage" setting, 
whereas an additional "vca" setting is available in the full version. The plug-in 
recognizes the number of incoming signals and, if necessary, edits the signal in mono. 

Am-Track SE limitations compared to the full version: 

• No tape simulation  
• No "VCA" mode in the compressor, only "Vintage" operation can be 

implemented along with the presets. 
• Some expert compression settings (view page 177) are integrated in the 

interface, parameters: "ahead" (pre-delay) and "adapt release" (switchable 
release automation) are missing. 

(Release automation is always activated in the SE version which corresponds to the 
set value of the mid position of the 'capacity' controller.) 

Below, the full version of AM-Track is explained and its features compared to 
"normal" software compressors and the available parameters. 
 

Compressor Section 
Two completely different compressors work in AM-Track, each with their own 
independent control and sound methods. 

You may be wondering why we mention sound when talking about a compressor, 
since compressors merely relate to control actions. This isn't as simple as the idea of 
"making loud quiet".  

Various designs, algorithms, and topologies for solving the actual problem (dynamic 
reduction), which all have their own unique character, have come from the history of 

http://pro.magix.com/de/audio-plugins/analogue-modelling-suite.175.html
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analog and digital signal processing. For example, pre-filtering in the detector circle 
and the type of detection have a large influence on the audio results. Plenty of 
hardware compressors have the same established VCAs (voltage controlled 
amplifier), but they all sound different and influence a signal, an entire production (or 
even a genre) with their "signature sound". We intend to provide you with acoustic 
variation via these dynamic tools in the digital world. 

The two operating modes of the AM-Track may be selected using the switch 
"vca/vintage": 
 

VINTAGE mode 

 

This mode appears as a preset on start-up of the AM-track. It has fewer 
parameters than the VCA mode and has audibly less of a "surgical" quality, 
but more of a trimmed sound character. 

"Vintage" mode simulates a circuit design from the time when VCAs were not yet or 
could not be fully implemented. Instead, a FET (field effect transistor) was often used 
as a controllable resistor. Together with constant resistance at the circuit's gate, this 
forms a so-called voltage splitter, which is to say  it forms a resistance change at the 
FET (caused by a change in voltage at its gate) which results in a damping of the input 
signal. A very simple detector circuit is used to activate the FET which obtains its 
signal from the output of the compressor (behind the whole control circuit). For older 
designs, this feedback loop provides a stabilization of the work parameters and is one 
of the decisive factors for the often quoted soft and musical compression of 
exponents of this design, e.g. the Urei 1176 or 1178. The control circuit sees the layout 
of its previous work and oscillates to the signal. 

 

The disadvantage is that the set time parameters for attack and release depend 
somewhat on the program. In some cases,  it's actually advantageous for vocals, bass, 
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or even drums (e.g.  subgroup, ambience, mics). You should rely completely on your 
ear for this. 

Because of the feedback topology, the maximum gain reduction is usually lower than 
 VCA devices with forwards detection, usually  20  dB. This way, there is almost 
always a level matching amplifier in the feedback loop. The "drive" controller of the 
AM-Track regulates the feedback amplification here. This can be so high that the 
detector may become saturated by a loud input signal, resulting in signal peaks being 
swallowed up. Simultaneously, the setting becomes more intense as quieter signals 
also start reaching the threshold. You can creatively implement this according to the 
situation to create complex signal compression which doesn't much sound like 
dynamic compression due to the transients that slip through and release at high 
"drive" levels. 

The stated release of the signal, technically known as a ratio reduction, is also caused 
by the centerpiece of the circuitry: the FET. Level reduction works entirely as a 
function of its characteristic curve, resulting from the non-linear behavior of this 
element. The FET virtually comprises part of the input resistance of the compressor 
circuit. As a result, the input/output response curve does not create a plateau when 
"drive" is high, which would be the case for a reference line featuring a high ratio or 
even limiting. A saturated FET may no longer complete the job it was marked out to 
do, i.e. to keep its output at low Ohmic values. Once again, signal peaks pass through 
the entire circuit unaffected, but the average level could be severely compressed. 
From a technical point of view, the control process appears incomplete, but sounds 
pleasantly open and airy depending on its application.  

The entire detection is dependent on the spectral balance in the virtual AM-track 
circuit, the highs are automatically compressed less so that even extreme settings 
sound less flat and more lively. 

It's the same story with deep bass. On closer listening, you'll find that with strong 
compression the signal still retains its power which would otherwise be lost if the 
envelope were to follow shortly afterwards. 

"Vintage" mode has another feature to offer: At the output of the compressor in the 
signal path, an emulation of a transformer-coupled matching-level amplifier can be 
found. This contributes to some subtle, non-linear distortions at high levels, but is 
very much frequency-dependent. 
 

VCA Mode 

 

In VCA mode, the parameter selection and the circuitry design 
correspond to a modern compressor with a VCA element as the control 
circuit and a forward automatic gain control in the detector section 
("feed-forward design", i.e. the controlling signal for level reduction is 
taken from the input signal). 
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The typical basic sound for this category is accurate, largely neutral and, in relation to 
the adjustable parameters, easily predictable. 

In VCA mode, the control signal is accessed at the input where it firstly executes a 
controllable low-cut (which may be set up via  "detector hp freq" in "Expert" mode). 
The filter makes sure that deep-frequency signals have less influence on the 
adjustment settings; this is a popular trick for more power, e.g., when using drums in a 
sub-group.  

The filtered signal then arrives at the detector. With the forward gain control, 
previously set parameters apply fully and affect the adjustment settings immediately. 

 

In contrast to this, there is a "feedback" method which provides a second compressor 
mode. 
 

Compression Parameters 
Vintage Mode 
In this mode, you can intuitively (by ear) use the dynamic editing features with just 
three knobs. Do whatever you want, but keep in mind: less is sometimes more... 

• Drive: You can use the "drive" potentiometer to control the amplification factor 
in the feedback loop, i.e. the signal strength which the detection circuit 
calculates. Furthermore, the internal "ratio" changes within a limit, the more 
"drive" there is, the higher the compression ratio. 

• Attack and release: The same basic conditions as VCA mode apply here. 
However, not only do you change the actual control response time after 
detection, but the "temporal window" in the detector must be adjusted as well. 
Additionally, the feedback method does cause a certain amount of 
unpredictability. You should expect less control over the device in this mode, but 
more leniency on its part.  
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VCA Mode 
The regular set of parameters of dynamic compressors is available in this mode: 

• Threshold: The threshold above which dynamic reduction begins. 
• Check the threshold display if necessary (thr): If the input signal reaches the set 

threshold, the blue dash will move around the arrow symbols. If this dash moves 
upwards, the threshold is below the average level and compression is active. 
Inversely, if the dash moves below the marking, the input signal becomes too 
quiet to be able to reach the threshold; compression will be applied. 

• Ratio: This ratio (1:n) specifies by which factor the signal should be reduced 
once the threshold has been reached. For example, if the threshold is set to -20 
dB and the ratio to 1:4, an input signal of -10 dB will only be amplified by 2.5 dB 
(10 dB : 4 = 2.5 dB). 

• Attack: This is the response time, e.g. how long the project takes to execute the 
required level reduction. Short attack times intercept level peaks, and longer 
ones let them through unimpeded (compression only starts past this value). 

• Release: This is the time allocated to the circuit to reach the normal 
amplification factor. 

Note on attack & release: In general, short attacks are used for moderate 
compression and making the transient response softer; longer times retain the "bite" 
of a specific instrument at larger compression rates or make the sound a bit 
snappier. With more difficult sources, like a very dynamic vocal track (ballads), for 
example, you can use a longer attack so that the project runs more smoothly and 
quietly; the release time may be trimmed audibly to match the pauses or the song 
speed. 

Shorter release time may be used for modern, aggressive "close up" vocals, e.g. 
when breathing sounds are an important stylistic device and the voice should sound 
very full and compact. 

• Knee: Use this parameter to specify the shape of the characteristic around the 
threshold. A "hard knee" means that the transition of 1:1 amplification for level 
reduction occurs abruptly; a "soft knee" on the other hand starts much lower 
than the threshold and moves the characteristic softly into the reduction. A 
"hard" setting is useful for effect-filled, acoustic compression, e.g. individual 
drum tracks. A softer setting is useful for complex and sensitive sources like 
guitars, pianos, or vocals. The more complex the signal, the easier it will be to 
notice a difference. For less sensitive sources, this parameter is usually less 
important. Note that for "soft knee" settings, the "threshold" value will need to 
be re-adjusted, since the compression starts at a much lower level. 
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Compression Expert Settings 
Of course, you can efficiently compress a lot of data with AM-Track without having to 
press the "Expert" button or try out additional options. However, we have added a few 
"handy" parameters behind the front panel. This applies equally to both compression 
modes. 

 
• Look ahead: AM-Track is always ahead of the signal. You can specify how many 

milliseconds you want to "look ahead". The audio signal path is delayed 
according to the signal route so that the detection circuit is fed first with the 
input signal (so-called "look-ahead delay"). You can increase the attack time 
and still avoid fast peaks. The latency compensation in the host program ensures 
that other tracks in the project are adjusted and that no time delay occurs. For 
percussive signals, you can even set the delay all the way to "0". 

• Detector hp filter: This high-cut filter is positioned before the two compressors' 
detection circuit. You can use it to specifically exclude basses and mids from 
these rules. Complex signals with bass and hi information like a subgroup or 
complete mixdown produce fewer "pumping" artifacts. This is because low-
frequency signals feature the most power and therefore always trigger 
regulation and modulate other frequency ranges in the volume 

• Auto makeup gain: Normally, you have to continuously adjust level reduction to 
generate "compression" at the same maximum level. This is done by activating 
auto makeup gain. The volume difference expected from the set working 
parameters is determined and applied as an output factor after master 
regulation. If you prefer to adjust the "classic" level reduction and amplification 
manually, you can deactivate this function. 

• Adaptive release: This is "semi-automatic", i.e. you can roughly adjust the 
release time, and AM-Track reduces it according to the current signal power 
from "a little (1%)" to "considerably slower (100%)". In "Vintage" mode, this 
regulation method is particularly intense, since it affects the feedback loop 
process. For instance, if you are editing vocal tracks or dense, complex material, 
it can sound "calmer" or more "musical" if adaptive release is activated. 

• Capacity: Adjusting the "capacity" controller sets the time response of the 
"adaptive release". The greater the capacity, the more sluggish the release 
adjustment. You can therefore influence larger parts of the compensation 
response. For instance, if you want to use vocals that have been "moved 
forward", you should use a short release time (maybe 80-100 ms) and a greater 
value for semi-automatic (e.g. 80). Vice versa, you can reduce automatic feed 
by switching the relation (smaller capacity, generally greater release time). 

• Comp mix: Parallel compression is a popular "studio trick", particularly with 
complex material. Adding the original signal retains the transients and spectral 
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balance of the source. You can add compression by turning the mix controller. A 
mixed signal is particularly discreet, more transparent, and less "squishy" with 
vocals, whereby the compressed portion usually has a higher level reduction 
than without adding the original. 

 

Vintage Effects Suite 
If you're a guitar, bass or keyboard player, you'll probably recognize the look of our 
new "vintage effects" suite. They are accurate digital models of analog "standard 
effects" used by live musicians. Although we have adopted the appearance of stomp 
boxes and have given these effect a typical analog sound they are ideal for studio use. 

All effects of the Vintage Effects Suite are subject to a soft rule behavior – internally, 
parameters are softly faded from the old to the new value. This is particularly 
noticeable when presets change and is of a particular benefit when playing in live 
mode. 

In the following we will present the effects of this suite and explain how and where to 
use them. 
 

Analog Delay 

 

This delay offers creative playing along with common delay effects. "Analog" in this 
case means, for instance, that you can change the delay times while playing without 
the risk of typical, scratching artefacts developing. Instead, the times are softly faded 
out, similar to the old tape echo machines that used the tape speed to change the 
delay and where the system also had a certain sluggishness.  

"analog" in terms of this delay also means that typical tape echo sounds can be 
mimicked, e.g. tape speed fluctuations and reduced highs during playback 
("feedback"). The feedback has a two-band filter that can be used to create dark, high, 
or mid repetitions depending on the settings.  
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These properties can be useful, for example to create "wild" dub/reggae-style delays 
that move towards the center of the sound with each repetition and even grind 
slightly. In this case, "analog" means that you cannot digitally overdrive the delay. 
Even in a 'looped' repetition, the signal cannot be distorted indefinitely, but it is 
compressed by an increasingly slight degree and distorted similar to a tape. 
 

Analog delay parameter 
Analog delay has the following parameters: 

Delay type 

Delay type (l + r): Left and right delay times can be controlled separately (see below). 
You can choose a note value for the control pots to snap to. Even and syncopated 
note values from 1/2 to 1/32 are available. Note that the delay times are always in 
relation to the project’s current tempo. 

 Link button (lock symbol): Press this button to control the “delay type” pots for 
both channels simultaneously. 

Mix: Adjusts the ration between the original signal and the echo. 

Modulation 

Speed: The tape warble speed. Low values result in very light fluctuations, high values 
result in drastic warbling. 

Depth: The warble intensity. When this control is turned all the way to the left, there 
is no pitch modulation. For a subtle "analog" feel, we recommend a setting between 
the 9 and 11 o’clock position. 

Filter 

"Low" This control progressively reduces the bass frequency as it is turned 
to the right, making the signal sound "thinner". 

"High"  Once turned all the way to the right, the control only attenuates the 
treble very lightly; turned completely to the left, the delay repetitions 
become progressively less treble. 

Feedback 

Width: This controls the stereo width of the delay repetitions. When you turn 
“Width” to the right, an additional effect is produced: the panning of the delays 
increases. This is commonly referred to as a "ping-pong" delay. 
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Drive: When this control is turned all the way to the left, the delayed signal is 
repeated only once. Turned all the way to the right, the feedback is seemingly endless 
and the repetitions continue for a long time.  

The actual strength of the effect is dependent on the material, since the feedback loop 
(as explained earlier) is addressed via compression and uses a "tape saturation" 
effect. If you send a "loud" signal to the delay, then the feedback will sound longer 
than at a lower level as compression "brings it up" to a certain level. If you are used to 
"purely digital" delays, then this might take some getting used to, but it will probably 
sound "livelier". 
 

Flanger 

 

The "Flange" effect is similar to that of the chorus, but does have a different technical 
and historical background. It came about by chance: Someone (various sources say 
John Lennon) slowed down one of two running interconnected tape machines in a 
studio with his hand. The result: The rather brief delay of the second signal compared 
to the first resulted in cancellations within the frequency spectrum, leading to a so-
called comb filter effect (the sum of both signals creates "peaks" and "lows" in the 
spectrum that look familiar to the teeth of a comb).  

Flanging is basically a chorus effect, but it has a lower delay time (less than 10 ms). 
"Release" or signal doubling is not highlighted here; the result is a much more creative 
frequency response deformation.  

A "complete" flange effect will definitely require feedback: The flange portion is 
returned to the input to increase the effect. People often talk about the "jet effect", 
since it resembles a jet on take-off. 



 

 

Audio effects 181 
 

Flanger parameters 
Speed: Modulation speed. 

Depth: The overall amount of modulation. 

Feedback: The volume of the internal feedback loop. 

Mode:  

Normal: Flanging. 

Dual: Two parts, panned left and right.  

Quad: Four parts, alternately panned left and right. 

Quad pan: Like “Quad”, but the “Depth” control also sets the intensity of the signal’s 
pan movements between left and right. 
 

Filter 

 

"Filter" is a "modulation" effect like chorus and flanger. However, it controls the 
frequency response of a modulation source as well as the pitch. There are various 
filter types and modulation sizes available for this.  

Possible areas of application are synthesizer sounds (filter sweeps on pads) or 
creative distortions of drumloops (e.g. for variations, fills, etc). With guitars you can 
create typical 'wah' effects: either by tempo modulation or in a special mode, 
modulation via the envelope curve. The decisive factor is the current signal strength 
above the frequency set for the filter. 
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Filter parameters 
Speed: The modulation speed is set by note values ranging from 1/1 to 1/16 (even or 
dotted). Similar to analog delay, the tempo information is automatically provided by 
the project.  

A peculiarity of the final position of the controller:  

Tempo synchronization stops and modulation is controlled via the signal level. 

Freq: This is the base frequency for modulating the filter, and generally takes place 
above this frequency, i.e. the modulation increases the filter frequency. 

Depth: This control determines the modulation depth, i.e. the amount by which the 
speed control (or envelope mode, as described above) increases the base frequency. 
For extreme effects, turn “Freq” all the way to the left and “Depth” all the way to the 
right. 

Filter modes 

Low-pass A filter with a slope of 24 dB/octave and a small amount of 
resonance. The treble frequencies above the base frequency 
(cut-off frequency) are filtered steeply. This is great for 
filter sweeps on synth pads and drum loops. 

Band-pass Only the frequencies around the base frequency are passed 
through the filter (24 dB slope with resonance). Use this 
mode to create wah-wah effects for guitars. 

Band 
elimination 
(„Notch-Filter") 

Two parallel filters (–36 dB) with linked base frequencies 
create two ‘notches’ in the frequency spectrum. This allows 
you to create interesting sounds (e.g. guitar chords), and it 
sounds similar to a phaser. 

High-pass This mode achieves the opposite effect to the low-pass 
filter. Frequencies below the base frequency are filtered 
steeply. If you ‘thin out’ sections of your track (for example, 
a drum track) with a tempo-based modulation, this can 
sound very effective when contrasted with the full-range 
frequency spectrum (for example, if the filter is turned off 
for the next object). 
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Chorus 

 

The chorus pedal creates characteristic "floating" sounds which one typically 
recognizes from guitar or synth pads. You can add acoustic "depth" to an instrument 
to add more power to the sound or to create the illusion that it exists multiple times.  

The chorus sound is created by using the so-called Doppler effect. You probably have 
noticed this phenomenon daily life: The sound of an approaching ambulance sounds 
higher than when it is moving away. This effect is a result of the speed of the sound 
which first increases and then decreases, thus also changing the sound pitch. If there 
were a second siren at your location, an oscillation would develop between both 
sounds (just like when two instruments are out of tune). 

Chorus also splits the signal in at least two: direct sound and effects part. The double 
effect is created by a short signal delay of the effect.  

This delay is within the range of 10-30 ms (as in this one), this means that it is short 
enough to be perceived as an "echo". The times would also be similarly short if you 
were to double a guitar track for instance. A short delay in the mix already sounds 
"doubled" but is not authentic. This is where the above-mentioned "out-of-tune" 
effect comes in: The pitch of the effect signal is slightly modulated by gently "drifting" 
forward and backward in the delay curve. The result is a floating effect where the 
speed is influenced by drifting 
 

Chorus parameters 
You can enter the following parameters to control the floating effect: 

Speed: Modulation speed. Low speeds create an even, continuous development. High 
speeds produce vibrato-like qualities, but can also result in an "underwater" effect. 

Depth: Modulation depth. This determines how strongly the speed affects the pitch 
modulation.  
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Mix: This sets the balance between the direct signal and the effects signal.  

Mode: You can choose between four operating modes of the chorus effect:  

“Normal” is a combination of the direct signal and the detuned delay signal.  

“Normal, low-pass” is designed for bass-heavy signals like bass guitar. The bottom 
end of the signal stays clear and well-defined, the effect is only audible for the mid 
and treble frequencies.  

“Dual” makes the source sound more lively than a single "part". The sound is spread 
over the stereo panorama, which makes this mode seem "wider". The character of the 
sound becomes livelier than with a single voice only, and it is also distributed over the 
stereo panorama, making the mode sound "broader". 

“Quad, low-pass” is ideal for creating sounds such as deep synth pads with tight bass 
frequencies. 

Tip: Similar to the stomp boxes our vintage effects are modeled on, there is a 
"footswitch" below the pedal’s logo that can be clicked to turn the effect on or off for 
A/B comparisons. All the effects of the Vintage Effects Suite have been designed 
like this. 

 

Distortion 

  

The distortion pedal is a "high gain" distorter for crunch and lead guitar sounds. If you 
like typically "British" amp sounds and want to quickly record a guitar track with little 
effort, this pedal is for you. 

An entire valve pre-amp circuit has been modeled, including the typical EQ curve. The 
amplification is "valve-typical", i.e. it doesn't start quickly but is harmonic and soft. 
Even at full power the pedal still reacts softly to a guitar and its settings (e.g. pick-up 
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choice and tone controller). For instance, you can influence the distortion even more 
by using the volume knob on the guitar. 

There are only three parameters on this effect; however, these interact with each 
other and can thus generate quite a variable sound: 

• Low: The "bass" controller. This allows you to set the share of basses, even after 
the distortion. The type of prefiltering is important for guitar amps in particular, 
and is characteristic for the basic sound. You should set the bass controller 
depending on the basic sound of the guitar and the sound you are aiming for 
("powerful" or "cut"). 

• High: Mainly controls the share of highs before and after the distortion. If you 
are not using an external guitar speaker as a monitor, we recommend setting the 
controller to the middle position or even moving it slightly to the right. This way 
the "sharp" highs disappear, which all guitar amps generate without the suitable 
loudspeaker. At the same time the mids stand out more, which gives the sound 
more "kick". On the other hand you can further emphasize the highs if you want 
the sound to be more neutral.  

• Drive: The level of distortion. This controls the amplification used to operate the 
"virtual valve circuit" (max. 60 dB). As the level increases, the valve goes into 
overdrive and generates typical distortions. For a slightly distorted sound 
("crunch"), it's sufficient to set the controller to 10-11 hours at maximum; the 
modeled circuit also provides the usual "weight" for power rock chords, and 
more. The further you turn this controller to the right, the more the mids of the 
signal move to the fore so that the "high-gain" lead sound is better heard.  

You can also use the distortion effect in combination with the amp simulation! 
 

BitMachine 

 

Audio material can always be edited into high quality with MAGIX Music Maker 
Premium Steam Edition. Nevertheless, there are some situations, for example, a more 
imperfect lo-fi sound would perfectly suit a drum loop or a synthesizer sound. 

Remember, for example, the first hardware samplers from the 80s that usually only 
ran at 8 or 12-bit rates and at low sample rates. With the BitMachine, changing the 
sound with such an "antique" device is no problem. 
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You can use the BitMachine to bring back to life the times when minimalist and 
scratchy soundchips in home computers were commonplace. 

The BitMachine opens up a gateway to "acoustic time travel" where you can 
encounter bit and sample rate reduction and downstream filters based on analog 
models.  

Furthermore, the effect has a modulation section with which you can control 
individual parameters using an oscillator (LFO) or the input signal.  

We have designed a range of "typical" presets to demonstrate the time travel abilities 
of the BitMachine. These can be opened at the top right of the interface 

The following section describes the details of BitMachine: 
 

"Reduction" section 
Bits 

This dial controls the resolution of the audio material. Turning the dial to the left 
results in 16-bit quantization (CD quality). The further it is turned to the right, the 
lesser the signal dynamic becomes. In extreme cases (1-bit), there are only "on“ or 
"off“ states.  

At the intermediate levels, you’ll notice an increase in the background noise and a 
decrease in the dynamics. For example, 8-bit quantization will exhibit dynamics of 
only 48 dB. Quieter points in the material sound noisy and very quiet points sound 
"capped“. This effect is amplified the more you turn the dial to the left until it starts 
crackling or "groaning". 

Sample rate 

The audio material is "down-calculated" with this dial, i.e. the internal sample rate is 
reduced. A new separation ratio between old and new rates is created. In relation to 
this ratio, a sample from the data stream will be "dropped“ at the various points. 

Note: The two smaller dials from this section are explained under Modulation. 
 

"Filter" section 
The filter in the BitMachine is a digital model of one of the most well-known filters in 
music electronics, i.e. the "Chamberlin 2-pole" filter used in old Oberheim 
synthesizers. These types of filters sound exceptionally musical. They can also be 
used quite creatively in the BitMachine, but should not be used exclusively to smooth 
out existing artifacts.  
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The filter works in the so-called "high-pass" mode, i.e. it lets through deep frequency 
(or medium) material according to setting, and dampens highs and medium areas. 

Freq: 

You can specify the cut-off frequency of the filter using "Freq". Filtering starts above 
this frequency. 

Reso: 

The signal in the area around the cut-off frequency can be strongly elevated to just 
below self-oscillation. Sharp, cutting sounds are possible at this level, and the effect 
becomes even clearer when you vary the cut-off frequency. 

Drive: 

Both of the individual filters of the connections mentioned above have the ability to 
overmodulate themselves internally. With the "Drive“ dial, you can regulate the 
amount of overmodulation. The more you turn this dial up, the more the signal is 
overmodulated. In this case, the parameters of the internal workings of the filter 
interact with one another. Increasing drive weakens the resonance, but, at the same 
time, the signal gets more volume, more bass and becomes acoustically fuller.  

Note: The two smaller dials from this section are explained under "Modulation". 
 

"Modulation" section 
You can automate your effects via the settings in the modulation section. 

Here, you’ll find the so-called low frequency oscillator (LFO), which resonates with 
adjustable speed. You can influence the speed and type of resonance. 

To influence the resonance, use the two small dials in both the reduction and filter 
areas. These four dials display modulation targets.  

Example: You’ve left the dial for the sample rate at its default setting. Change the 
small dial beneath from its middle position to either side. The modulation for the dial 
value is added to the sample rate: The LFO now controls these parameters 
proportionately and the sample rate reduction resonates at this modulation. 

You can use this technique on other dials as well. You just have to make sure that the 
main dial isn’t turned up to full, because then the modulation wouldn’t have any 
effect. The modulation is always added to the set value. 

Example: Turn the small dial beneath the "bits" dial fully to the left (Value: -50) and 
the one beside it (beneath "sample rate") to the right (+50). You’ve now assigned a 



 

188   

www.magix.com 

modulation to both parameters with the LFO. They are not changed uniformly, but 
rather opposite to one another: A negative setting is nothing more than an inversion 
of the modulation, so you’re effectively turning down the control signal. 

Waveforms of the modulation section 

We’ve already explained this example with the help of sine oscillation. The LFO can 
be in: 

• Sine form 
• Square wave (0 or 1, no intermediate level) 
• Random value (an internal randomizer will be queried at the set speed) 

Oscillator speed 

The LFO speed is specified with the "speed“ dial. If the "sync“ button is active, then 
the LFO adapts to the song speed, and the dial locks musical values into place (e.g. ¼ 
note). Rhythmic paths of the sound distortion are therefore enabled. You can also 
switch off this synchronization and set the speed manually (in Hz).  

Modulation with the "Envelope follower“ 

In the modulation section you’ll find a fourth button, the audio input signal. If this 
mode is active, then the signal itself can be called upon to extract “modulation 
tension”; a so-called "envelope follower" continuously scans the volume of the input 
signal. 

Note: The BitMachine doesn’t recognize the type of audio signal automatically. For 
this reason, you should set the input sensitivity roughly with the "gain“ dial. To do 
this, use the control LED: With accurate detection of the signal dynamics, assigning 
the four small dials to modulation lows is easier and you can use the full control 
range.  

In envelope mode, the "speed“ dial is used to control the response speed of the 
envelope (the display now switches to milliseconds). Lower times result in a faster 
response, higher times make the envelope rise (and fall) slower. You should 
experiment with the signal according to its complexity. The presets provided can only 
point you in a rough direction. 
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Vandal SE 

 

Virtual Guitar & Bass Amplification 

VANDAL is a complete simulation suite for guitarists and bassists. The plug-in is 
capable of simulating the entire signal chain, from input to stomp boxes, amplifiers, 
microphone loudspeaker boxes and post-processing studio effects, all in top quality. 
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Quick start via preset selection 
Would you like to know about everything that's possible with Vandal SE? Play 
yourself or use some of the presets. These are available via the list in the upper edge 
of the interface.  

A preset includes all settings for the main elements of Vandal SE: Stomps, amp 
settings, cabinet simulation, and studio effects. 

 
 

Tuner 
The best amp or the best simulation is useless if the guitar is out of tune. VANDAL 
offers its own chromatic tuning device for this. You can use it like any analog device: It 
automatically displays the note that has been struck (in octave) and the display 
visualizes deviations (in cents). 

 

The following describes the major components of VANDAL. The stations are 
described according to their position in the signal chain. 
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Input 
The station that you will most likely want to activate first is the input controller. Just 
like with a genuine guitar or bass setup, it's important to ensure the highest possible 
input level, in order to work optimally. This is even more important for distorted 
sounds and natural high-gain playing styles. Use metering  for this, too.  
As required, activate the noise gate and adjust it so that it lightly suppresses the input 
signal during pauses in playing. VANDAL does not cut the input on classic gates too 
hard, but rather regulates them finely via the signal energy beginning at the highs 
(where noise is most audible). 

 
 

Stomp boxes 
The real world has produced a series of effect devices popular with guitarists and 
bassists in the "stomp box" format. We've also included a rich palette of these 
devices. Vandal SE includes four "stomp slots" that can be equipped with effects from 
the list. The signal flow within this chain runs from left to right. Since all of the 
controls are self-explanatory, we won't describe them here. 

 
 

Vandal - Amplifier 
Vandal SE basically offers 2 different amplifiers: Guitar Amp and Bass Amp. The 
amplifier type depends on the selected preset. 

During development, a large selection of famous amplifier brands and models were 
not included. To guarantee that you are nevertheless able to get a number of different 
sound characteristics out of your Vandal SE amp, the amplifiers are set up variably. 
Internally, circuit designs work absolutely the same as the real devices. In several 
ways, however, Vandal SE goes in its own direction in terms of the sound it offers. 
 

Guitar amp 
The Vandal SE guitar amp offers three different pre-amp modes and two switchable 
end stage models. These basic configurations differ according to the selected preset.  
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The guitar amp is set up with three channels. These may be set up with the pre and 
post gain controllers per channel (Clean, Crunch, and Lead) for the desired mix ratio. 
Don't worry about switching things around: The amplifier will remember the gain 
settings when channels are changed. These are the gain presets for the different 
playing styles within a song. 

 

Voicing: We have provided Vandal SE pre-amps with something that we call Curve 
EQ. For example, if you take a simple EQ pedal and shape the signal a little before the 
amp, then this may change the sound quite drastically. Curve EQ does something 
similar: It's located (in some cases multiply) at strategically important points between 
individual amplifier stages and filters the signal, before it is distorted by the next 
stage. Move the curve in both directions and navigate through the spectrum using the 
"Freq" controller. This will give the amp a completely different character... 

Equalization: The actual sound control (the "tone stack") functions rather 
conventionally: Vandal SE offers low, mid & high settings. Everything functions like 
the passive sound regulation network in genuine amps, so that the controllers 
influence each other to produce numerous variations. 

Reverb: Surf and twang simply need on-board spring reverb. We relied on well-known 
reverb springs for modeling. Everything sounds natural with complete authenticity. 
 

Bass amp 

 

After roughly setting the Gain controller, the bass signal will first be treated with the 
Contour circuit. This filtering stage works similarly to the "Loudness" function by 
cutting the (lower) mids and lifting the deep bass and highs. It's sort of like an "instant 
slap". 

Next, the signal passes through the compressor stage (Comp). This is a simple but 
extremely musical, visual design: The bass triggers a light source that is coupled with 
a photo resistor which dampens the signal. This may already be familiar to you from 
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the most famous studio compressor for bassists, i.e. Urei LA2A, which functions 
according to the same principle. 

After any possible compression, Drive provides the option to take the bass sound to 
the next level. Saturating the signal takes place depending on the frequency: In spite 
of a possibly high level of distortion, the basses remain relatively clean and contoured. 

The equalization stage offers 4 frequency ranges, whereby the two mid bands are 
variable. The final master volume controller specifies the volume of the final stage. As 
with the guitar amp, the end tubes are also engaged in this case as much as remains 
sensible. 
 

Rack effects (FX1/FX2) 
There are effects that don't always work well before the amp, e.g. reverb or delay, 
especially when they are distorted. Normally, these effects are better placed at the 
end of the signal chain. 

For final processing and enriching, we offer two separate studio-quality effects units 
just like real 19" rack devices. 

Many algorithms create a stereo signal. Take care that the sequencer track operates 
the duct in "stereo" mode. 

 

Effects units may be selectively operated one behind the other (serial) or parallel. 
Switching may be changed via the mode switch. 

The following algorithms & effects are available: 

• Mono delay (msec & tempo sync): Possibly a simple delay with free selection of 
delay time or synched to the sequencer tempo with a musical raster. In case of 
high feedback values, a reduction of the damping frequency is required to 
provide naturalness to echoes. 

• Stereo delay (msec & tempo sync): Like mono delay; features two models. 
Repetitions may take place on separate channels (feedback controller to the 
right: dual delay) or in ping-pong mode (controller to the left), whereby the 
signal alternates between the sides.  

• Chorus: Produces a typical "floating/shimmering sound" by modulated detuning 
of a signal to "thicken up" its sound or spread it across the stereo field. Detuning 
is achieved by a short delay, the length of which can be varied by the 
modulation. This produces the so-called "Doppler" effect and broadens the 
signal. 

• Flanger: Algorithmically similar to chorus, but different in that the delay time is 
significantly lower and delay works with repetitions (feedback). A flanger 
sounds more "cutting" and up-front than a chorus. 
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• Phaser: A modulation effect just like chorus & flanger, but in this case no 
detuning takes place. Filter components periodically alter the signal's "phase 
response" (principle of the "phase shifter"). Characteristic notches are produced 
in the frequency spectrum response (comb filter effects). 

• Room reverb/hall reverb: Reverb offers realistic simulation of realistic 
reverberation. Room creates the impression of a small to mid-sized recording 
room, while Hall produces the sound impression of a concert hall. A particular is 
that both effects algorithms provide a modulation parameter, which may remove 
possible resonance at low dosages and can produce a soft chorus effect at 
higher values. 

• LoFi: This algorithm gives the sound a little bit of "grit", or a certain measure of 
signal destruction depending on its setting. Turn down the internal sample rate 
as much as you like to steal a few bits from the sound's resolution. This is 
definitely unconventional... 

• Vintage compressor: Ideal for thickening up the signal a little. The algorithm 
emulates an older popular circuit design that is similar to studio legends like the 
Urei 1176 or simple compressor pedals. A so-called "FET building block" controls 
the volume via the input level simply, effectively, and quite musically, as well as 
the set compression ratio and the attack and release. 

• 3-band EQ: This sound controller works like a conventional mixer with controller 
for bass, highs, and two controllers for the (variable) mids. This adds the final 
polish to your sound. 
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Video and Bitmap Objects 

Video and bitmap formats 
MAGIX Music Maker Premium Steam Edition can load and export videos in the 
following formats: AVI, Windows Media (*.wmv, *.asf), MAGIX Video (*.mxv) and 
Quicktime Movie (*.mov). Graphics can be loaded and exported in BMP and JPEG 
formats. Also RTF text files can be loaded and used as subtitles. On the content media 
you will find the included image and video files. You can also use your own files or 
even record your own videos (only in the Live & Premium version). 
 

Video monitor 

 

The video monitor can be opened by clicking on this button or 
pressing the F3 key. 

 

Both video monitors can even be positioned 
freely on the screen and adjusted for size. To 
adjust the size, right-click on the monitor screen 
and select the size you want in the context menu 
or make your own (user-defined). Please note 
that larger video monitors require more 
computing power. 

The video monitor's size can be increased to the full size of the screen by double-
clicking on the video monitor or by pressing Alt-Enter. You can end fullscreen by 
pressing Escape (Esc). Apart from the video monitor size, you can also add a large 
time display on the video monitor. Select “display play time” in the context menu and 
the current playback marker position is displayed on the video monitor. Foreground 
color, background color and transparency are selectable 
 

Audio peakmeter 

 
The video monitor is transformed into an analyzer which displays the 
sound as a graphic. 

 

Shortcut:   Shift + F4 
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Overview 
In the Overview mode, you can view the whole project and you are 
also able to access any object you want in a split second; zoom in 
directly to the video monitor or move around the clip displayed in the 
arranger. 

 

Shortcut:   Shift + F2 
 

Infobox 

 
The InfoBox mode shows help text in the preview monitor if you hold 
the mouse pointer over a button on the screen. 

Shortcut:   Shift + F1 
 

Loading and editing videos and bitmaps 
Video and image objects can be loaded and edited just like other objects. In order for 
you not having to decide which file is to be loaded, you can use the preview function 
on the video monitor. Simply click on a video or graphics file in the Media Pool: The 
corresponding video or graphic is displayed or played in the video monitor.  

• Via the context menu (right mouse-click into the list) you can choose between 
different views ("List", "Details", "Large symbols"). In the "Large Symbols" view 
the videos are displayed with a preview frame – very useful to preview the 
available images.  

• If you want to use the video for your project, drag the video or bitmap file onto a 
track in the arranger while holding the mouse key. During playback in the 
arranger, the entire video and image material on all tracks, including all effects, is 
played back in real-time.  

• Video and image objects can be edited in the same manner as other objects: 
You can touch and move them with the mouse, fade them in or out with the 
handles at the top corners, or change their brightness with the middle handle, 
etc. Please also read the chapter "Arranging objects (view page 56)". 

 

Simplify object presentation 
With the TAB key you can switch between two object presentations. The objects in 
the alternative presentation are not displayed frame by frame in the arranger, but in 
simplified form. This saves working memory and improves overall play performance. 
Scrolling and zooming in the arranger as wee as various object manipulations are far 
quicker in TAB mode. The video display in the video monitor is not influenced by the 
simplified object display. 
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Video scrubbing 
The scrub mouse mode is particularly useful for quickly finding certain positions 
within a video. To do this, activate the scrubb mode in the mouse mode bar and drag 
the mouse pointer over a video object while holding down the mouse key. The video is 
played back according to the speed and position of the mouse, including all effects. 
 

Extract sound from videos 
Video with sound material appears in the project window on two tracks as two 
objects (an audio object and a video object). The two objects automatically form a 
group. 

To edit the video and audio material separately from one another, the objects can be 
separated with the Ungroup (view page 253) function in the "Edit" menu or button in 
the project window. Now you can replace the audio or the video track, or process 
each file separately. Rejoin/regroup the tracks with the ”Export project” function. 
 

Video effects 
All video effects work in real time. In principle, almost any combination of effects may 
be assigned to any video or image object: For example, mix mode stanzas with a false 
color effect. 

By overlaying of multiple videos or bitmaps, MAGIX Music Maker Premium Steam 
Edition proceeds from the bottom up. The background video object must be placed in 
the upper track. It will be overlaid by and mixed with objects lying below. 

Example, if you want to put a dancer on a landscape, place the landscape on track 1, 
the dancer on track 2 and activate the Blue Screen effect for the dancer. 

Video effects are stored in the ”Video FX” directory. Open the directory by clicking 
"Templates" in the Media Pool. All video effects have a preview function and can be 
dragged & dropped on a video object into the Arranger. 
 

Title Editor 
Text objects and title presets 
MAGIX Music Maker Premium Steam Edition has an option for inserting and editing 
titles. These can be things like animated text in music videos to indicate the artist and 
song or opening and closing credits. 

The title templates ("Title" button in the Media Pool in the "Templates" tab) offer a 
good basis for creating titles. To add a title to your project, proceed as follows: 
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• Select a template. As usual, a simple click generates a preview in the video 
window. This lets you see what the title will look like like in the video. 

• Once you’ve found the right title, drag & drop it onto a track in the arranger. This 
will create a title object at that position. Several title templates (e.g. YouTube 
templates) contain additional image objects and require two tracks. 

• The title editor (see  below) opens automatically. You can customize the text 
here. Clicking on "OK" closes the title editor.  

• As with all other objects in Music Maker, title objects can also be edited. They 
can be moved freely in the arranger, faded in or out, shortened or extended.  

• To open a title object again simply double-click on it or open the context menu 
with a right-click and select the option "Title Editor". 

Title Editor 

 

Enter text, e.g. for subtitles or opening and closing credits. Texts can be displayed in 
all of the installed fonts and colors. 

Presets: The list on the left continas the title templates from the title folder in the 
Media Pool. This way you can try out different movements, effects and designs. The 
presets are arranged in various subfolders; the icon and the description will help you 
find the template you want.  

Save as template: You can save all the settings as a title template. You can then easily 
drag & drop them from the Media Pool. 
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Text/Position: Type the text for your video subtitles in the title editor. Use the 
scrollbar to the left and above the text window to organize your text in the video 
monitor. You can freely position the writing vertically and horizontally. If you have 
selected moving text, this position determines the starting position. Please note that 
setting movement to text places the starting position of the title outside of the video 
window. You can, however, always change the starting position. 

Font: Here you can enter the font style, size, color and type.  

Color: With this button you can choose your own color. If you want to format 
individual words or letters, select them with the mouse and choose a different format. 
If no selection is made, the entire text will be formatted. 

Alignment: Specifies whether the title should be aligned left, right or at the center. 

Center Position: Clicking on “Center Position“ puts the title back in the middle. 

Preview: This button starts the title preview in the video monitor together with the 
project. If you have selected a movement for the title, it will also be animated in the 
video preview window. You can interrupt the preview anytime by pressing "Stop". 

Length: Sets the duration of how long you would like to display the title. (You can also 
adjust the length of the title object directly in the arranger by dragging the lower 
handles to shorten or extend it) 

Text Effects: This function allows you to add motion, shadows, and 3D effects, or a 
border. These settings can be adjusted in detail in the "Advanced" section. 

Delete Title: Closes the title editor and removes the title object. 

Arrow Buttons: If there are several title objects on a track, you can use the arrow 
buttons to switch between the these objects without having to close the editor. 

OK: Changes are applied and the title editor is closed. 

Apply to All: The settings in the title editor (font, color, effects etc.) are applied to all 
title objects. The text in each title object remains intact during this process. 

If everything is as it should be, close the title editor by pressing "OK". 
 

Video recording 
MAGIX Music Maker Premium Steam Edition can be used with USB cameras, graphic 
cards, TV cards, or video cards. Video recorders or other devices are connected to the 
video input of the video card, TV card or graphic card (either with RCA or S-VHS 
)connectors. If your card also has audio ports, these should be used for capturing and 
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playing back sound so that the image and sound do not go out of sync during a 
lengthy video. 

To record from analog sources: 

• Select "Import > Video Recording" in the "File" menu. 
• In the video recording dialog select the appropriate driver for your video and 

audio cards (if you have more than one installed). A video preview window is 
now displayed. 

• Name your recording. Choose an appropriate name. 
• Then select the recording quality in the "Recording Quality" menu. The default is 

set to the highest quality possible that your system can handle. 
• Start recording by pressing the red record button and end it by pressing the stop 

button. Play close attention to the "dropped frames" display. If this number gets 
too high, e. g. 10 frames per minute or more, reduce the recording quality to 
prevent your PC from becoming overloaded. 

• Click "OK" to end the recording dialog. 
• You can check that everything works as it should by pressing the space bar to 

preview your recording. 
 

Video recording dialog 

 

Video/Audio driver: Here you can set up the video card or sound card for recording. 
In practically every case the driver software supplied with the hardware must be 
installed. 

Save movie file as/Save in folder: Here you can enter the title of the movie you want 
to record. You can also select the folder where you want to save your video file. This 
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can be changed via "File menu > Properties > Program settings > System > Path 
settings".  

Record quality: You can choose between various predefined recording qualities in the 
list box according to your computer's processing power and how you wish to use the 
picture material. They are listed in order of picture quality. Using "Configuration" you 
can fine-tune the quality for the selected preset. 

Advanced… – Opens the video driver setting dialog (view page 201). 

Record control: Here you'll find the red record and stop buttons. These start and stop 
recording. 

Preview: On some graphics adapters you can reduce the system lead by deactivating 
the video preview. If you hear an "echo", deactivate the audio preview. 

Recording information: Here statistical details on the recording time, the available 
disk space, the number of recorded "frames" (individual pictures), and "Dropped 
frames". Dropped frames are frames that have been left out because the computer 
processor is too slow for the selected image format and cannot accept all incoming 
frames. 
 

Advanced configurations in the video capturing dialog 
Here you can adjust certain settings for the video recording driver. 

These dialog boxes, so-called “property sheets,” come with the video card drivers. 
These driver-specific performance properties may deviate depending on the cards. 
We also have a very limited influence on the behavior of these drivers. If you 
encounter any difficulties, please contact the video card manufacturer for the latest 
driver updates. 

Source: Sets the crossbar of the video card. 

The crossbar determines which video and audio input signal will be recorded. The 
crossbars are connected in series to the video recording chip itself. In the output field, 
the video output (for the crossbars) is the input for the recording chip (video or audio 
decoder-in) of the video card. In the “Input” field, select the signal source that will be 
used by the video card to capture for this input. Many video cards have separate 
crossbars for audio and video. If you have a problem, try out the different 
configurations until the right sound matches the right image. 

Composite-in = the normal video input (typically a cinch jack) 

S-video = S-video input (mini-din jack) 

SVHS-in = SVHS input (special cable) 

Tuner-in = TV signal of the integrated tuner 
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Display 
Video decoder: If the picture only appears in black & white or it flickers, the video 
standard may be set incorrectly. In mainland Europe, PAL_B is used. 

VideoProcAmp: Fine-adjustment of colors, brightness, contrast etc. We recommend 
against changing any of the manufacturer’s settings. 

Format: Please do not change anything here. The capturing format is set in the 
"Recording quality" option in the video recording dialog. 

Station selection 
This option is only available if a TV tuner is integrated into your video card. 
 

Video Compression 
Compressed video data is typically saved in AVI files. AVI stands for ‘Audio and 
Video Interleaved’, i.e. mixed picture and sound. Depending on the compression rate, 
high data rates will be required – a good video starts at about 2 MB per second, 
equivalent to compression of about 1:10 as opposed to uncompressed video with 20 
MB per second data flow rate. High quality video systems only work with a 
compression of 3 or 2 – i.e. creating up to 10 MB per second data for video flow. Even 
uncompressed video can be used. MAGIX Music Maker Premium Steam Edition can 
also process such high-resolution video data completely. Within MAGIX Music 
Maker Premium Steam Edition, video data is processed in uncompressed format – all 
effects, mixes etc are carried out in the highest quality. It is possible that replay of a 
project with several videos or realtime effects may ‘jump’ more than is the case with 
smaller videos. This does not harm the end result though – video export is calculated 
frame by frame. 
 

General notes on AVI videos 
The AVI format (Audio Video Interleaved) isn't actually a proper video format! 
Rather, it is a so-called "container", where the conventions for transferring audio and 
video files to the program are only loosely defined. The codec (coder/decoder) 
actually defines what storage format is used. A codec compresses audio/video data 
into its own unique format which can only be read by the codec itself and is decoded 
when the film is played.  

In concrete terms, a computer-generated AVI file can only be loaded by and played 
on a different computer if the same codec is installed on it. 

Many codecs (e.g. Intel Indeo® video) have now become standard components of the 
Windows installation. Others are not standard. If you are generating an AVI file for 
future play on another computer using one of these codecs, you should first install 
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this codec on the other PC. The best method available is to copy the codec installer to 
your export directory and burn it every time you create a video disc (slideshow disc) 
for play on computers. 

You may encounter some problems when using older video editing cards with codecs 
which only function with the card’s hardware. Such AVIs can only be used on the 
computer which was used to create them. Try to avoid using this kind of codec. 
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Mixer 

 

MAGIX Music Maker Premium Steam Edition includes a real-time mixer with a 
master effects section that professionally mixes all the tracks within an arrangement. 
The Mixer can be opened by pressing the "M" key or via the toolbar in the main 
window.  

The Mixer displays eight tracks simultaneously by default. You can enlarge or 
minimize the mixer by dragging on the left or right border. You can view further tracks 
using the scroll bar. 
 

Slider (Fader) 
Each track in the project corresponds to a particular volume fader in the mixer, which 
controls the volume of all audio objects, synth objects, or a synthesizer in the track. 
(The fader has no effect on image and video objects.) 

 

The stereo position for each track is defined with the Pan controls. 
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The "Solo" button switches a track to solo mode, i.e. all other tracks are muted. Mute: 
The "Mute" button mutes the active track. Double-clicking on any of the controls 
resets it to its default passive setting (no boost or cut in level) that does not require 
processor output.  

 With the REC-button you can activate recording for this track. (see the 
"Track box and Instrument Icons (view page 33) section in the 
"Arranger" chapter) and Monitoring (view page 70). 

 

Control groups 
The volume, panorama, and FX send faders of the various tracks can be compiled into 
control groups. To do this, first click on a fader and then, while holding down "Ctrl", 
click on all other faders that you wish to include in your group. If you select "Shift", all 
faders in between the first one selected and the next one will be grouped. 

Now you can set the volume of multiple tracks together without having to change the 
volume ratios of the tracks. For example, you can set the volume of an individual 
instrument of a drumset (kick, snare, HighHat) in such a way that they can harmonize 
with one another. Now, if you group together the volume faders of the tracks, you can 
set the master volume of the drumset. 

To ungroup a fader from a control group, click the instrument and press "Ctrl" again. 
There may only be one control group active at a time, creating a new group 
automatically deactivates an existing group. 
 

Track effects 
 You can open the track audio effects rack with the FX button.  

A lit FX track button signifies that effects are active in the track.  

For more information on using and controlling the individual effects, please read the 
Audio effects (view page 135) chapter. 
 

FX tracks 

 

Two FX send controllers (FX1 and FX 2) are located below the plug-in 
slots. 

You can define the volume at which you want the signal to be routed to the two 
available FX tracks.  

An FX track is a complete, additional mixer track which provides a complete track FX 
rack for use as a send effect. A send effect differs from a normal effect found in the 
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track (Insert) in that it can edit the signals from multiple tracks or objects 
simultaneously.  

The FX are usually hidden in the Mixer. They will be displayed as soon as one of the 
FX send controllers is used. 

In the first FX track, the reverb feature is activated by default, since it is the most 
essential way of using send effects. 

The "Mute" button is used to switch the FX feature on and off. "Solo" lets you listen to 
the FX track by itself. The other tracks will be muted, but not the input signal of the FX 
track. This is why the peak meter of the tracks which send to the FX track are 
displayed in gray. 
 

Master track 
The FX button works exactly like it does in the tracks. It opens the Master Audio 
Effects Rack. The complete mixer settings including the FX tracks can be reset with 
the "Reset" button. 

Mastering: Opens the MAGIX Mastering Suite. 

5.1 Surround: This button switches the mixer to Surround Mode (view page 209). 

Both faders control the total volume. 

Link buttons: If the link button is deactivated, the volume of the 
right and left channels may be set individually. 
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5.1 Surround 
MAGIX Music Maker Premium Steam Edition supports playback in real 5.1 Surround. 
 

Requirements 
You will require a sound card or a sound chip which is integrated into the computer's 
motherboard with six individual outputs to playback the individual channels: 

• front left (L) / right (R) 
• centre (C) / subwoofer (LFE) 
• back left (Ls) / right (Rs) 

Surround playback is possible with all audio driver models (see Playback settings), 
(Wave, DirectSound). 

DirectSound is supported by most of the standard sound cards.  

Wave drivers are similarly supported by many standard sound cards; however, 
individual sound cards (for example, Soundblaster) require access to DirectSound.  

Output of the six output signals is achieved in all driver models in the output channels 
in the same (standardized) order: 

Channels 1/2: L-R 

Channels 3/4: C-LFE 

Channels 5/6: Ls-Rs 

When using WAV drivers, the loudspeaker settings normally have to be changed to 
5.1 playback in the control panel. On most systems the program does this 
automatically while using DirectSound. 
 

Import and export of surround audio files 
Import 
Interleaved 6-channel wave files can be imported. On loading, these can be 
transformed automatically into 3 stereo wave files and the corresponding track 
settings can be activated (First track L/R, second track C/LFE, third track Ls/Rs). 
 

Export 
Surround exports can occur in any one of the following formats: 

• Interleaved 6-channel wave files 
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• Windows Media files (Windows Media Audio or as a surround soundtrack of a 
Windows Media Video). 

The files created are fully compatible with the normal file formats. This means that 
they can also be played on computers incapable of playing Surround (in normal 
stereo). 

The export is performed using the same menu commands (e.g. "File -> Export project 
-> Audio as wave") like the normal stereo export. You will then be asked if the export 
should be in stereo or Surround format. 
 

The Mixer in surround mode 

 

To activate Surround playback, open the mixer ("M" key) and click on the "5.1 
Surround" button in the master. 

In the master, 6 peak meters for the individual channels are shown. The normal 
panorama button turns into a representative display of the Surround editor (see below 
(view page 209)) which can be opened by clicking on the display.  

The Surround editor is also available to the FX tracks (see "Mixer"). For example, you 
can send the original track to the front loudspeaker L/R, the FX track however will 
remain at the rear loudspeakers Ls/Rs. 

The master volume is applied to all channels, here the left controller influences 
channels L and Ls, the right controller; channels R and Rs and the middle value of both 
controller; the channels C and LFE. 

The master plug-ins are only applied to the front channels! 
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In the master FX rack of the MAGIX Mastering Suite, the full effect palette is not 
available in 5.1 Surround mode, but rather only the compressor and the parametric 
equalizer (from the Mastering Suite). The settings of these effects have the same 
effect on all six channels.  
 

5.1 Surround Editor 

 

In the 5.1 Surround Editor of the mixer track you can arrange the audio signal of a 
track (displayed as two red sound sources) in the “imaginary” room. The signal is 
dispersed to the 5 (blue) loudspeakers which represent the individual surround 
channels. 

There are 6 channels 

L: front left 

R: front right 

C: Center 

Ls: back left/left surround 

Rs: back right/right surround 

LFE Subbass (Low Frequency Effect) channel 
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Dispersing the signal to the 5 loudspeakers occurs after the so-called sound source 
emits a sound field of a certain level (displayed as red circles). The further away a 
loudspeaker’s source is, the lesser its share of the corresponding loudspeaker channel. 
The position of the loudspeaker can be moved with the mouse. 

The subbass share (LFE) is set directly from the corresponding value table. It can also 
be changed with the mouse. 

There are various modes in which you can use the source signal: 

Mono: The (stereo) source signal is seen as mono material, the left and right channels 
are mixed together and arranged together. The original stereo information is lost here. 

Stereo 1: Similar to mono mode insofar as the left and right channels are moved 
together, however, only a portion of the left source is audible in the loudspeakers L 
and Ls and only a portion of the right source in the right channels R and Rs. The stereo 
information remains as intact as possible. 

Stereo 2: The left and right channels can be arranged independently of one another, 
when moving the left source, the distance between the left and right sources remains 
unchanged. You can move an individual source by holding down the Alt key. 

Center/LFE: Only the left channel is arranged. In return, the LFE share is drawn solely 
from the right channel. This mode is only of importance to the Import of surround 
material (view page 207). 

“Width” determines the level of the sound field of an individual source. 
 

Automation 
Panning of the sound source on the loudspeaker can be automated to simulate 
movements in the room. 

For this to happen “Automation” must be activated. There are two methods to create 
automations: record and draw. 
To record (when automation is on), the sound source is moved between the 
loudspeakers during playback. When recording the automation, the “Record” 
checkbox lights up red. 

An alternative to drawing out complex movements is the draw function. When 
drawing in active mode, all panner movements are transmitted to the time interval 
between the start and end marker (when the mouse button is held). 

“Reset” deletes surround automation from the track. 

There is no automation of the parameters for width and LFE, of the distance between 
the left and right source in “Stereo 2” mode, or of the loudspeaker positions. 
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Live Pads 
The Live Pads are ideal for quick music production in realtime, live performances or 
sketching out ideas for new songs. You can control 16 matching loops, global pitches 
and effects via mouse, keyboard, MIDI keyboard or smartphone app (view page 216). 
This transforms MAGIX Music Maker Premium Steam Edition into a musical 
instrument that can be played right away and intuitively. 50 premade Live Sets in 13 
great styles are included. You can also create your sets from the Soundpools and your 
own recordings. 

The operation of the Live Pads has been specially developed for and works perfectly 
with the MAGIX Music Maker Premium Steam Edition Performer bundle including 
Novation Launchkey mini (view page 213). 
 

Live Pads interface 
Open the Live Pads by clicking on this button under the arranger or by 
pressing the K key. 

 

 Pads:Loops are started using the pads (view page 212). 

 Pitch: Like in the Soundpools, all melodic and harmonic loops in a live set are 
divided into 7 pitches. If you choose a different pitch, all loops will adapt to create 
a harmonic mix.  

 REC: If REC is active, objects added to the project via the pads stay in place and 
the live performance is recorded. 

 Quantization: When the pads are clicked, the loops don't start immediately, but 
right on the beat to ensure that beats and melody synchronize. You can set the 
time resolution for this (1 beat to 1/32 note) or deactivate quantization entirely. 
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 Presets: Select one of the pre-programmed live sets from the submenu and load it 
to the pads. Use the < > buttons to select the previous/next Live Set. 

 This opens the Shop view, where you can purchase additional Live Sets. 

 New Live Set: Removes all samples from the pads. 

 Load Live Set: With this button you can load your own or premade live sets. 

 Save Live Set: The complete assignment of the Live Pads can be saved with this 
button as a "Live Set" (.lms file) to be used later. The current Live Pad assignment 
will be saved together with the project. 

 Settings: In addition to some system settings, Sync mode can be deactivated here 
(see below)  

 

Playing the Live Pads 
Load one of the live sets supplied by clicking on "Presets". This fills the pads with 
loops and gives them different colors. Loops can be played back by clicking on the 
corresponding Live Pads using the computer (keys 1-8 and Q-I) or MIDI keyboard 
(see below).  

As soon as a Live Pad is selected, playback begins. During playback the corresponding 
object will appear for each Pad, and then disappear again when the Pad is released 
(when recording with REC it will remain visible).  

 

The pads that are being played will illuminate more brightly. 

Pads in the same color form a group. This means that these loops are sharing a track 
and only one of them can be played at a time - for instance different variations of one 
drum loop. 

Sync mode 

By default, loops are played in Sync Mode, as if they were all started at the project 
start and switched with the pads to "audible" (Mute Automation). This means that all 
loops always play in synch. Use this mode to create a basic structure for your project. 
If the sync mode is turned off, loops will always be played back from the start. Use 
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this mode if you would like to add solos or effect sounds or separate the beats in 
break beats. Sync mode can be deactivated through clicking on the gear icon. 
 

Your own live sets 
Using drag & drop, you can add samples from the Media Pool to the Live Pads in order 
to put together your own live sets. If you're using loops from the Soundpools in 
addition, these also adapt to shifts in pitch. However, pitch shifting will not function 
with your own samples, or recordings that don't contain any information about pitch. 

If using several drum loops that are played backed alternatively, these should be 
mutually exclusive. Therefore, they need to be grouped together. To do this, right-
click on the pads you have selected and choose the same group number for all of 
them. 
 

Use MAGIX Music Maker Premium Steam 
Edition with Novation Launchkey mini 
MAGIX Music Maker Premium Steam Edition is specially designed for using Live Pads 
with Novation Launchkey mini.  

 

 The InControl button lets the keyboard be used in Live Pad Mode. In this mode 
you operate the loops with the pads and control global pitch with the keyboard. If 
InControl is deactivated, the keyboard behaves like a normal keyboard (see 
below). 

When the Live Pad dialog (view page 211) is opened, the keyboard automatically 
changes to InControl mode. 
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Live Pad Mode on: 

 Pads: Loops can be stopped and started with the pads. A yellow-lit pad indicates 
that a loop is loaded to this pad. When a pad is played, it lights green. 

 Slider / Selection buttons: You can control a filter effect for the loops with these 
sliders. With the selection buttons on the right, select whether you want the slider 
to be applied to the top or bottom row of pads. 

Note: The filter affects the whole group of pads that share the same track and 
are played alternatively. See above for more information) 

 Scene buttons: Load the next/previous live set with the scene buttons. 

 Change the pitch with the seven lower keys. The other keys do not have a 
function 

 The octave +/- buttons are not necessary in this mode. These should be switched 
off so that pitch selection can function.  

Live Pad Mode off 

 By pressing InControl and one of the 16 Pads simultaneously, you can select the 
MIDI channel that's connected to the slider and the keyboard. This usually does 
not need to be adjusted. 

 Pads: The pads send the standard notes for a GM drumset to MIDI channel 10 
(the standard channel for drum sounds).  

 Sliders: The sliders send controller values (CC20-28) that you can use to operate 
synthesizer parameters. 

Tip: These sliders are already preset in the Vita synthesizers and Vita solo 
instruments supplied. 

The round selection buttons on the right do not have a function in this mode. 

 The scene buttons on the right do not have a function in this mode. 

 With the keyboard, you can play instruments as normal. 

 The octave +/- buttons shift the octave on the keyboard. The button lights up if 
the octave is shifted.   

See the MIDI objects (view page 89) chapter for more information on synthesizers 
and MIDI control. 

 



 

 

Live Pads 215 

Keyboards stickers 
In the MAGIX Music Maker Premium Steam Edition Control package you'll find a set 
of stickers for marking the keys of your MIDI keyboard. This way, you can operate the 
Live Pads even if you don't own MAGIX Music Maker Premium Steam Edition 
Performer or don't have Novation Launchkey mini. Owners of MAGIX Music Maker 
Premium Steam Edition (without additional hardware) can print the stickers from a 
PDF file and apply them to their keyboard. This file is located in the program folder. A 
link to this can be found in the start menu. 

 

Mark the three lower octaves of your keyboard with these stickers. The first two 
octaves operate the 16 pads, and the third octave is for adjusting pitch. Here's what 
the keyboard should look like: 
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MAGIX Audio Remote 
The MAGIX Audio Remote app is for remotely controlling certain functions of MAGIX 
Music Maker Premium Steam Edition via smartphone or tablet. Your computer and 
device need to be on the same Wi-Fi network for this to work. 

This app is continuously under development and will be used as a "universal remote 
control" in the future for all MAGIX products. 

Here http://www.magix.com/us/music-maker/ you can download the app! 
 

Connect 
Setting up a connection between Music Maker and MAGIX Audio Remote is simple. 

1. Make sure that your PC and the mobile device are connected to the same 
network. The connection will be automatic if both devices are using the same 
internet router. 

2. Open the app and click the gear icon in the top right corner. The settings screen 
shows the name of the computer on which MAGIX Music Maker Premium 
Steam Edition is running under "List of found devices". 

3. Click "Connect". The connection is now established. 
 

General operation 

 
Settings 

The gear icon opens the settings 
screen. This is where you set up the 
connection to the program. Use the 
slider to adjust screen brightness. 

 

 

The small transport console is 
visible on every page. 

Loop on/ off 

To start 

Stop 

Play / Pause 

Record 

 
Menu: Here you can choose how 
many pages you want in the control 
area. Currently, there are four pages in 
the control area 
• Filter 
• Reverb 
• Transport 
• Live Pads (only Live & Premium 

Versions) 

 

 

http://www.magix.com/us/music-maker/
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Filter 
Filter is a remote control / modulation source based on physical modeling for the 
filters in MAGIX Vita Solo Instruments. 

 

The vertex of a filter curve is controlled by a sphere graphic that hangs from a thread 
in a set position (the sun). When the whole thing is set in motion, things start to get 
exciting. Depending on how the graphic is manipulated, you can carry out slow filter 
changes, LFO modulations or chaotic reflections. Even if you're not an expert, the 
interface makes it easy to experiment. 

To use the filter, load one of the Vita Solo Instruments with filter. How to set the filter 
in motion: 

• Click on the graphic and drag it. You can also click in space and drag to 
illuminate the sphere with a tractor beam. 

• The sun can be moved. 
• Zoom between the sun and sphere to change the length of the thread. 
• Click on the sun to undo the connection between the sphere and the sun. The 

sphere now flies freely through space. It bounces off walls and the sun and gains 
energy in doing so. The "ground" is in the lower part of the screen. 

• Drag below left or right to the change the gravity. 
• Two-finger zooming in free space changes the damping. As damping is 

increased, the quicker the sphere comes to a stationary position. 
 

 



 

218   

www.magix.com 

Technical note 
In technical terms, the "Filter" sends the xy positions of the sphere in the space as 
MIDI CC20 and CC21 to the Vita Solo Instruments. These correspond to the 
controllers that are used by the the first two Novation Launchkey mini sliders and that 
are assigned preset parameters in all the Vita synthesizers. In the replications of the 
synthesizers these are the cut-off and resonance filters. These attributes can be 
changed in order to modulate two other synthesizer parameters with the "Filter". 

Details for assigning MIDI controllers to Vita Solo Instrument parameters can be 
found under Automation of Vita Solo instruments (view page 128)! 
 

Reverb 
In the reverb page you can control reverb in the Vita synths. 

 
• Set room size in the rectangle 
• Zoom with a two-finger gesture to define the amount of reverb (Dry/Wet). 
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Transport console 
The transport console performs exactly the same function as in MAGIX Music Maker 
Premium Steam Edition (and in the small transport console on the edge of the app). 

 

Tip: For anyone creating music and producing at the same time, a recording in a 
recording booth can be controlled remotely. 

 

Live Pads 
Operate the MAGIX Music Maker Premium Steam Edition with the app. The interface 
will be the same as the Live Pads interface (view page 211) in Music Maker. (available 
only in ) 
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Automation curves 
In addition to object-based effects and the mixer effects for entire tracks/for the 
entire sound, there is also the option of controlling audio and video effects via freely 
drawn curves. 

There are track curves and object curves. The track curves are saved on the track and 
influence all objects of the track. The object curves "hang" off the object and can be 
moved with them. Changes to the object length are adjusted correspondingly. 

 

Object featuring FX Level 1 object curve on a track with an active volume curve 

Automation curves change a specific value, e.g. the volume value for a track, which is 
"automated" during playback. This enables you to make your arrangements more 
exciting, e.g. the volume of several tracks shortly before the refrain may be reduced 
slightly in order to make the refrain itself more powerful once it appears. 
 

Effects that may be automated 
The following effects can be controlled via effect curves: 

Audio objects 
• Volume and Panorama are identical to the functions in the mixer, in which case 

a volume curve is added to the mixer setting and a panorama curve replaces the 
mixer setting entirely. 0% in the Panorama corresponds with all the way to the 
left, while 100% is all the way to the right. 

• Softening and sharpening filters as well as distortions are additional effects that 
are only available for effect curves and that are independent of the filter or 
distortion effect in the effects rack. This controls the filter's input frequency or 
the degree of distortion. 

• Effects level 1 and 2 control the effect level sent  from the object or track to the 
two effects tracks (view page 205). 

Video, image, and title objects 
• X,Y position: An X curve value of 50% corresponds to the normal position; at 

0%, the video is moved to the left by its own complete width, and at 100% it is 
moved to the right (it becomes invisible in both cases). Analogous to this, a Y 
value less than 50% moves the video downwards, and a value more than 50% 
moves it upwards. 

• Height/Width/Zoom: 50% corresponds with the original size; 100% 
corresponds to double size. 0% causes the object to disappear. 
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• Rotation: 50% corresponds to the original orientation, 180° corresponds to the 
maximum clockwise rotation, and 0% 180° rotates the object counter-
clockwise. 

Video effects are only available as object effects. 
 

Track automation 
You may also show an automation curve for editing the project in the track's 
"Effects" menu. In this case, only one automation curve will be displayed; all 
automation curves are able to affect the track simultaneously. 

 
 

Editing the track curves in the project 
In the arranger, only one track curve may be edited per track at a time. The curves can 
either be edited with the individual handles or by freely drawing the effects curve. 

New handle points can be added by double clicking on the curve; existing ones can be 
deleted by double clicking. All handles can be moved with the mouse in a horizontal 
and vertical direction. 
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In Automation (view page 53) mouse mode, the left mouse button may be used to 
draw a new curve on the track. 
 

Object automation 
Object curve effects are selected and edited in the "Dynamic Effects Editor" dialog. 
Use the "Object automation" command in the "Effects > Automation" menu 
(Keyboard shortcut: Ctrl + H) to open this feature. 

 

Effects provides a list of all available effects for the selected object. The box before 
the name allows you to activate the respective curve. To keep things clearly laid out, 
only one curve at time can be shown for an object. Clicking on the name allows you to 
select which of the active effects should be shown as a curve in the project. 

Tip: You can select or activate another object and its automation curves without 
having to close the editor in the meantime. 

The volume and panorama curves of an object may also be hidden/shown via 
"Effects -> Automation". 

Delete envelope: Deletes the current effect curve. 
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Invert envelope: Mirrors the current curve on the 50% horizontal axis, i.e. 0 becomes 
100%. For a panorama curve, this would result in the playback side changing. 

Rhythmic envelope: This options creates a rhythmic curve either via the generator or 
(for audio objects) via volume analysis of the object. 
 

Rhythmic envelope 
The curve generator will create a beat-based automation curve that pulses according 
to eighth, quarter, half, or full notes. Enter a minimum and maximum value or define 
delay values as options for writing the beat-based envelope curve calculation. 

The selection dialog allows you to define the shape of the automation curve in more 
detail:  

 

Beat based: This option causes the automation curve to follow the beat of the 
arrangement.  

There are 4 basic patterns available for beat-based automation curves, i.e. 2 sawtooth 
shapes, rectangle, and triangle. These shapes are regularly run in time with the beat 
and control the intensity of the activated effect. On the left side of the dialog, you can 
adjust whether the basic pattern of the automation curve should run once per eighth, 
quarter, half, or whole note. 

Options: This opens an additional dialog to control the style and intensity of the 
influence of the beat on the automation curve (see below). 
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Scan envelope curve: Allows the volume process to be displayed as an automation 
curve as an alternative to a beat-based automation curve. 

Normalize first: This function normalizes the level of the audio object before the 
object is scanned to create an automation curve. 
 

Curve generator - options for beat-based calculation 
Limitation: Determine the minimum and maximum value of the envelope via Delay 
Minimum/Maximum the basic forms can be altered further.  

 

Shifting moves the entire curve. This lets you create interesting off-beat effects.  
 

Editing curves 
Standard mode: If the project is not playing, you may create an effects curve point at 
the position of the start marker and move it vertically. An effects curve may be edited 
by setting the start marker at different positions and setting the curve value for this 
point with the slider. 

Draw mode: Move the slider in the dialog (when playback is stopped) and a curve will 
be drawn in the track between the start and end marker accordingly. The duration of 
the curve drawn corresponds with the object's duration. Automation (view page 53) 
mouse mode is also activated so that the curve may also be drawn in with the mouse. 
This also works during playback. 

Adjust active: Specifies object curve behavior if the length is changed retroactively. If 
"Adjust active" is on, then the object curves will be compressed and stretched with 
the objects, i.e. the curve points are moved correspondingly. For example, if a 
movement curve is set so that an object is moved across the entire screen, then this is 
also done in case the length is changed (only slower or faster). 
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Integrating other programs - Synchronizing 
and ReWire 
MAGIX Music Maker Premium Steam Edition enables other programs or external 
MIDI hardware (e.g. Grooveboxes, hardware sequencers) to be remote controlled via 
MIDI synchronization or to be controlled by these devices. Synchronization means 
that both components involved always use exactly the same tempo and operate at 
the same time position. 

ReWire technology makes it possible to play ReWire-capable programs like 
Propellerheads Reason or Ableton Live in MAGIX Music Maker Premium Steam 
Edition just like a software synthesizer via MIDI objects. 
 

Synchronization 
Sometimes MAGIX Music Maker Premium Steam Edition is not enough on its own. A 
friend has a Groovebox and wants to jam... 

If two software or hardware sequencers (devices like Grooveboxes or keyboards) are 
intended to play music together, then it's important to synchronize them. 

Why is this necessary 

You would have to be pretty skilled to be able to play both programs or devices at the 
same time - there would most likely be problems with time delays, and as soon as one 
side pauses or skips forward, chaos is fairly likely the result. 

Even when playback is started simultaneously (synchronously), the sequencers can 
get out of beat over time, since even if tempo is programmed on both sides, this will 
never truly match 100%. Software sequencers determine the tempo based on time 
which is derived from the sample rate on the sound card. Theoretically, this has a 
fixed, predefined value, e.g. 44,100 Hz, but in practice, this value can deviate so that 
the real tempo is slightly faster or slower than what is displayed. 

Therefore, synchronization means that one side constantly receives information about 
the current time position from the other, and that the position and tempo is corrected 
correspondingly to result in a match. This includes provision of all transport functions 
like start stop, or jump to a specific time position. 

The side which sends the synchronization information is called the Master, and the 
side which receives the information is called the Slave. 

For synchronization, a normal MIDI connection is required, i.e. depending on the 
operational mode, you connect a MIDI output (MIDI OUT) on the computer with the 
MIDI input (MIDI IN) on the other computer/device for master synchronization or 
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other way around (MIDI input on the computer with the output on the other machine 
for slave sync). 

Activate synchronization in the dialog "Project settings" ("E") under the 
"Synchronization" tab. 
 

Synchronization settings 

 

Receive synchronization (slave): Slave sync on. MAGIX Music Maker Premium 
Steam Edition follows the tempo and transport control of the external 
device/program. 

Device: Here you have to select the MIDI input driver via which MAGIX Music Maker 
Premium Steam Edition should receive the MIDI timecode. 

Framerate: The master and slave framerates must match. Synchronization with video 
programs/video hardware matches the framerate of a specific video format, e.g. 24 
for cinema, 25 for PAL video audio synchronization, 29.97 drop/no-drop or 30 for 
NTSC video. 

Preroll frames: Here you can enter a frame number that MAGIX Music Maker 
Premium Steam Edition will ignore before synchronization starts. This will ensure that 
analog devices first require a certain time to reach the correct speed. In order to 
prevent synchronization of MAGIX Music Maker Premium Steam Edition to an invalid 
time, this can be skipped by means of preroll frames. 

Send synchronization (master): Master sync on. The external device/program 
follows the tempo and transport control in MAGIX Music Maker Premium Steam 
Edition. 
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GIX Music Maker Premium Steam 

 of MIDI and audio can run apart for longer projects. 
You can accelerate the speed of the MIDI playback in this case by slightly increasing 

 to 1.000001). 

ReWire-compatible client applications (like, for example, 
emium Steam 

ack. 
ppear as individual sections in the selection menu for 

he 

r 

s, starts, and stops synchronously with the time position in 
MAGIX Music Maker Premium Steam Edition so that you can also use the sequencer 
in

Start offset (ms/SMPTE): Specify an offset in milliseconds or SMPTE frames 
(minutes:seconds:frames) to be deducted from the incoming timecode before the 
time is used for synchronization. An offset of 60:00:00 (1 hour) will synchroni
tape with an SMPTE code that starts at 1 hour; MA
Edition however still starts at the tape beginning at "0". Vice versa, sending a 
timecode snaps this value to the current position. 

Correction factor: Normally, this value should be at "1" if you don't change it. In 
seldom cases, synchronization

this factor (e.g.
 

ReWire 
If this option is activated, 
Propellerheads Reason) can be integrated into MAGIX Music Maker Pr
Edition as synthesizers.   

Activate the ReWire function in the project properties ("E") under the 
"Synchronization" tab. 

Afterwards, installed ReWire applications can be loaded as instruments into a tr
All ReWire client applications a
software instruments in the track box and in the MIDI editor and are loaded as 
software instruments (VSTi).  

Several client applications can be opened automatically by right clicking on their 
name in the selection menu, just as you can open the plug-ins window for VST 
instruments by right clicking. ReWire clients which support the direct opening of t
client application via the host application (MAGIX Music Maker Premium Steam 
Edition) need to be started manually. You can do this by starting your client 
application as you would normally. It then automatically recognizes the host and 
starts in a special client mode. The client application should always be launched afte
MAGIX Music Maker Premium Steam Edition and should be closed before exiting.  

The ReWire application can be controlled via MIDI, just like a software instrument. 
The client application run

 the client application. 

The "classic" MIDI channel of MIDI notes and events is not important; it is replaced 
by the ReWire MIDI bus system. MAGIX Music Maker Premium Steam Edition only 
sends to the ReWire MIDI bus and only supports the ReWire master output-side, 
not the ReWire audio bus system. 
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Reprocess arrangement 

Export wizard 
The export wizard can be opened through "File" > "Export" > "Common export 
options". This bundles different options for exporting your project in different formats, 
for burning onto CD, or publishing on the Internet with different platforms. 

 

Export as MP3: This selection exports the project in the popular MP3 format for use 
on the Internet or on mobile playback devices (MP3 players, mobile phones, etc.). 
More details about the export dialog are provided in the "Export" (view page 235) 
section of the "File menu" chapter.  

Burn to CD/DVD: This selection exports the project in the best possible quality and 
opens an additional program for burning an audio CD. The option is also available to 
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backup the entire project with all involved files onto CD or DVD. See Burn audio CD 
(view page 233). 

Upload to MAGIX Online Album laden: Uploads the project to MAGIX Online 
Album. This platform enables friends and acquaintances to experience your work. The 
MAGIX Online Album online player may also be embedded into any other websites. 
More information about MAGIX Online Album is available in the"File menu" 

Publish on Facebook: You can send the project directly to your Facebook profile. It 
will then appear as a post on your wall.  

Publish on YouTube™: This selection uploads the project as a music video to 
YouTube. To use video in MAGIX Music Maker Premium Steam Edition read the 
chapter Video and Image Objects (view page 195). More info about YouTube export 
is available in "Export to YouTube" (view page 231) in this chapter. 

Publish on Soundcloud: The project will be uploaded to Soundcloud. Additional info 
about this innovative music environment can be found in the Upload audio to 
Soundcloud (view page 232) chapter. 

Send by email: Converts the project into Windows Media and adds it as an 
attachment to an email. An email program (e. g. Outlook Express) must be installed 
and setup.   

Note: You cannot use this function if you only access your email through a browser.  
However, you could invite others to listen to your uploaded music via email to your 
MAGIX Online Album or Youtube™. To do so, you will have to use the functions of 
the respective website (for MAGIX, this is MAGIX Online Media Manager). 

 

Export as E-Mail attachment 
The option "Send project as email" in the "File" > "Export" menu creates a file in the 
Windows Media format. Your mail program is activated simultaneously and the 
created file is added as an attachment of an opened message. Thus, any project can 
be compressed without intermediate steps and sent as an email immediately. 
 

Export as ringtone 
With MAGIX Music Maker Premium Steam Edition you can produce your own 
individual ringtone melodies. Once completed, export the project using the "Audio as 
Wave/ADPCM"  or "Audio as MP3" option in the File menu under "Export". Exactly 
which format to choose can vary depending on the capabilities of your phone. 

Take a look at the "File menu"chapter for more information on the audio export dialog 
and the for specific export format settings. 
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Some advice on creating ring tones 
Audio material: When designing your ring tone please take into account that the 
loudspeakers of your mobile phone can only poorly reproduce bass tones. High tones 
are also heard more easily in a loud environment. If your ring tone includes MIDI 
Objects, you should activate VST Instruments on the respective tracks in the project, 
so that MIDI information included in your ring tone becomes audible. 

Some manufacturers offer VST effects which simulate the loudspeaker of your mobile 
phone on the PC. 

Length: Typical ring tones have a length of about five to sixty seconds. MAGIX Music 
Maker Premium Steam Edition lets you create longer ring tones; however, you should 
note that large ring tone files require sufficient memory in your mobile phone. 

File format: First, select a format suitable for your mobile phone from the Export 
dialog. If several formats are possible, please note that the resulting audio quality will 
vary. In general, the quality increases in tandem with the size of the file. If your mobile 
does not support stereo audio playback, you can activate the "mono" export option 
which reduces the required memory space by about half. The size of the file that will 
be generated using your current settings is displayed in the Export dialog. 

Transferring the ringtone to your mobile phone: Depending on the type of mobile 
phone and the items included in delivery there are several possibilities to transfer your 
ringtone from the PC to the phone: 

1. Wireless via infrared (IrDA) or BlueTooth link 
2. Using a data cable and, if applicable, the transfer software supplied by the 

manufacturer 
3. By WAP or MMS  
 

Community upload 
The menu entries featured under "File" > "Export" >"Community upload" or via the 
Export assistant allow you to upload the finished song to different web communities. 
 

Export to Facebook 
You can export your project from MAGIX Music Maker Premium Steam Edition 
directly to Facebook. 

The command opens a dialog where the project name (displayed according to the 
settings in MAGIX Music Maker Premium Steam Edition), a description and search 
words (tags) can be entered. After confirming this data with "OK", the project will be 
exported and uploaded to Facebook. For connecting and transmitting the video file, 
you must login with your Facebook username and password.  If you aren't registered 
on Facebook, first open your browser and create a Facebook account. 
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After a successful upload, your browser will open to show you your video's info page 
so you can check the entered data once again. If everything is as you want it, you can 
leave the page and the new video will now appear in the list of your own videos.  
 

Export to YouTube 
You can upload your project to YouTube® directly from within MAGIX Music Maker 
Premium Steam Edition. 

You can find this function in the menu "File -> Export -> Youtube". 

The command opens a dialog where you can set the name of the project for YouTube 
(default is the same as in MAGIX Music Maker Premium Steam Edition), description, 
keywords (so-called "tags"), and the category for the video. After submitting this data 
by pressing "OK", the project is exported and uploaded to YouTube®. This is why you 
have to enter your YouTube® account access data (username, etc.) to connect to 
YouTube®. If you don't have an account open your browser and go to YouTube® to 
sign up for an account first. 

If uploading was successful, your browser will open the info page for the video you 
just uploaded to YouTube® to double check your description and tags. If everything 
looks correct, just leave this page and the new video is already listed under your 
videos. YouTube® takes some time to process the video for online presentation, but 
after this period you and every web user around the world will be able to watch it. 
 

Title templates for YouTube 
If your project does not contain a proper video, then you can still upload it to 
YouTube® with an attractive still image.  
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In the Media Pool, under the setting "Templates" you will find the subfolder 
"YouTube" under the "Title". This contains spezial title templates for use with 
YouTube videos. These templates feature neutral designs or match the style of the 
Soundpool (hip hop, rock etc.), and contain standard text for artists, title, album, and 
comments. These titles also appear throughout the entire length of the project. 

 
 

Upload song to Soundcloud 
Soundcloud is a community that is especially designed for musicians. The free version 
provides 120 minutes of storage space for your songs. Every song may be embedded 
as a player widget into external websites; the widget even allows comments along the 
timeline of the song and an optional download of the original song. 

For more information about the possibilities provided by the Soundcloud community 
and the different premium accounts see www.soundcloud.com 
http://www.soundcloud.com. 
 

Additional editing 
You can send your project directly into other MAGIX programs for further editing. In 
the "Mixdown" menu you can find the applications available in Music Maker.  

MAGIX Music Maker Premium Steam Edition lets you use your project  

• as background music in slideshows and videos 
• to be added to an existing music collection 
• to be edited with an external editor 
• to be uploaded onto an online platform 
• and much more... 

http://www.soundcloud.com/
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Note: The relevant MAGIX program must be installed in order to use these features. 
Music Maker automatically populates the menu "Share" with the corresponding 
features available. 

 

Burn audio CD 
To burn an Audio CD, export your project as a wave file: Click on "File" and select the 
"Export project" option > "Audio as Wave/ADPCM". The WAV file created can be 
burned as an Audio CD with any burn program.  

In the Live & Premium version, the burner program MAGIX Speed burnR as well as 
the MAGIX Music Editor are at your disposal. You can load your project into the 
MAGIX Music Editor with the help of the option from the menu command: "File" > 
"Export project" > Burn project on audio CD-R(W), and burn an audio CD using this 
CD mastering tool. Or you can open MAGIX Speed burnR, for example, with the help 
of the context menu in the Media Pool. An MP3 data CD can also be created with 
MAGIX Speed burnR.  
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File Menu 

New project 
A new MAGIX Music Maker Premium Steam Edition  project is created with this 
menu item, with 16 tracks. More tracks can be added via the menu “Edit”.  

Shortcut:  Ctrl + N 
 

Load project 
A previously saved MAGIX Music Maker Premium Steam Edition project is loaded 
with this menu item. Please note that the object files for the project must also be 
available! MAGIX Music Maker Premium Steam Edition will look for the sounds and 
videos that were used first in the path where they were located when the project was 
saved. If they are not found there, then the MAGIX Music Maker Premium Steam 
Edition Project will look for the objects in the same directory as the project itself.  

Shortcut:  Ctrl + O 
 

Save project 
The current project is saved under the existing name. If no name has been selected, 
then a File requester opens, where the path and name can be defined. 

Shortcut:  Ctrl + S 
 

Save project as... 
A dialog opens where the path and name of the project can be specified. 
Shortcut:   Ctrl+Shift+S 
 

Import 
Import audio CD tracks 
You can simply import one or more CD tracks like a regular file from the Media Pool 
via drag & drop. If this convenient method fails for some reason, then this menu 
command may be accessed via the CD manager to insert tracks from audio CDs 
directly into the project. More on this can be found in the section "Importing Audio 
CDs (view page 71)" in the "Audio objects" chapter. 

Shortcut:  C 
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Audio recording 
See Audio recording (view page 67). 

Shortcut:  R 
 

Video recording 
See Video recording (view page 199). 

Shortcut:  G 
 

Export 
Common export options 
You will find a quick selection of the most common export options here. 

Please read more on this in the section Export wizard (view page 228). 

Keyboard shortcut:  X 
 

Burn audio to CD-R(W) 
With this option the project will be exported as a WAV file and loaded into an 
additional program called MAGIX Music Editor.  From there it can be burned straight 
to disc. 

Shortcut:  Shift + C 
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Audio export dialog 

 

File 

In File you can enter the file name for you exported file. 

 Use the folder symbol to select the folder into which you want to export it. The 
dialog will remember the export path for future exports. 

 Use the "home" symbol to restore the original preset (More information can 
be found in the section "Folders" on page 250) path. 

With "Overwrite file automatically" you can perform multiple exports from the same 
file.  

Options 

Only export the area between the start and end markers: Set the option if you wish 
to export only one of the clippings from the project. 

Bit rate: The "Bit rate" selection specifies the level of compression: The higher the bit 
rate, the higher the quality of the exported audio file. On the other hand, the bit rate 
determines the final file size: The smaller the bit rate, the smaller the files. 

Mono/Stereo/5.1 Surround: Most mobile devices have only one loudspeaker. To save 
on memory, you can export in mono as well. In 5.1 Surround Mode (see Mixer in 
Surround Mode) you can also export in MP3surround. 
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Advanced: Here you can open the advanced settings dialog for the corresponding 
audio format (see below). 

Normalize: This function should always be activated. It guarantees that the music is 
not too loud/overmodulated or too quiet.   

Transfer format: 

Here you can state whether you want to send he exported arrangement to mobile 
devices via Bluetooth, infrared or email. Read more in the Reprocess arrangement  
(view page 228)chapter. 

 
 

Audio as WAV/ADPCM 
The audio material is exported as a standard wave file. This is the conventional format 
for further use on Windows PCs. These files are not compressed and retain their full 
sound quality. 

Compression (IMA ADPCM): This option compresses the WAV file in to the 
ADPCM format. This format is needed for playing WAV files on mobile phones. A lot 
of mobile phones also need a lowered sample rate. (usually 16000 Hz). 

Note: You can also export single tracks. TO do so, simply "mute" those tracks that 
you don't want. Then, only the active tracks will be exported with this function.  

Shortcut:   Shift + W 
 

Audio as MP3 
MAGIX Music Maker Premium Steam Edition supplies an optional MP3 encoder for 
especially fast, top-quality conversions into the popular MP3 audio format. 

Note: The MP3 encoder cannot be used as a codec for the audio track of AVI audio 
files.  

Transfer format: 

Here you can specify how you wish to send the audio file to the mobile device. Read 
more on this under Transferring files (view page 229). 

Options 

In the "Options" section you can set the format and the compression of the audio file. 
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Bit rate: The "Bit rate" selection specifies the level of compression: The higher the bit 
rate, the higher the quality of the exported audio file. On the other hand, the bit rate 
determines the final file size: The smaller the bit rate, the smaller the file. 

Mono/Stereo: Most mobile devices have only one loudspeaker. To save on memory, 
you can export in mono for these devices. 

Normalize: This function should always be activated. It guarantees that the music is 
not too loud/overmodulated or too quiet. 

Keyboard shortcut:  Shift + M 
 

Audio as Ogg Vorbis 
"OGG Vorbis" is a license-free open source audio codec with very good sound 
characteristics for comparably small files – similar to the MP3 file format. 

In the settings under "Advanced" you can still choose from three various encoder 
modes and bit rate. Set quality. Constant bit rate enables streaming and maximum 
compatibility; with variable bit rate a better audio quality with the same size files can 
be achieved.  

Shortcut:  Shift + O 
 

Audio as Windows Media 
Exports the project in Windows Media Audio format. Please read more on the 
advanced settings in the Windows Media Video Export (view page 241) section. 

Shortcut:   Shift + E 
 

Audio as AIFF 
The audio material is exported as an AIFF file. This is the most commonly used audio 
format for Apple™ computers. 

Shortcut:  Shift + I 
 

Audio as FLAC 
FLAC is the abbreviation for "Free Lossless Audio Codec". This is a freely savable 
format that can be used to compress your audio data to 50% of their original size. 
Unlike lossy compression methods like MP3 or OGG, the full sound quality is kept 
intact with FLAC. 

Shortcut:  Shift + F 
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Audio tracks as single waves 
Opens the WAV export dialog with activated "Export single tracks" option. Clicking 
on OK saves each track as a separate wave file in the export folder. 

Shortcut: Shift + U 
 

Video export dialog 

 

You can export your arrangement into various video formats. The options on offer can 
vary according to the selected format.  

Presets: Under "Presets", you'll find the typical settings for the selected format for the 
most important applications.  

You can save your personal settings by pressing the "Save" button and 
remove them by pressing the "Delete" button. 

Export settings: You can set up the general export parameters like resolution, page 
proportions and frame rate in the dialogs. Select the most-used values from the list 
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field, to set your own values click on the "..." button. The "Advanced" button opens 
the specific settings dialog for selected video format (see below).  

In File you can enter the file name for you exported file. 

 Use the folder symbol to select the folder into which you want to export it. The 
dialog will remember the export path for future exports. 

 Use the "home" symbol to restore the original preset (More information can 
be found in the section "Folders" on page 250) path. 

With "Overwrite file automatically" you can perform multiple exports from the same 
file.  

Options 

Shut down PC automatically after successful export: Use this option to have the 
computer switch off automatically after lengthy export processes. 

Only export the area between the start and end markers: Set the option if you wish 
to export only one of the clippings from the project. 

Play after export: Here you can state whether you want to send he exported 
arrangement to mobile devices via Bluetooth, infrared or email. Read more in the 
Reprocess arrangement  (view page 228)chapter. 
 

Video as AVI 
When exporting to AVI video you can set and configure the size and frame rate of the 
AVI video and the compression codec for audio (audio compression) and video 
(Codec). Please also observe the general information on AVI video formats (view 
page 202) in the PDF manual. 

Shortcut:   Shift + A 
 

Video as MAGIX video 
Exports the project in MAGIX video format. 

This format is used for video recording by MAGIX Music Maker Premium Steam 
Edition video software and is optimized for digitally editing high quality video material. 

Shortcut:   Shift + X 
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Video as Quicktime Movie 
Exports the movie in Quicktime Movie format. This format enables streaming 
playback of audio or video files via the Internet. 

Like with Real Media Export, you can make corresponding settings for video size, 
frame rate and codecs for Quicktime export. However, the export dialog doesn't offer 
the option of saving comments for the video.  

Tip: For Quicktime files (*.mov), the Quicktime library must be installed. 

Shortcut:   Shift +Q 
 

Video as Windows Media 
Exports the project in Windows Media format. This is a universal audio/video format 
from Microsoft. The setting options in the "Advanced"dialog are correspondingly 
complex. 

Manual configuration 
Audio/Video codec: Various codecs are available, corresponding to the various 
Windows Media versions (7, 8 or 9). Should compatibility problems arise on 
playback, try an older codec with a lower version number. 

Bitrate mode: Constant and variable bitrates are possible; most devices and 
streaming applications demand constant bitrate. For VBR two pass modes the movie 
is compressed in two passes in order to optimally use the bandwidth for highly-
compressed movies for the Internet. 

Bitrate/quality/audio format: The bitrate determines display and audio quality. The 
higher this is, the better your videos will look and the larger the files and the required 
encoding time will be. For variable bit rates, the bit rate is adapted dynamically to the 
requirements of the corresponding picture or sound material. Either the quality value 
can be set between 1-100 or, for two-pass encoding, an average or maximum bit rate. 
For audio, the bit rate is set additionally by the audio format. 

Import from system profile (export type): For the most used methods (other than 
playback on mobile devices,for which you should use the supplied presets), like 
Internet streaming, etc., Microsoft provides diverse system profiles to choose from. If 
you have the Windows Media Encoder 9 installed, which is available from Microsoft 
as a free download, you can edit the profiles or create your own. These can be loaded 
by pressing the "Import from profile file" button. 

Go to Clip info to insert title, author name, copyright details, and a description.  



 

242   

www.magix.com 

Shortcut:   Shift + V 
 

Single picture as BMP 
Exports the picture located at the current start marker and displayed in the video 
monitor as a bitmap (.BMP) file. 

Shortcut:   Shift + B 
 

Picture as JPG 
Exports the image located at the current start marker and displayed on the video 
monitor as a jpeg file. 

Shortcut:  Shift + J 
 

Sending your project as an email 
This option creates a compressed file in Windows Media format. Your mail program 
is activated simultaneously and the created file of an opened message is added as an 
attachment. This lets you compress and send your project immediately without 
having to go through any intermediate steps. 
 

Upload to Community 
In this menu item you have the option of uploading the finished project to various 
online platforms. You can find details about this in the section Publish online (view 
page 230). 
 

Backup 
Load backup project 
Using this command you can load a backup project. Backup projects are created 
automatically by MAGIX Music Maker Premium Steam Edition and can be used 
when, for instance, a program crashes in order to recover the last status of files. This 
type of automatic backup gets the file extension MM_ (underscore). This command is 
also useful if you unintentionally saved your change and wish to return to the previous 
version. 
 

Save project and used media 
With this menu point, you can put a complete MAGIX Music Maker Premium Steam 
Edition project, including all used multimedia files into one folder. This is especially 
useful when you wish to reuse or archive such a project later on or when the files can 
be found on multiple CDs so that on loading you continually have to change CDs. 
Furthermore, the effect files used are saved in one folder with the other files. 
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A dialog opens where you can specify the path and name of the project. 

Shortcut:   Ctrl + Alt + S 
 

Save project and used media (audio as OGG Vorbis) 
You can create a backup copy as an OGG file, whereby all audio files used will be 
compressed into OGG format. This way you can compactly archive your song or put it 
on the web as a remix kit. 

Shortcut:  Ctrl + Shift + C 
 

Burn project and used media onto CD/DVD-R(W) 
Use this option to burn the project as well as all the relevant files to CD or DVD. 

Even larger projects can be burned straight to disc. The project, if necessary, will then 
be split up and burned automatically to multiple discs. A restore program which is 
burned to the first disc of such a backup, guarantees easy re-recording of the backup. 

Shortcut:   Ctrl + B 
 

Burn manually selected files to CD/DVD-R (W) 
Opens MAGIX Speed burnR to burn videos or other files onto CD/DVD. File selection 
is done via drag & drop from <goyaburn>'s Explorer. 

Shortcut:  Ctrl + Alt + B 
 

Settings 
Project settings 
In this dialog, the general properties of the project can be set. Statistical information 
about the project is also displayed. 

Shortcut:  E 
 

General options 
Name: Enter the name of the current project. 

General project settings 

Path: This is where you determine the folder on your hard drive in which your project 
is saved. 
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Save automatically: Saves the project automatically according to the settings used for 
automatic backups in the program settings. 

Use settings as presets for new projects: The settings entered in this dialog are 
applied to all new projects. 

Number of tracks: Here you can set the number of tracks you wish to use. 

Audio sample rate: The sample rate determines the pitch and the speed at which 
audio objects are played back. The sample rate you can use depends on your sound 
card (some sound cards even permit changing the sample rate during playback). The 
sample rate you can use depends on your sound card (some sound cards even permit 
changing the sample rate during playback). If you halve the sample rate, wave audio 
objects are played one octave lower.  

Time signature: Several types of bars are available to choose from, for example ¾ 
beat. With various grid settings you can also set additional time signatures. For 
example, with a set ¾ beat and a 1/8 note grid a 6/8 beat would be the result. 

Video resolution: Here you can specify the presets for the video resolution used and 
the video format. 
 

Synchronization 
Options for Synchronization (view page 226) and ReWire (view page 227) support. 
 

Information 
Name/Path: See above 

Created on: Displays the time the project was created.   

Last changes: Displays the time when last saved. 

Number of used objects: Displays the number of all objects in the project. 

Used files: Here the names and paths to all multimedia files used in the project are 
shown. 
 

Audio recording 
See Audio recording (view page 67). 

Keyboard shortcut:  Shift + R 
 

Program settings 
Here you can set MAGIX Music Maker Premium Steam Edition according to your 
needs and wishes. 

Shortcut:  P 
 



 

 

File Menu 245 

 

General options 
Autoscroll: If autoscroll is activated, the screen view automatically shifts when the 
playback marker reaches the right edge of the screen, which is particularly useful for 
longer projects. Scrolling requires constant recalculation of the screen view, which 
may lead to interrupted playback if the amount of system RAM is too low. If this 
happens, simply deactivate the autoscroll feature. 

Simplified Object Display: This option determines whether the objects are displayed 
with one or two waveforms. When it is activated, the waveforms are displayed in 
stereo, i.e. with a right and left channel. In addition, video objects are displayed as 
individual frames in the arranger rather than just the frame at the beginning and end 
of the video object. This helps to improve performance and allows for a faster display. 

Shift: Ctrl + Alt + Z 

Automatic saving of backup projects: Here you can the time intervals at which 
automatic backup projects will be saved. 

Soundpool 

Hide unavailable loops: All Soundpools are saved into a database automatically. The 
Media Pool lists all loops saved in the database, i.e. also those which originate from 
external media (Soundpool discs) that may not be in the drive at the moment. These 
results can be hidden, but this slows down the search results in the Media Pool. 

Hide instruments which are left empty in the style selection: Instrument groups for 
which there are no loops present in a certain style are completely hidden in the Media 
Pool (instead of being grayed out). 

Clean up Soundpool: Every detected Soundpool (on CD/DVD or on the hard drive) is 
added to the database and displayed there, even if the corresponding medium is 
currently not in the drive or if the Soundpool has been deleted or moved. This option 
helps to remove these entries in the database. 

Reset Soundpool: Deletes the Soundpool database. You have the option of 
maintaining the included and installed factory-provided Soundpool in the database. 

Hide advanced tooltips: The additional information for the detected loops in the 
Media Pool will be hidden. 

Instruction dialogs: In its newly installed state, MAGIX Music Maker Premium Steam 
Edition displays a number of security queries at various parts of the program. Every 
one of them can be switched off by clicking the small box at the bottom that says 
"Don't show this message again". To display these warning messages, select the 
"Reactivate dialogs" option.  



 

246   

www.magix.com 

Program interface 

Darken screen when dialogs are opened: Darkening signals modal dialogs which 
need to be closed before the rest of the program can be operated. This can be 
deactivated if it disturbs you. 

Hide news: This option deactivates the MAGIX News Center in the main interface of 
MAGIX Music Maker Premium Steam Edition.  
 

Import 
Preview samples (Wav, OGG) while playing the project (Smart Preview): Here you 
can switch off the preview when a playback is running (Smart Preview). 

Automatically adapt samples to BPM: When loading or previewing the project, 
MAGIX Music Maker Premium Steam Edition tries to adapt the samples to the tempo 
of the project. This always works properly with newer MAGIX soundpool samples as 
the tempo information is saved in the audio file. It usually works with all other loops 
as well, provided the loops are clean, that is, they are cut to entire bar lengths. 

With "For patched samples only", automatic timestretching can be deactivated for all 
other samples. With "Apply to samples longer than 15 seconds as well", longer 
samples will also be adapted if they contain tempo and bar information provided by 
the Remix Agent. 

Automatically open Remix Agent for samples longer than 15 seconds: Here you can 
deactivate the automatic opening of the Remix Agent for longer samples (for 
example, CD tracks or MP3s). 

Automatically adjust waves to pitch: A wave's pitch can be adjusted automatically 
using pitchshifting. For this to work however, the used samples (much like the 
samples on the MAGIX soundpool CDs) must have the corresponding key and pitch 
information. The pitch of the project will then correspond to the pitch information of 
the first sample in the project. 

Use destructive adjustment for shorter samples: Usually, loaded samples are 
adapted to the project in realtime with time stretching. For computers with lower 
processing power, this method can be deactivated – the timestretching effect will 
then be calculated into a new file which is copied to the hard disk. 

Import CD tracks analog instead of digitally: If this option is activated, you can record 
audio CDs via the record button in the transport console. Read more on this in the 
"Recording audio CDs" section in the "Audio objects" chapter. 

Automatically open MIDI editor during import of MIDI files / built-in VSTi 
synthesizers: The MIDI Editor will automatically open after loading MIDI files or 
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synthesizers, allowing you to make changes to channel and instrument assignment 
and other settings. 

Automatically start file preview in Media Pool for...: Here you can deselect automatic 
file preview start for Media Pool files and certain file types. 

Import formats: File formats that you never use can be de-selected here. Once de-
selected they won't be imported anymore. Please keep in mind that several import 
modules exist for some file types (AVI, WMA); MAGIX Music Maker Premium 
Steam Edition uses the fastest one in each case. If you experience problems when 
importing certain files, you can experiment with deactivation of certain import 
modules, forcing the program to use the slower but more compatible import module. 
 

Audio 
Output device: This option determines which sound card and which output plays 
back the wave audio objects and the drivers that should be used. 

Advanced: Use these buttons to access the playback options window which provides 
information on the current sound card. ASIO provides the settings dialog for the ASIO 
driver, e.g. the MAGIX Low Latency ASIO driver. 

Wave/Direct Sound/ASIO/WASAPI: Specifies which of the conventional Windows 
wave drivers should be used for the sound card, i.e. the DirectSound system or ASIO. 
Starting with Windows Vista, the WASAPI driver model is also an option. 

Windows wave drivers have the advantage of being relatively stable against strained 
peaks caused by large buffers. If playback becomes jerky as a result of processor-
heavy effects like time-stretching, switching to wave drivers may solve the problem. 
Otherwise the system may react more slowly with wave drivers because of the large 
buffers, that is, all changes are heard with a delay. 

16/24-bit wave/driver communication: If your sound card is able to play 24-bit 
audio, your project will be played at this higher resolution (internal 32-bit float 
calculation). This is applicable only to wave drivers. 

When using live monitoring and when playing and recording VST instruments in real 
time, i.e. with as low a reaction time (latency) as possible, it's recommended that you 
use ASIO drivers. If your sound cards do not have ASIO drivers, you can use the 
MAGIX Low Latency driver. 

If you select ASIO as the driver model, you can set the output in the upper list field 
(for cards with multiple outputs) and the ASIO driver in the lower list field. Advanced 
opens the settings dialog of the ASIO driver. Please refer to the sound card manual for 
more information.  

WASAPI is a new Windows (native) driver model for low latency and can be used as 
an alternative to ASIO drivers. WASAPI is recommended for Windows Vista or later 
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Windows versions when the sound card does not have its own ASIO driver and the 
MAGIX Low Latency driver isn't compatible.   

Audio buffer:Here you can specify the buffer size that should be used for playback of 
the entire arrangement or for previewing audio files in the Media Pool. 

As a rule of thumb: If response and loading times are too slow, reduce the buffer size; 
otherwise increase the buffer size if the audio playback is choppy or if real-time effect 
computation errors occur.  

As error-free playback is usually more important than fast reaction times, the buffer 
size should be raised to 16384 or 32768 if dropouts occur. 

MIDI 

Output device: MAGIX Music Maker Premium Steam Edition uses an external MIDI 
device when no software instruments are applied and to preview MIDI files in the 
Media Pool. Here the "Microsoft GS Wavetable SW synth", a standard software 
synthesizer included in Windows® as an OS component, should be set as default. If 
sound cards with their own synthesizer are used or in case MIDI hardware 
synthesizers are connected, the MIDI driver of the sound card or a MIDI interface 
should be set!  

FX: If MIDI playback is too fast or lagging behind, you can enter a speed correction 
factor here. 

Input device: Lets you select the MIDI driver for your MIDI recording, i.e. the driver 
for the MIDI device that is connected to your MIDI keyboard or the driver for your 
USB keyboard. 

Use MIDI target channel: The MIDI system offers 16 different channels to control 16 
different sounds. Normally, MAGIX Music Maker Premium Steam Edition receives 
MIDI notes on all channels simultaneously. With this option, you can select a specific 
channel. Next you have to set the desired sound together with the MIDI channel on 
the device and select the MIDI recording options on this channel. 

Synthesizer latency: Some synthesizers, especially software synthesizers like VST 
instruments, create delay during playing, i.e. playback of the sound is delayed when 
the key is pressed. This value lets you even this out, causing all notes to be moved 
over by a certain temporal value. 

Options 

Create "Undo" before destructive editing of audio data: To undo destructive effects, 
the original files must be saved to the hard disk.  If you use this type of effect quite 
often, you can switch off the undo function and save on time used to create an undo 
file as well as save space in memory. 

Write real-time audio to wave file: If this option is activated, the entire project can be 
mixed live and recorded simultaneously. During playback you can, for example, 
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control mixer fades and effects or, with the help of keyboard shortcuts, you can play 
the beats in the project  –  all activities will be recorded and written to a separate 
wave file.  Every time playback stops you will be asked if the portion you just played 
should be saved as a wave file, loaded into the project, or deleted. 
 

Video 
Video standard: PAL is used in Europe, the US and Japan use NTSC. This setting 
should not be changed. 

Video display: The resolutions that can be set here concern only the picture display of 
DV videos in the Arranger. If playback becomes jerky, we recommend entering a 
lower value. The quality of exported videos is not influenced by this. 

Extract sound from videos during import: If a video contains audio data as well, you 
can use this function to extract the audio track from the video. It will be loaded 
directly underneath the video track and grouped together with it. If you ungroup them 
(in Edit menu), you can edit the sound as an independent object. 

Automatically adjust videos to BPM during import: With the available BPM 
information you can automatically create a video in which the rhythm and order of 
pictures are synchronized. This does not play all frames of a video, but some are 
excluded according to the BPM setting on frame playback. The video appears faster at 
a higher BPM setting; it "dances" to the rhythm. The tempo can be set before every 
new project in the transport control. Otherwise, the project applies the BPM tempo of 
the first sample that is loaded. 

Adjust minor deviations from 04:03 aspect ratio during export: This option 
automatically customizes photos that have an approximate 04:03 aspect ratio to 
04:03 TV screen format. The pictures are therefore easily stretched or compressed. 
This inevitably brings about distortions in the picture. If this option is deactivated, 
black bars appear along the sides. 

Automatically preview exported clips: This option starts the clip immediately after 
exporting for verification. 

Automatically copy exported material to clipboard: This option is particularly useful 
when used with other programs, such as Microsoft PowerPoint. If switched on, the 
created multimedia file will be available straight after being inserted. 

Video priority: Usually, audio objects have priority over playback. Here, an overloading 
of the computer as a result of too many effects can bring about jerky video playback 
while the audio continues to play without any problems. 

To change this, you can give the video playback precedence over the audio. Video 
playback is then renewed after every audio buffer, which may lead to interruptions in 
the sound. 
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Folders 
Here you can set the path where 

• projects will be saved (Projects) 
• files are exported (Export) or imported (Import), and recordings (Recordings) 

are saved, 
• files from the Soundpool are loacted (Soundpool) 
• your MP3 collection is available (My MP3s) 
 

Keyboard shortcuts 
Opens the dialog for editing shortcuts used in MAGIX Music Maker Premium Steam 
Edition. 

Shortcut:  U 
 

Language 
Change the language used in MAGIX Music Maker Premium Steam Edition here. 
Normally, the language that is used for installation is set as the program language. 
 

Reset program settings to defaults. 
Use this function to reset all program settings (view page 244) you made in MAGIX 
Music Maker Premium Steam Edition to their original settings. 
 

Exit 
Exits MAGIX Music Maker Premium Steam Edition. 

Keyboard shortcut: Alt + F4 
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Edit Menu 

Undo 

 
10 commands can be undone, including object and cursor manipulations. If 
you don’t like the result of a change in your project, the Undo function will take 
you back to the previous project. 

Shortcut:  Ctrl + Z 
 

Redo 

 
Redo lets you reverse the last Undo command. 

Shortcut:  Ctrl + Y 
 

Object 
Create a new object 
Record a new object 
A new audio object is recorded; see Audio recording. 

Keyboard shortcut:  R 
 

Create a new MIDI object 
This function creates a new MIDI object in the current track. After invoking the 
function, a pop-up menu opens in which you can choose between an empty MIDI 
object or several standard templates. 

Shortcut:   Ctrl + Alt + N 
 

Text to speech 
Please refer to the Audio objects (view page 87) chapter. 

Shortcut:  Ctrl + Shift + T 
 

Record a new object 
A new video object is recorded; see Video recording (view page 199) 
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Shortcut:   G 
 

Create a new title object 
Creates a new title object and opens the title editor (view page 197). 

Shortcut:   Alt + Shift+ T 
 

Cut 
The marked objects are cut out of the current project and placed onto the clipboard. 
They can then be inserted at different positions. 

Shortcut:  Ctrl + X 
 

Copy objects 
Objects selected from the current project will be cut out and saved to the clipboard. 
They can then be pasted to a different location. 

Keyboard shortcut:  Ctrl + C 
 

Duplicate objects 
This menu option lets you copy all selected objects. The copy appears next to the 
original and can be moved easily by holding the left mouse button (drag & drop). 

Shortcut:  Ctrl + D 
 

Inserting objects 
The contents of the clipboard are added  into the current project at the position of the 
start marker. 

The playback marker is positioned at the end of the most recently inserted object so 
that the quick and easy multiple use of the command is also possible. Existing objects 
now become overwritten. 

Keyboard shortcut:  Ctrl + V 
 

Inserting multiple objects 
This function is similar to "Insert", but you can choose how often the content of the 
clipboard is to be inserted. 

Shortcut:  Ctrl + Numeric pad '+' 
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Deleting objects 
Objects selected from the current project will be deleted. 

Shortcut:  Del 
 

Split objects 
You can cut up a selected object at the S marker position. If you have not selected an 
object, all objects will be cut into pieces at the S marker position. 

Later on, if you want to re-join the pieces of an object, select “Build group” to join all 
selected objects to a group. 

Shortcut:  T 
 

Save objects as takes 
The selected objects are saved in the takes directory. For more about using takes, 
please refer to the section „Takes“ (view page 61) in the chapter "Arranging Objects". 

Keyboard shortcut:  Alt + Shift + S 
 

Grouping 
Group objects 
Orders all selected objects into groups. As soon as an object is selected in the group, 
all objects in the group become highlighted so that you can work on them collectively. 

Shortcut:   Ctrl + G 
 

Ungroup objects 
Any selected objects that are part of an object group will become independent objects 
again in this case. 

Shortcut:   Ctrl + U 
 

Loop range 
Set user-defined loop 
Normally an object is always looped over the full length of the underlying data 
material (audio or video file). To set a clip from a file as a loop, shorten the object at 
the front and the back with the handles and choose the menu option "Edit  > Object > 
Loop range > Insert user-defined loop". This function is very useful for setting your 
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own recording as a loop, as the silence at the beginning of a recording can be cut 
away. 
 

Remove user-defined loop 
The user-defined loop length is reset. 
 

Object properties 
This function displays all the information about the currently selected objects such as 
file name, position on the hard-drive, tempo, etc.  

More information is available under Object properties (view page 264). 

Shortcut:  Ctrl + P 
 

Track 
Add track 
A new empty track will be added to the arranger. In the "File > Project properties" the 
count of tracks can be set in large increments. 

Shortcut:   Ctrl + I 
 

Mixdown audio... 
This function can combine the project or segments of the project into a single 
audio/video object. Please refer to the "Track mixdown" (view page 65) section in the 
"Arrange objects" chapter. 

Tip: To create the finished end version of the song or video, it is recommended you 
select the "Export project" function in the "File" menu instead of the "Mixdown" 
function. 

Shortcut:   Ctrl+Shift+G 
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Range  
MAGIX Music Maker Premium Steam Edition provides object-based functions as well 
as "band-oriented" editing functions. These always refer to the whole project from the 
first to the last track as well as to the area between the start and end marker. 
 

Cut range 
The section between the in and out points is cut from the current project and placed 
on the clipboard. This section can be reinserted elsewhere. 

Shortcut:  Ctrl + Alt + X 
 

Copy range 
The section between the in and out points is copied from the current project to the 
clipboard. This section can be reinserted elsewhere.  

Shortcut:   Ctrl + Alt + X 
 

Insert range 
The contents of the clipboard are inserted at the current project's position of the in 
point.  

Shortcut:  Ctrl + Alt + V 
 

Insert segment multiple times 
Similar in function to "Insert", but you can stipulate how often the content of the 
clipboard is to be inserted. 

Shortcut:   Ctrl + Alt + Number key 
 

Delete range 
The section between the in and out points is deleted from the current project and not 
copied to the clipboard. 

Shortcut:  Ctrl + Del 
 

Extract range 
The section between the in and out points is preserved, and all of the material in front 
and behind it are deleted. Use this option to isolate a specific part of a project for 
further individual editing. 
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Shortcut:   Ctrl + Alt + E 
 

Navigation 
Move screen view 
Using these commands, a viewable portion together with the start marker will be 
moved in the timeline. You can quickly skip between different jump markers and 
object edges. 

Shortcuts:  See keyboard shortcut overview in the Arranger View (view 
page 283) section. 
 

Move playback position 
This sets the playback marker to the position of a jump marker. This function can best 
be used via the keyboard. 

When stopped, you can immediately move the playback markers to the position of 
the saved jump markers. During playback, the playback marker along with the 
playback range will be moved. Here, the old range is always played until the end so 
that you can remix your project live once the jump markers have been placed where 
you want them without losing the beat. 

Shortcuts:  1..0 
 

Set jump marker 
This sets a jump marker at the position of the current playback marker. Here you can 
note specific parts of the project. With the "Move playback position" function you can 
quickly jump to these positions. 

Shortcut:  Shift + 1...0 
 

Create jump marker sequence 
This option duplicates the currently selected playback area between the start and end 
markers by setting start markers equidistant to one another in the bar ruler. Now you 
can jump to every jump marker using keyboard shortcuts. 

Keyboard shortcut:  Ctrl + Alt + M 
 

Delete all jump markers 
Deletes all jump markers 

Shortcut:  Alt+Shift+M 
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Select all objects 
All objects in the project will be selected. 

Keyboard Shortcut:  Ctrl + A 
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Effects Menu 

Object automation / Track automation 
The dialog Dynamic effects editor (view page 222) for object automation or track 
parameters is shown. A parameter can be selected and edited in Automation mouse 
mode (view page 53). 

More about automation in the chapter Automation curves (view page 220). 

Shortcut:  Ctrl + H 
 

Song Maker 
This command opens the Song Maker (view page 85) to make projects semi-
automatically.  

Keyboard shortcut:  W 
 

Audio 
Please read the chapter "Audio effects (view page 135)" for more details on audio 
effects. 

 

Master audio effect rack 
Opens or closes the master effects rack; you can also use the "Master FX" button in 
the mixer window for this. 

Shortcut:  B 
 

Mastering Suite 
You can open the MAGIX Mastering Suite with this option. 

Shortcut:  N 
 

Text to speech 
Please refer to the Audio objects (view page 87) chapter. 

Shortcut:  Ctrl + Shift + T 
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Object effect rack 
See Object and master effects rack (view page 137). 

Shortcut:  E 
 

Audio effects 
This submenu includes all audio object effects plus the vintage effects and the effects 
from the MAGIX Mastering Suite (Live & Premium version only); the latter can be 
used individually. 

Individual effects can be found in the chapter "Audio effects (view page 135)". 
 

Volume 
An assortment of different menu commands which influence the volume of your 
audio objects. 
 

Mute/Unmute 
Use this command you can mute one or more selected objects. Selecting this 
command again makes it audible once again. 

Shortcut: Ctrl + M 
 

Set volume 
This function, located in both the effects menu and the context menu, controls the 
sound volume for individual objects, just like the object handles in the project window. 
 

Automatic volume damping 
This command automatically dampens the volume of other audio objects. This can be 
used to insert voiceovers into your project or add commentary to a film (with the 
original sound). You can also specify whether you want to dampen the original sound 
of existing videos or all soundtracks equally. 

In the dialog you can activate and deactivate the value of the dampening. 

You can use this command while recording audio (view page 68) (Audio recording, 
advanced options). 

Shortcut:   Ctrl+Shift+D 
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Normalize (maximum level) 
The function "Normalize" raises the level of an audio object to the maximum possible 
level without clipping the material. This searches for the largest signal peak in the 
audio material and raises the level of the object so that this position matches exactly 
0 dB (maximum overdrive). 

Keyboard shortcut:  Shift + N 
 

Tempo and pitch 
An assortment of different menu commands which influence the pitch and tempo of 
your audio objects. 
 

MIDI transposition 
This command is only available for MIDI objects. It increases/decreases the pitch of a 
MIDI object's notes by a specific value (in semitones). Use this function, for example, 
to adjust the sound of imported MIDI files to other audio objects. This is more 
effective than repositioning audio objects (pitchshifting), since this can diminish the 
sound; transposition does not diminish the quality of MIDI objects because they are 
produced by the synthesizer. 

Shortcut:   Ctrl + T 
 

Timestretch and pitchshift 
See Timestretch/pitchshift (view page 143). 

Shortcut:   Shift + P 
 

Harmony Agent 
The Harmony Agent is designed to analyze harmonies.  

Read more on this in the corresponding section of the "Audio Objects (view page 
84)" chapter. 

Shortcut:   H 
 

One pitch higher/lower 
You can quickly alter the octave of an included sample without having to access the 
corresponding Soundpool folder in the Media Pool. 

The "*" and "÷" keys on the numeric keypad (right on the keyboard) place the sample 
one level higher or lower. 
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The "+" and "-" keys on the numeric keypad change the pitch via pitchshifting; the 
respective effect in the audio effects rack is utilized for this. 
 

Set pitch 
Use this command (only in the Soundpool sample's context menu) to quickly change 
the pitch of the selected object (if present). This also functions when working with 
multiple selection. Simply select all the objects which are under one another and 
select a new pitch to create variations in the project. 
 

Remix 
These are the commands for MAGIX Music Maker Premium Steam Edition's remix 
functions. 
 

Create Remix objects 
If, while running the Remix Agent, the tempo and beat information were saved to the 
audio file, this command can be used to create remix objects. If the Remix Agent has 
not yet been implemented, this command starts it and opens the presets dialog for 
creating remix objects. 

Shortcut:   Ctrl + J 
 

Remix Maker 
With the Remix Maker, automatic remixes can be created from Remix Agent loop 
objects. 

Please refer to the Audio objects (view page 82) chapter. 

Shortcut:  Shift + K 
 

Tempo & beat recognition 
MAGIX Music Maker Premium Steam Edition provides a Remix Agent for the 
automatic determination of the speed in BPM (beats per minute) and for the creation 
of loop objects. 

Please refer to the "Remix Agent"chapter. 

Shortcut:  J 
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Loop finder 
The Loop Finder was developed for the purpose of finding BPMs in short rhythmic 
passages and setting BPMs for the project. The Loop Finder can also help to fit short 
loops into an existing project or extract short rhythmic passages from drum loops. 

Note: For longer passages (e. g. complete CD tracks), you can use the Remix Agent 
(view page 77, view page 261).  

The waveform of the audio material is displayed in the upper part of the dialog, preset 
at a zoom level of about 10 seconds. 

The principle involves moving the green start marker to the start of the beat and the 
red end marker to the start of the next beat. The BPM display to the left then shows 
the tempo of the loop in beats per minute (BPM). Here we presume that there are 
exactly the same amount of beats in the selected passage as is displayed in the 
"Beats" input field – 4 is the default. If there are two full bars between the start and 
end markers, the number of beats has to be increased to eight, otherwise the Loop 
Finder will only correlate half the speed. 

The precise marking of the beat length is required for exactly defining the loop length. 
This is also possible manually by moving the start and end markers, and can be 
similarly precise when using the zoom functions. But it's easier to do so using the 
following: 

Tap tempo: activates the automatic step-sequence to determine the tempo. First, 
audio playback begins at the start marker position. Then you will be requested to tap 
in the beat with "Tap" or by pressing the "T" key, that is, the "T" key should be pressed 
in time with the music. Playback stops after the number of beats set above is reached. 
The start marker is now positioned at the start of the tap process and at the end 
marker at the end. And that's it! The beat has now been set and the tempo can be 
read. Program automation makes sure that the start and end positions are placed 
exactly at the next beat. Even if the tap process didn't work out exactly, automation 
nearly always finds the right beat meant when tapping. 

Snap marker: You can use the red and green arrow buttons at the top beside the 
wave display for moving the start and end marker one beat forward or one beat back. 
This makes it very easy to select "round loops", i.e. whole bars, during running 
playback. 

As long as a loop runs through without any problems, the correct tempo will be able 
to be read to the left. 

Here you should make sure that the number of beats per bar (default: 4) has to 
adapted to the actual loop length. That means if four bars are selected as a loop, 16 
has to be entered into this field. 
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Start (S) and End (E) Markers: These markers indicate the beginning and the end of a 
loop. You can move them around with the mouse to fine-tune the range. 

Cut: Once a correct loop has been found, it can be cut using the this function in order 
to be able to use it again later.  

Use new BPM: The project applies the BPM value found.  

Timestretching: Adapts the object to the tempo of the project (as a result of the 
determined tempo) using timestretching. 

Resampling: Adapts the object to the tempo of the project (as a result of the 
determined tempo) using resampling. 

Keyboard shortcut:  L 
 

Load/Save/Reset audio effects 
You can save the current effect combination of an audio object separately and apply it 
to other objects later. Or you can deactivate all currently used effects entirely (Reset) 
if you want to undo the changes.  

Keyboard shortcut: Load audio effects Ctrl + Alt + O 
 Reset audio effects Ctrl + Alt + R 
 

Convert stereo into two mono objects 
With this option stereo recordings can be split into two mono objects which are then 
connected to a group. You can use the "Ungroup" button to edit the channels as 
independent objects. 

Shortcut:  Shift + Z 
 

Edit in external editor 
Open a selected audio object in the external program MAGIX Music Editor where it 
can be edited with lots of special features. Once editing has been completed, the 
edited material is used in MAGIX Music Maker Premium Steam Edition instead of the 
original object. 

Shortcut:  Ctrl + Shift + M 
 



 

264   

www.magix.com 

Object properties 
This function displays all the information about the currently selected objects, such as 
file name, position on the hard disk, tempo, etc. The object editor also defines the 
foreground and background color of every object in the project. 

In the "Tempo/Pitch" tab, information on the patched/determined tempo and pitch of 
the audio object is shown. Furthermore, there is an overview of how the various 
timestretching/pitchshifting operations affect the entire audio object. The 
tempo/pitch adjustment when loading the sample, the effect of the master tempo 
fader, and the time processor as object effect tracks are offset against one another, 
but they may not mesh properly. For this reason, there are two buttons which can be 
used to double/halve the object speed. Try using these buttons if the tempo of some 
loops is incorrectly interpreted as twice or half the speed. 
 

Video 
Edit image in external editor 
Graphics files (BMPs or JPEGs) may be edited retroactively with an external graphics 
program from the arranger. The selected image file is loaded automatically and, once 
editing has been completed, is used in the MAGIX Music Maker Premium Steam 
Edition instead of the original material. 

Shortcut:   Ctrl+Shift+B 
 

Load video effects 
This command enables a saved effects combination to be loaded for the currently 
loaded object. If multiple objects are selected, then the effects combination will be 
applied to each selected object. 

 
 

Save video effects 
This command saves the current effects combination for each object separately. 
 

Reset video effects 
This option allows you to deactivate all currently used effects. The material will be 
reset to the state it was in before you applied the effect.  
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Title 
Title Editor 
Opens the title editor (More information can be found in the section "Title Editor" on 
page 197) for the selected photo or video object. 

Shortcut:   Alt + Shift + T 
 

Load title template 
Use this command to load previously saved title effects for the current object.  
 

Save title template 
You can save the current effect combination for each title object separately and apply 
it to other title objects later. 
 

Automation 
Display object volume curve 
The automation curve for object volume is shown and can be edited in Automation 
mouse mode (view page 53). 

More about automation in the chapter Automation curves (view page 220). 
 

Display object panorama curve 
The automation curve for object panorama is displayed and can be edited in 
Automation mouse mode (view page 53). 

More about automation in the chapter Automation curves (view page 220). 
 

Object automation / Track automation 
The dialog Dynamic effects editor (view page 222) for object automation or track 
parameters is shown. A parameter can be selected and edited in Automation mouse 
mode (view page 53). 

More about automation in the chapter Automation curves (view page 220). 

Shortcut:  Ctrl + H 
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View menu 

Standard layout 
This option determines, whether the video monitor and Media Pool are integrated in 
the main window or appear as a separate window which can be closed or opened. 

Shortcut:  F11 
 

Zoom Soundpool and Keyboard 
This setting enlarges the display of the loops in the Soundpool view of the Media Pool. 
The keyboard and menu items are also shown with a larger display. This makes it 
easier to use MAGIX Music Maker Premium Steam Edition on touchscreens (view 
page 41). 

Keyboard shortcut:  Tab key 
 

Arranger 
Optimize view 

  
The start marker is set at the beginning of the project and the end marker is 
set at the end of the last object in the project, so that the project may be 
played back in full. 

Zooms out of the project so that the complete duration of the project is visible. The 
vertical zoom steps (track height) remain preserved. 

Shortcut:  F12 
 

Objects with stereo imaging 
This option determines whether the objects are displayed with one or two waveforms. 
When it is activated, the waveforms are displayed in stereo, i.e. with a right and left 
channel. In addition, video objects are displayed as individual frames in the arranger 
rather than just the frame at the beginning and end of the video object. This helps to 
improve performance and allows for a faster display. 

Shift: Ctrl + Alt + Z 
 

Highlight loop area 
With this option, you can fade the loop area in and out, visible by the stripe above the 
first track that indicates the area that will be played as an endless loop. 
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Display pitch ranges 
Displays or hides the Pitch bar (view page 37). 
 

Horizontal scrolling 
This option reverses the horizontal and vertical functions of the mouse wheel for 
zooming and scrolling (view page 35). This means you can use Shift and Ctrl+Key for 
zooming and scrolling the tracks instead of for the visible duration. This corresponds 
with the performance of the mouse wheel in the old Music Maker version. 
 

Cursor keys move playback marker 
The option "Cursor keys move playback marker" in the "View" menu > "Arranger" is 
preset as active. If you disable this, you can move the playback marker with the arrow 
keys while additionally pressing the Alt key. You can then move the playback range 
(view page 37) with just the cursor keys. 
 

Show object marker > Show bar marker/harmony marker 
After using the Remix agent or the Harmony Agent, the analysed material receives 
beat and harmony information which is then shown in the arranger via these 
commands. 

Shortcut: Bar Marker Ctrl + Shift + F9 
 Harmony Markers Ctrl + Shift + F10 
 Beat Markers Ctrl + Shift + F11 
 

Media Pool 
Show Media Pool... 
This option hides or displays the Media Pool. 

Shortcut:  F2 
 

Loop Manager/Instruments/File Manager 
Opens the corresponding folder in the Media Pool. 

Shortcut:  Loop Manager  F5 

  Instruments  F6 

  File Manager  F7 
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Control tab 
Control tab visible... 
This option hides or displays the Control tab. 

Shortcut key:  F3 
 

Templates/Keyboard/Inspector/Catooh 
Opens the corresponding folder in the Control tab. 

Shortcut:  Templates  F8 

  Keyboard  F9 

  Inspector  F10 

  Catooh   O 
 

Video monitor 
Show video monitor 
Opens and closes the video window. 

Shortcut:   F3 
 

Full-screen Video Monitor 
This option shows the video preview monitor in full-screen mode. The right mouse 
button opens the context menu, the Esc-key returns you to normal viewing mode. 

Shortcut:  Alt + Enter 
 

Video output 
This option switches the preview monitor on or off to display the existing video 
objects in the Arranger.  

Shortcut:   Shift + F3 
 

Project overview 
With this option you can display an overview of the entire project on the video screen. 
It is particularly suitable for long and complex projects to prevent you from losing 
track.  
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You can view the whole project and and still be able to access the sought-after object 
in a split second – you can zoom in directly on the video monitor or move around the 
clip displayed in the Arranger. 

 
The function can also be opened via "Overview" on the video monitor. 

Shortcut:   Shift + F2 
 

Audio peakmeter 

 
The video monitor is transformed into an analyzer which displays the 
sound as a graphic. 

 

Shortcut:   Shift + F4 
 

Infobox 

 
The InfoBox mode shows help text in the preview monitor if you hold 
the mouse pointer over a button on the screen. 

Shortcut:   Shift + F1 
 

Mix 
Mixer 
With this option you can open and close the real-time mixer. Further information can 
be found in the Mixer (view page 204) chapter. 

Shortcut:  M 
 

Master audio effect rack 
Opens or closes the master effects rack; you can also use the "Master FX" button in 
the mixer window for this. 

Shortcut:  B 
 

Mastering Suite 
You can open the MAGIX Mastering Suite with this option. 

Shortcut:  N 
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Live Pads 
Opens the Live Pads . Please refer to the Live Pads (view page 211) chapter! 

Shortcut:   K 
 

Live Arranger 
Opens the Live Arranger . Please refer to the "Arranging objects" (view page 56) 
chapter, section "Live Arranger" (view page 61)! 
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Share menu 
The Share menu provides access to online social networks as well as transfer 
functions to other MAGIX programs. 

Here you'll find options for uploading individual objects in the arranger or files from 
the Media Pool as well as the entire project, as audio or video. You can also transfer 
your project to another MAGIX program (if it is installed) e.g. to use it as background 
music for your slideshow. 
 

Manage login details 
These are options for managing user names (email addresses) and the associated 
passwords so that you are able to access your Online Services without having to enter 
the details each time. 

This information applies to all of my Online Services: If this option is activated, then 
the account details you have entered will be applied to all Online Services. Deactivate 
this option if you have different details for individual services, then choose the 
corresponding service via "Select service and enter the associated login details.  
 

Community upload 
The menu entries featured under "File" > "Export" >"Community upload" or via the 
Export assistant allow you to upload the finished song to different web communities. 
 
 

Upload video to Facebook. 
Uploads the current project to Facebook. You can find additional information under 
Export to Facebook (view page 230). 
 

Upload video to YouTube 
Uploads the current project to YouTube. See Export to YouTube (view page 231) for 
details. 

Shortcut:   Shift + Y 
 

Upload audio to Soundcloud. 
Uploads the project to the Soundcloud music platform. You can find additional 
information under Upload audio to Soundcloud (view page 232). 
 



 

272   

www.magix.com 

Sending your project as an email 
This option creates a compressed file in Windows Media format. Your mail program 
is activated simultaneously and the created file of an opened message is added as an 
attachment. This lets you compress and send your project immediately without 
having to go through any intermediate steps. 
 

Present music on magix.info 
Opens an Internet browser at the MAGIX Online World media upload page. There 
you can choose the file you would like to present on the website. 

Note: You first have to export (view page 228) your project. 
 

Use as background music 
Converts your project into MP3 format and sends it to an installed MAGIX photo or 
video program, where it can be used as background music.  

Note: This function is only available if you have at least one of the above programs 
installed.  

 

Add to music collection 
Converts your project into MP3 format and sends it directly to a MAGIX music 
management program (e. g. MP3 deluxe), where it is added to an existing music 
collection.  

Note: This function is only available if you have installed an appropriate MAGIX 
program. 

 

Edit audio objects in external editors 
Converts your project into WAV format and sends it directly to one of the specified 
programs where it can be edited further. 

• Music Editor 
• Audio Cleaning Lab 

Note: This function is only available if you have at least one of the above programs 
installed. 
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Burn audio to CD-R(W) 
Your project will be sent to MAGIX Speed burnR, where it can be burned as an audio 
CD. The Live & Premium version offers you MAGIX Music Editor. 

Keyboard shortcut:  Shift + C 
 

Burn project and used media onto CD/DVD-
R(W) 
Your project will be sent to MAGIX Speed burnR, where it can be burned to CD or 
DVD. 

Shortcut: Ctrl + B 
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Help Menu 

Show welcome dialog 
With this command you can display the "Welcome" dialog again. There, you have a 
quick access to important functions during program start. 
 

Documentation 
Content 
Use the command "Content" in the "Help" menu to open the start page of the help 
file. You can read through the help file step-by-step and jump to specific sections via 
the tree structure on the right hand side. 
 

PDF manual 
Opens the manual in PDF format. 
 

Context Help mouse mode 
The mouse cursor will turn into an arrow with a question mark. 

Click on any button of the main screen, to open program help which will describe the 
control element in question. 

Shortcut:  Alt + F1 
 

Display tooltips 
Tooltips are small information windows that open up automatically if the mouse 
pointer stops briefly on a button or some other area. They provide information about 
the function of the button. These information boxes can be switched on or off with 
this option. 
 

Watch more tutorials online... 
Opens the magix.info with online tutorial videos. 
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Update program / Upgrade functions 
Register online 
This option opens the MAGIX homepage for online registration where you can 
register as a MAGIX user. 

Registration grants you access to the MAGIX support website where various program 
updates and help programs can be downloaded. 
 

Online Update 
Connects directly to the online update page where you can get the latest version of 
your program. 
 

magix.info - Multimedia Knowledge Community 
Help others and find help Directly from within the program you'll be able to access 
magix.info – the new MAGIX knowledge base. You'll find answers to all the most 
frequently asked questions about MAGIX products and multimedia in general. 
Couldn't find an answer to your particular question? No problem, just ask the 
question yourself. 
 

Ask the Knowledge Community a question online 
Ask magix.info a question. 
 

Find knowledge & workshops 
Have a look at the newest workshops at magix.info and read useful tips from other 
MAGIX Music Maker Premium Steam Edition users. 
 

Present music on magix.info 
Opens an Internet browser at the MAGIX Online World media upload page. There 
you can choose the file you would like to present on the website. 

Note: You first have to export (view page 228) your project. 
 

Open magix.info - Multimedia Community 
Opens the magix.info main page. 
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About MAGIX Music Maker Premium Steam 
Edition 
Displays copyright info and version number of MAGIX Music Maker Premium Steam 
Edition. 
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Buttons overview and keyboard shortcuts 

Toolbar 

 
New Project Load Project 

 
Save Project Settings (view page 244) 

 
magix.info Grid On/Off (view page 35)  

 
Redo Action Undo Last Action (Undo) 

 
Split Object Select Mouse Mode (view page 52) 

 

Keyboard shortcuts 
In MAGIX Music Maker Premium Steam Edition, there are many functions for which 
key commands can be used to open your desired program at the touch of a button. In 
detail: 

• Menu and object context menu entries 
• Functions of the Media Pools (Options menu) 
• The video monitor menu 
• Move and zoom of the arranger view 
• Playback control (Moving the playback marker and the playback area) 
• Mouse modes 
• Smart preview function (Previewing Media Pool files in the project context) 
 

File menu 
Load/Save project 

New project Ctrl + N 

Load project Ctrl + O 

Save project Ctrl + S 

Save project as Shift + S 

Import 

Import Audio CD track(s) C 

Audio recording R 
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Video recording Live & Premium G 

Export 

Common export options X 

Burn audio to CD-R(W) Shift + C 

Audio as Wave/ADPCM Shift + W 

Audio as MP3 Shift + M 

Audio as OGG Vorbis Shift + O 

Audio as Windows Media Shift + E 

Audio as AIFF Shift + I 

Audio as FLAC Shift + F 

Audio tracks as single waves Shift + U 

Video as AVI Shift + A 

Video as MAGIX video Shift + X 

Video as Quicktime Movie Shift + Q 

Video as Windows Media video Shift + V 

Picture as BMP Shift + B 

Picture as JPEG Shift + J 

Backup copy 

Save project and used media Ctrl + Alt + S 

Save project and used media (audio 
as OGG Vorbis) 

Ctrl + Shift + C 

Burn project and used media onto 
CD/DVD-R(W) 

Ctrl + B  

Burn manually selected files to 
CD/DVD 

Ctrl + Alt + B 

Settings 

Program settings P 

Project settings A 

Audio recording Shift + R 

Keyboard shortcuts U 

Exit Alt + F4 
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Edit menu 
undo Ctrl + Z 

Restore Ctrl + Y 

Select all Ctrl + A 
Object 

Record new audio object R 

New MIDI object Ctrl + Alt + N 

Text to speech Ctrl + T 

Record a new video object G 

Create a new title object Alt + Shift + T 

Cut Ctrl + X 

Copy Ctrl + C 

duplicating Ctrl+D 

Insert Ctrl + V 

Multiple insert Ctrl + "Num+" 

Delete Del 

Select all Ctrl + A 

Split T 

Save objects as takes Alt + Shift + S 

Group objects Ctrl+G 

Ungroup objects Ctrl+U 

Object properties Ctrl+P 

Range 

Cut Ctrl+Alt+X 

Copy Ctrl+Alt+C 

Insert Ctrl + Alt + V 

Multiple insert Ctrl + Alt + "Num+" 

Delete Ctrl + Del 

Extract Ctrl + Alt + E 

Navigation: Set jump marker, move playback position (see Playback control), move 
view (see Move arranger view (view page 283)). 
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Effects menu 
Song Maker W 

Audio 

Master audio effects rack B 

Mastering Suite N 

Text to speech Ctrl + Shift + T 

Object effect rack E 

10 Band Equalizer Q 

Parametric equalizer Ctrl + Q 

Sketchable filter F 

Compressor Shift + D 

Stereo processor Z 

Invert phase Ctrl + Shift + I 

Echo/Reverb Shift + H 

Distortion/Filter D 

Vocoder V 

Gater Shift + G 

Reversed Ctrl + Shift + R 

Mute/Unmute Ctrl+M 

Volume settings Ctrl + Shift + D 

Normalize Shift + N 

Timestretch/pitch shift Shift + P 

Vocal Tune S 

MIDI transposition Ctrl + T 

Harmony Agent H 

One pitch higher Num * 

One pitch lower Num / 

Create remix objects Ctrl + J 

Remix Maker Shift + K 
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Remix Agent – Tempo and beat 
recognition 

J 

Load audio effects Ctrl + Alt + O 

Reset audio effects Ctrl + Alt + H 

Convert stereo into two mono 
objects 

Shift + Z 

Edit wave in external editor Ctrl + Shift + M 

Video 

Edit image in external editor Ctrl + Shift + B 

Title 

Title editor Alt + Shift + T 
Automation 

Object automation Ctrl + H 
 

View menu 
Zoom Soundpool and Keyboard Tab 

Standard layout F4 

Arranger 

Optimize view F12 

Change object presentation Ctrl + Alt + Z 
Show object marker 

Bar marker Ctrl + Shift + F9 

Harmony marker Ctrl + Shift + F10 

Beat marker Ctrl + Shift + F11 

Media Pool 

Show Media Pool F2 

Soundpool F5 

Instruments  F6 

File manager F7 

Control tab 

Templates F8 

Keyboard F9 

Inspector F10 
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Catooh O 

Video monitor 

Show video monitor F3 

Fullscreen video monitor Alt + Enter 

Video output Shift + F3 

Project overview Shift + F2 

Audio peakmeter Shift + F4 

InfoBox Shift + F1 

Mix 

Mixer M 

Master audio effects rack B 

Mastering Suite N 

Live Pads K 
 

Help menu 
Context help mouse mode Alt + F1 

About MAGIX Music Maker 
Premium Steam Edition 

I 
 

MIDI objects context menu 
MIDI editor Ctrl + Shift + D 

Track VSTi editor Ctrl + Shift + F 

MIDI transposition Alt + Shift + D 
 

Video Monitor 
Show video monitor F3 

Fullscreen video monitor Alt + Enter 

Video output Shift + F3 

Project overview Shift + F2 

Audio peakmeter Shift + F4 

Info Box Shift + F1 
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Move Arranger view 

Note: These commands similarly move the playback marker when it's stopped, the 
marker always remains visible in the project clip. 

To next object edge Ctrl + 0 

To the previous object edge Ctrl + 9 

Go to beginning of project Home 

Go to end of project end cap 

Go to start marker Ctrl + Home 

Go to end marker Ctrl+End.   

Page right/left  Page Up/Down 

Grid unit right/left Ctrl+PgUp/PgDn 

Go to the next jump marker Ctrl + Shift + PgDn 

Go to the previous jump marker Ctrl + Shift + PgUp 
 

Arranger view - Increase/Reduce clip size (zoom) 
Increase clip size (zoom in) Ctrl+Arrow up 

Reduce clip size (zoom out) Ctrl+Arrow down 

Zoom 1 frame Ctrl+1 

Zoom 5 frames Ctrl+2 

Zoom 1 sec Ctrl+3 

Zoom 10 sec Ctrl+4 

Zoom 1 min Ctrl+5 

Zoom 10 min Ctrl+6 

Zoom view between start and end 
marker 

Ctrl+7 

Zoom over whole project Ctrl+8 

Increase track pitch Alt+Arrow up 

Reduce track pitch Alt+Arrow down 
 

Move playback control / playback marker / playback area 
Start/Stop playback Space bar 

Stop at position (stop playback, Escape 
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move playback marker to current 
position) 

Set jump marker Shift+1...0 

Playback marker to jump marker 1..0 

Note: When stopped, the playback marker is moved to the jump marker (after the 
end of the current loop). 

Create jump marker sequence (10 
markers with intervals equal to the 
current playback area) 

Ctrl+Shift+M 

Delete all jump markers Alt+Shift+M 

Move playback range Arrow left/right 

Move playback one quarter of its 
length 

Ctrl+Arrow left/right 

Double/Halve playback area length Shift+Arrow right/left 

Double/Halve playback area length 
by a bar 

Ctrl+Shift+Arrow left/right 

 

Mouse modes 
Mouse modes for individual objects Alt + 1 

Connect objects in one track Alt + 2 

Connect objects in all tracks Alt + 3 

Curve mouse mode Alt + 4 

Draw objects Alt + 5 

Splitting objects Alt + 6 

Object stretch mouse mode Alt + 7 

Preview objects mode Alt + 8 

Scrub mode Alt + 9 

Replace mouse mode Alt + 0 
 

Preview/Smart preview 
Change preview object Arrow keys 

Insert into project Enter 

Delete smart preview object Del 
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If you still have questions 

Tips for Program Help 
When the program is open, you can access the Help feature by pressing F1 on your 
keyboard. The program Help contains tips on how to use the program and lots of 
additional information. Many important terms are indicated in the text in italics. 
Simply click on these terms for a more detailed explanation of what they mean. 

Context Help: Press the "F1" key on your keyboard at any point in the open program 
and Help will open with the matching help topic. 

Search function: This feature can be used to look for specific words in the Help 
section. Enter either the individual word or use logical operators (e. g. OR, AND, 
NEAR) to refine your search if you have several search words. 
• OR (between two words): all topics which contain both words or one of the 

words will be listed. 
• AND (between two words): only those topics will be listed which contain both 

words. 
• NEAR (between two words): only those topics will be listed which contain both 

words. A maximum of 6 additional words are allowed between two search 
words. 

• NOT (before a word): topics which contain this word will not be listed. 

Print: The print function can be used to print out specific Help topics or entire topic 
sections. The print button is located at the very top of the toolbar in the Help window. 
 

Uninstalling the program 
If you would like to uninstall MAGIX Music Maker Premium Steam Edition, go to the 
Control Panel and select "Software" or "Programs and Features". 
 

System Requirements 
Operating System: Microsoft Windows Vista / 7 / 8 /8.1 

Minimum Configuration: 

• Processor with 2 GHz or above 
• 1 GB RAM (2 GB recommended) 
• Free hard disk space: 6 GB (Live & Premium version: 9GB)  
• Graphics card: Min. resolution 1024 x 768 
• Onboard sound card 
• DVD drive 
• Internet connection required for activating and validating the program* 



 

286   

www.magix.com 

*Software can also be used offline. However, please note that the program requires 
an Internet connection at least once a month to validate the license.  

Optional: 

• Burn CDs/DVDs with a CD/DVD±R(W) recorder  
• MP3 export with Windows Media® Player 10 or higher 

Note: Artist rights and ancillary publisher copyrights must be respected. Only non 
copy-protected audio CDs can be imported. 

 

Serial number 
A serial number is included with each product. This serial number is required for 
software activation. Please store this number in a safe place. 

What does a serial number do? 
With a serial number your program license is clearly assigned to you and only you. 
This allows you to use the free customer service via email.  

Serial numbers also help protect against software piracy. This makes it possible for us 
to offer our customers the most value for their money. 

Where is the serial number located? 
The serial number is on the insert card in the program box. 

If you have purchased the download version, you will receive a confirmation email 
containing the serial number that you can use to activate the program. This will be 
sent immediately following purchase to the email address you provided. 

When is the serial number needed? 
The serial number is required when you start the program the first time, as well as for 
program registration. 
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Publishing works created in MAGIX Music 
Maker Premium Steam Edition 
What needs to be taken into account when publishing a 
music or video production? 
A distinction is made between "non-commercial use" and "commercial use". 

1. What constitutes non-commercial use? 

If songs are created with MAGIX Music Maker Premium Steam Edition or if music is 
added to private videos, they can be shared with others on social networks (e.g. 
YouTube, Facebook, Soundcloud, Twitter or personal blogs/websites). The decisive 
factor in these cases is that no money is made or will be made from the song or video 
soundtrack. 

Examples of non-commercial use: 

• A user creates a song with Music Maker and uploads it to their SoundCloud 
page or YouTube channel. 

• A user produces a song using Music Maker, burns it to CD then sends it to their 
friends. 

2. What constitutes commercial use? 

Commercial use refers to videos with soundtracks or songs created using Music 
Maker for commercial purposes. Commercial use if if sales are made, if revenue is 
accrued through advertising (e.g. as a YouTube partner or through the process of 
monetizing) or if contracts are concluded. In this case the necessary licenses must be 
purchased from Catooh The Online Media Marketplace 
http://www.catooh.com/de/sys/id/search/?&search[mode]=fast&search[keyword
s]=music%20maker&search[category]=8563.  

Examples of commercial use: 

• A user creates a song in MAGIX Music Maker and uploads it to their YouTube 
channel, which they've enabled for advertising (YouTube Partner Program). 

• A user produces a song in MAGIX Music Maker and makes it available for 
purchase from an online download shop (e.g. iTunes, Musicload). 

• A musician produces a song with MAGIX Music Maker for a CD Compilation, 
which is sold at concerts. 

• A user makes a video in which they advertise their company or one of their 
company's products. 

Important: The downloadable styles in Catooh that are licensed for commercial use 
consist of high quality WAV files. Any "normal" Music Maker content from the 
installation DVD is in .ogg format for space reasons. 

http://www.catooh.com/de/sys/id/search/?&search%5Bmode%5D=fast&search%5Bkeywords%5D=music%20maker&search%5Bcategory%5D=8563
http://www.catooh.com/de/sys/id/search/?&search%5Bmode%5D=fast&search%5Bkeywords%5D=music%20maker&search%5Bcategory%5D=8563


 

288   

www.magix.com 

More about MAGIX 

Catooh – the Online Content Library 
If your project is missing pictures, videos, DVD menus, sounds, or samples, then you 
should have a look at the huge selection available at Catooh. There you'll be able to 
buy media in excellent quality for low prices: DVD menus, Slideshow Maker styles, 
decorative elements, 3D power effects, 3D transition series, MAGIX Soundpools, 
songs, ringtones... Perfectly suited to all MAGIX photo, video, and music projects. 
 

magix.info 
Do you have questions, need help, or are looking for expert tips and tutorial videos on 
using your MAGIX product? At magix.info you will find answers and solutions as well 
as workshops and a comprehensive user forum for software and multimedia queries. 

You can access magix.info online at www.magix.info 
 

Soundpool DVD Collection 
MAGIX Music Maker Premium Steam Edition includes thousands of sound and video 
building blocks. Other media can be ordered later. MAGIX Sound  Essentials includes 
professionally produced loops and samples in impressive quality – the ideal 
enhancement for the most varying of music styles, including: 

• Ambient 
• Big Beat 
• Easy listening 
• Dance / Electro 
• Disco / House 
• Soundtrack 
• Hip hop 
• Rock/Pop 
• Techno / trance 
• Special effects 

 

In the upper menu bar under "Tasks" > "Discover more", you can order the MAGIX 
Sound  Essentials directly. 

Tip: At www.magix.com you'll always find the latest soundpool offers. 
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Audio formats ...........................................................................................................................66 
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Edit in external editor ............................................................................................................263 
Edit menu .................................................................................................................................279 
Edit Menu..................................................................................................................................251 
Edit MIDI events.......................................................................................................................98 
Edit notes with the mouse .................................................................................. 100, 102, 116 
Edit objects .........................................................................................................................26, 29 
Editing curves..........................................................................................................................224 
Editing Pitch.............................................................................................................................. 141 
Editing the track curves in the project ...............................................................................221 
Effect curves .............................................................................................................................139 
Effects.......................................................................................................................................... 29 
Effects menu...................................................................................................................136, 280 
Effects Menu ...........................................................................................................................258 
Effects presets................................................................................................................. 137, 138 
Effects rack....................................................................................................... 51, 136, 137, 259 
Effects that may be automated ......................................................................................... 220 
essentialFX....................................................................................................................... 127, 163 
essentialFX Presets................................................................................................................ 164 
Exit ............................................................................................................................................ 250 
Export .................................................................................................................... 207, 228, 235 
Export as E-Mail attachment ..............................................................................................229 
Export as ringtone ........................................................................................................ 229, 237 
Export Project............................................................................................................................30 
Export to Facebook .......................................................................................................230, 271 
Export to YouTube............................................................................................... 229, 231, 271 
Export wizard ............................................................................................. 228, 235, 272, 275 
External synthesizers .............................................................................................................. 93 
Extract range ...........................................................................................................................255 
Extract sound from videos ....................................................................................................197 

F 

Fading Objects .......................................................................................................................... 59 
File manager .............................................................................................................................. 45 
File menu ..................................................................................................................................277 
File Menu..................................................................................................................................234 
Fill mode ..................................................................................................................................... 83 
Filter...........................................................................................................................154, 181, 217 
Filter parameters .................................................................................................................... 182 
Filters.................................................................................................................................135, 154 
Filter-Sweeps/Morphing....................................................................................................... 161 
Find knowledge & workshops .............................................................................................275 
Flanger....................................................................................................................................... 180 
Flanger parameters................................................................................................................. 181 
Folders............................................................................................ 46, 71, 120, 236, 240, 250 
Formats and interfaces ......................................................................................................15, 16 
Full-screen Video Monitor...................................................................................................268 
Fundamentals.......................................................................................................................... 149 
FX tracks.........................................................................................................................205, 220 



 

 

Index 293 

 

G 

Gater ...........................................................................................................................................161 
General notes on AVI videos....................................................................................202, 240 
General operation ...................................................................................................................216 
General options .....................................................................................................42, 243, 245 
Group objects ......................................................................................................................... 253 
Grouping .................................................................................................................................. 253 
Guitar amp.................................................................................................................................191 

H 

Harmony Agent................................................................................................ 16, 80, 84, 260 
Help menu ............................................................................................................................... 282 
Help Menu...............................................................................................................................274 
Highlight loop area ................................................................................................................266 
Horizontal scrolling ............................................................................................................... 267 

I 

If you still have questions ....................................................................................................285 
Import ...................................................................................................... 15, 76, 207, 234, 246 
Import and export of surround audio files..............................................................207, 210 
Import audio CD...............................................................................................................71, 234 
Import audio CD tracks ........................................................................................................234 
Infobox............................................................................................................................. 196, 269 
InfoBox......................................................................................................................................... 16 
Information..............................................................................................................................244 
Input ............................................................................................................................................191 
Insert range ............................................................................................................................. 255 
Insert segment multiple times............................................................................................ 255 
Inserting multiple objects .................................................................................................... 252 
Inserting objects..................................................................................................................... 252 
Instruments ............................................................................................................................... 45 
Integrating other programs - Synchronizing and ReWire ........................................... 225 
Internet upload to many platforms ...................................................................................... 16 
Introduction.................................................................................................................................13 
Invert Phase...............................................................................................................................161 

K 

Keyboard ............................................................................................................................ 48, 121 
Keyboard shortcuts .............................................................................. 39, 48, 136, 250, 277 
Keyboards stickers ................................................................................................................. 215 

L 

Language..................................................................................................................................250 
List Editor ............................................................................................................95, 98, 99, 105 



 

294   

www.magix.com 

Listening to the input signal - monitoring................................... 34, 67, 68, 69, 70, 205 
Live Arranger.................................................................................................................... 61, 270 
Live Arranger recordings........................................................................................................64 
Live Pads.................................................................................................... 18, 40, 211, 219, 270 
Live Pads interface ................................................................................................. 211, 213, 219 
Load and edit audio files.........................................................................................................66 
Load and save Live Arranger sequence..............................................................................64 
Load and save MIDI files................................................................................................90, 115 
Load backup project ..............................................................................................................242 
Load project .............................................................................................................................234 
Load synthesizers from the Media Pool........................................................................... 120 
Load title template.................................................................................................................265 
Load video effects ................................................................................................................. 264 
Load/Save/Reset audio effects..........................................................................................263 
Loading and editing videos and bitmaps.......................................................................... 196 
Loading and saving Live Arranger sequences...................................................................64 
Loading synthesizers via the track header........................................................................ 121 
Loop finder ...............................................................................................................................262 
Loop Finder ................................................................................................................................84 
Loop Manager/Instruments/File Manager.....................................................................267 
Loop range ...............................................................................................................................253 

M 

MAGIX Audio Remote...................................................................................................211, 216 
MAGIX Audio Remote - remote control via smartphone app ...................................... 18 
MAGIX Mastering Suite........................................................................................................157 
MAGIX Mastering Suite 2.0 .................................................................................................. 18 
MAGIX Music Editor............................................................................................................... 87 
MAGIX plug-ins ......................................................................................................................163 
MAGIX Vita..............................................................................................................................125 
magix.info.................................................................................................................................288 
magix.info - Multimedia Knowledge Community .........................................................275 
Manage login details ..............................................................................................................271 
Master audio effect rack ............................................................................................258, 269 
Master effects ..........................................................................................................................137 
Master track ........................................................................................................................... 206 
Mastering Suite ............................................................................................................258, 269 
Meaning of the colors in the Piano Roll and Controller Editor .....................................99 
Media Pool ....................................................................................................................... 42, 267 
Menu reference MIDI editor ......................................................................................... 95, 115 
MIDI channel filter .......................................................................................... 90, 99, 100, 116 
MIDI editor ................................................................................... 45, 47, 51, 90, 94, 121, 139 
MIDI Editor shortcuts ..................................................................................................... 95, 117 
MIDI Functions .......................................................................................... 99, 111, 113, 114, 115 
MIDI objects................................................................................... 27, 33, 47, 51, 61, 89, 214 
MIDI objects context menu.................................................................................................282 
MIDI Record options .........................................................................................34, 39, 97, 115 
MIDI transposition................................................................................................................ 260 
Mix .............................................................................................................................................269 
Mixdown audio ............................................................................................................... 65, 254 
Mixdown audio... .............................................................................................................77, 254 



 

 

Index 295 

 

Mixer ........................................................................................... 16, 32, 39, 40, 60, 204, 269 
More about MAGIX ..............................................................................................................288 
More sounds .............................................................................................................................. 51 
Mouse modes .......................................................................................... 38, 52, 76, 277, 284 
Move all.......................................................................................................................................52 
Move Arranger view ..........................................................................................256, 279, 283 
Move playback control / playback marker / playback area....................................... 283 
Move playback marker ............................................................................................................37 
Move playback position ....................................................................................................... 256 
Move playback range with the keyboard ................................................................. 37, 267 
Move screen view.................................................................................................................. 256 
Move selection ..........................................................................................................................52 
Move to track.............................................................................................................................52 
Move/Zoom with the mouse wheel .......................................................................... 35, 267 
Move/Zoom with the scroll bar.................................................................................. 34, 140 
Moving and zooming .............................................................................................................102 
Multimax................................................................................................................................... 159 
Multimedia files and objects................................................................................................. 56 
Multimedia Library  - Soundpool .......................................................................................... 14 
Multi-touch ...................................................................................................................... 41, 266 
Mute objects ..............................................................................................................................57 
Mute/Unmute ........................................................................................................................ 259 

N 

Navigation................................................................................................................................ 256 
Navigation buttons................................................................................................................... 51 
New project .............................................................................................................................234 
Non-real-time effects ............................................................................................................160 
Normalize (maximum level) ...............................................................................................260 

O 

Object ........................................................................................................................................ 251 
Object and track curve automation ......................................................................................17 
Object automation .............................................................................................222, 258, 265 
Object automation / Track automation................................................................. 258, 265 
Object effect and track effect presets ............................................................................... 139 
Object effect rack .................................................................................................................. 259 
Object effects .......................................................................................................................... 136 
Object Handles.................................................................................................................. 57, 58 
Object properties ......................................................................................................... 254, 264 
Objects with stereo imaging...............................................................................................266 
Objekt-Inspektor....................................................................................................................... 51 
One pitch higher/lower........................................................................................................260 
Online Update......................................................................................................................... 275 
Open magix.info - Multimedia Community.................................................................... 275 
Opening the Remix Maker......................................................................................................82 
Optimize view..................................................................................................................35, 266 
Overview...................................................................................................................................196 
Overview of the program interface ..................................................................................... 20 



 

296   

www.magix.com 

Own recordings ......................................................................................................................... 15 

P 

Parameter smoothing/ Controller knobs..........................................................................163 
Parametric EQ ............................................................................................... 135, 146, 154, 158 
Particularities for purchases made through Steam™ ........................................................5 
PDF manual..............................................................................................................................274 
Phaser.........................................................................................................................................167 
Phaser parameters ..................................................................................................................167 
Piano Roll....................................................................................................94, 95, 100, 115, 116 
Picture as JPG..........................................................................................................................242 
Pitch Bar.............................................................................................................................37, 267 
Play demo project .................................................................................................................... 22 
Play with Live Arranger........................................................................................................... 62 
Play/ PlaySolo ...........................................................................................................................96 
Playback area - Start and end markers..................................... 25, 34, 36, 58, 61, 67, 87 
Playback sequence................................................................................................................... 63 
Playing and recording MIDI synthesizer ............................................................................ 93 
Playing instruments with the keyboard.......................................................................96, 97 
Playing the Live Pads......................................................................................................211, 212 
Preface ...........................................................................................................................................3 
Present music on magix.info ..................................................................................... 272, 275 
Presets................................................................................................................................ 83, 150 
Presets for individual effects ................................................................................................138 
Preview audio ............................................................................................................................ 54 
Preview function....................................................................................................................... 57 
Preview of MIDI files .............................................................................................. 90, 93, 100 
Preview/Smart preview....................................................................................................... 284 
Previewing and loading sounds ............................................................................................ 24 
Problem solving preview in Media Pool .............................................................................90 
Program settings ................................................................................................ 244, 250, 277 
Project overview .....................................................................................................................268 
Project settings .......................................................................................................................243 
Publishing works created in MAGIX Music Maker Premium Steam Edition .........287 

Q 

Quantization Grid (.................................................................................................................. 111 
Quantization settings.............................................................95, 105, 109, 110, 111, 112, 114 
Quantize ............................................................................................................................. 111, 116 
Quantize controller events .......................................................................................... 105, 114 
Quick start..............................................................................................................................3, 22 
Quick start via preset selection .......................................................................................... 190 

R 

Rack effects (FX1/FX2) .........................................................................................................193 
Range..................................................................................................................................36, 255 
Real 5.1 Surround Sound.......................................................................................................... 18 
Record a new object ...............................................................................................................251 



 

 

Index 297 

 

Record audio output................................................................................................................ 65 
Redo ........................................................................................................................................... 251 
Register online ........................................................................................................................ 275 
Remix .........................................................................................................................................261 
Remix Agent..................................................................................................................... 77, 262 
Remix Maker ............................................................................................................. 80, 82, 261 
Remove user-defined loop ..................................................................................................254 
Removing synthesizers........................................................................................................... 121 
Reordering ................................................................................................................................ 162 
Replace ....................................................................................................................................... 54 
Reprocess arrangement ....................................................................................228, 237, 240 
Requirements..........................................................................................................................207 
Reset program settings to defaults. ..................................................................................250 
Reset video effects ................................................................................................................264 
Reverb ........................................................................................................................................218 
Reverb/Echo ................................................................................................................... 135, 148 
Revolta 2 .............................................................................................................................18, 122 
Revolta 2 interface.................................................................................................................. 123 
ReWire............................................................................................................................ 227, 244 
Rhythmic envelope................................................................................................................ 223 

S 

Save objects as takes ............................................................................................................ 253 
Save project.............................................................................................................................234 
Save project and used media..............................................................................................242 
Save project and used media (audio as OGG Vorbis) .................................................243 
Save project as........................................................................................................................234 
Save tempo and bar info .........................................................................................................82 
Save title template................................................................................................................. 265 
Save video effects ..................................................................................................................264 
Save/load projects .................................................................................................................. 56 
Scale ............................................................................................................................................ 49 
Scrubbing ................................................................................................................................... 54 
Select all objects .................................................................................................................... 257 
Select objects.............................................................................................................................57 
Select sounds............................................................................................................................ 95 
Selecting MIDI events ................................................................................................... 98, 100 
Sending your project as an email............................................................................. 242, 272 
Sequencer ...................................................................................................................................63 
Sequencer programming ........................................................................................................63 
Serial number..........................................................................................................................286 
Set jump marker..................................................................................................................... 256 
Set pitch ....................................................................................................................................261 
Set user-defined loop............................................................................................................ 253 
Set volume............................................................................................................................... 259 
Setting object volume............................................................................................................. 59 
Settings.....................................................................................................................................243 
Share menu............................................................................................................................... 271 
Shorten or loop objects .......................................................................................................... 59 
Show Media Pool... ................................................................................................................ 267 
Show object marker > Show bar marker/harmony marker........................................ 267 



 

298   

www.magix.com 

Show video monitor...............................................................................................................268 
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